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Information in this document is subject to change without notice. No part of this document may be
reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without
the express written permission of:

Sonotron NDT, 4, Pekeris st., Rabin Science Park, Rehovot, Israel, 76702

Covered by the United States patents 5524627, 5952577, 6545681; other US & foreign patents pending
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Sonotron NDT

4, Pekeris str., Rabin Science Park, Rehovot, 76702, Israel
Phone:++972-(0)8-9477701 Fax:++972-(0)8-9477712
http://www.sonotronndt.com

EC Declaration of Conformity

Council Directive 89/336/EEC on Electromagnetic Compatibility, as amended by
Council Directive 92/31/EEC & Council Directive 93/68/EEC

Council Directive 73/23/EEC ( Low Voltage Directive ), as amended by Council
Directive 93/68/EEC

We, Sonotron NDT Ltd., 4 Pekeris Street, Rehovot, 76702 Israel, certify that the product
described is in conformity with the Directives 73/23/EEC and 89/336/EEC as amended

ISONIC 2007

Dual Channel Portable Digital Ultrasonic Flaw Detector and Recorder

The product identified above complies with the requirements of above EU directives by
meeting the following standards:

Safety
EN 61010-1:1993

EMC
EN 61326:1997
EN 61000-3-2:1995 /A1:1998 /A2:1998 /A14:2000
EN 61000-3-3:1995

| IS0 9001 REGISTERED
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Sonotron NDT

4, Pekeris str., Rabin Science Park, Rehovot, 76702, Israel
Phone:++972-(0)8-9477701 Fax:++972-(0)8-9477712
http://www.sonotronndt.com

Declaration of Compliance

We, Sonotron NDT Ltd., 4 Pekeris Street, Rehovot, 76702 Israel certify that the product
described is in conformity with National and International Codes as amended

ISONIC 2007

Dual Channel Portable Digital Ultrasonic Flaw Detector and Recorder

The product identified above complies with the requirements of following National and
International Codes:

e ASME Section | — Rules for Construction of Power Boilers

e ASME Section VIII, Division 1 — Rules for Construction of Pressure Vessels

e ASME Section VIII, Division 2 — Rules for Construction of Pressure Vessels. Alternative
Rules
ASME Section VIII Article KE-3 — Examination of Welds and Acceptance Criteria
ASME Code Case 2235 Rev 9 — Use of Ultrasonic Examination in Lieu of Radiography
Non-Destructive Examination of Welded Joints — Ultrasonic Examination of Welded
Joints. — British and European Standard BS EN 1714:1998
Non-Destructive Examination of Welds — Ultrasonic Examination — Characterization of
Indications in Welds. — British and European Standard BS EN 1713:1998
Calibration and Setting-Up of the Ultrasonic Time of Flight Diffraction (TOFD)
Technique for the Detection, Location and Sizing of Flaws. — British Standard BS
7706:1993
WI 00121377, Welding — Use Of Time-Of-Flight Diffraction Technique (TOFD) For
Testing Of Welds. — European Committee for Standardization — Document # CEN/TC
121/SC 5/WG 2 N 146, issued Feb, 12, 2003
ASTM E 2373 — 04 — Standard Practice for Use of the Ultrasonic Time of Flight iffraction
(TOFD) Technique
Non-Destructive Testing — Ultrasonic Examination — Part 5: Characterization and Sizing
of Discontinuities. — British and European Standard BS EN 583-5:2001
Non-Destructive Testing — Ultrasonic Examination — Part 2: Sensitivity and Range
Setting. — British and European Standard BS EN 583-2:2001
Manufacture and Testing of Pressure Vessels. Non-Destructive Testing of Welded
Joints. Minimum Requirement for Non-Destructive Testing Methods — Appendix 1 to
AD-Merkblatt HP5/3 (Germany).— Edition July 1989
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FCC Rules

This ISONIC 2007 ultrasonic flaw detector and data recorder (hereinafter called ISONIC 2007) has been tested and found to comply
with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try
to correct the interference by one or more of the following measures:

. Reorient or relocate the receiving antenna

. Increase the separation between the equipment and receiver

. Connect the equipment into an outlet on a circuit different from that to which the receiver is connected

. Consult the dealer or an experienced radio/TV technician for help

Safety Regulations

Please read this section carefully and observe the regulations in order to ensure your safety and operate the system as intended
Please observe the warnings and notes printed in this manual and on the unit

The ISONIC 2007 has been built and tested according to the regulations specified in EN60950/VDEQ805. It was in perfect working
condition on leaving the manufacturer's premises

In order to retain this standard and to avoid any risk in operating the equipment, the user must make sure to comply with any hints and
warnings included in this manual

Depending on the power supply the ISONIC 2007 complies with protection class | /protective grounding/, protection class IlI, or
protection class IlI

Exemption from statutory liability for accidents

The manufacturer shall be exempt from statutory liability for accidents in the case of non-observance of the safety regulations by any
operating person

Limitation of Liability

The manufacturer shall assume no warranty during the warranty period if the equipment is operated without observing the safety
regulations. In any such case, manufacturer shall be exempt from statutory liability for accidents resulting from any operation

Exemption from warranty
The manufacturer shall be exempt from any warranty obligations in case of the non-observance of the safety regulations
The manufacturer will only warrant safety, reliability, and performance of the ISONIC 2007 if the following safety regulations are closely

observed:

. Setting up, expansions, re-adjustments, alterations, and repairs must only be carried out by persons who have been authorized by
manufacturer

e  The electric installations of the room where the equipment is to be set up must be in accordance with IEC requirements

e  The equipment must be operated in accordance with the instructions

e  Any expansions to the equipment must comply with the legal requirements, as well as with the specifications for the unit concerned

. Confirm the rated voltage of your ISONIC 2007 matches the voltage of your power outlet

e  The mains socket must be located close to the system and must be easily accessible

. Use only the power cord furnished with your ISONIC 2007 and a properly grounded outlet /only protection class I/

. Do not connect the ISONIC 2007 to power bar supplying already other devices. Do not use an extension power cord

e Any interruption to the PE conductor, either internally or externally, or removing the earthed conductor will make the system unsafe
to use /only protection class I/

e Any required cable connectors must be screwed to or hooked into the casing

e  The equipment must be disconnected from mains before opening

e To interrupt power supply, simply disconnect from the mains

e Any balancing, maintenance, or repair may only be carried out by manufacturer authorized specialists who are familiar with the

inherent dangers

Both the version and the rated current of any replacement fuse must comply with specifications laid down

. Using any repaired fuses, or short-circuiting the safety holder is illegal

If the equipment has suffered visible damage or if it has stopped working, it must be assumed that it can no longer be operated

without any danger. In these cases, the system must be switched off and be safeguarded against accidental use

Only use the cables supplied by manufacturer or shielded data cable with shielded connectors at either end

Do not drop small objects, such as paper clips, into the ISONIC 2007

Do not put the ISONIC 2007 in direct sunlight, near a heater, or near water. Leave space around the ISONIC 2007

Disconnect the power cord whenever a thunderstorm is nearby. Leaving the power cord connected may damage the ISONIC 2007

or your property

e  When positioning the equipment, external monitor, external keyboard, and external mouse take into account any local or national
regulations relating to ergonomic requirements. For example, you should ensure that little or no ambient light is reflected off the
external monitor screen as glare, and that the external keyboard is placed in a comfortable position for typing
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Do not allow any cables, particularly power cords, to trail across the floor, where they can be snagged by people walking past

The voltage of the External DC Power Supply below 11 V is not allowed for the ISONIC 2007 unit

The voltage of the External DC Power Supply above 16 V is not allowed for the ISONIC 2007 unit

Charge of the battery for the ISONIC 2007 unit is allowed only with use of the AC/DC converters / chargers supplied along with it or
authorized by Sonotron NDT

Remember this before:

balancing

carrying out maintenance work
repairing

exchanging any parts

Please make sure batteries, rechargeable batteries, or a power supply with SELV output supplies power

Software

ISONIC 2007 is a software controlled inspection device. Based on present state of the art, software can never be completely free of
faults. ISONIC 2007 should therefore be checked before and after use in order to ensure that the necessary functions operate perfectly

in the envisaged combination. If you have any questions about solving problems related to use the ISONIC 2007, please contact your
local Sonotron NDT representative

ISONIC 2007 from Sonotron NDT - Operating Manual — Revision 1.14 - Page 7 of 320



L. INTRODUCTION ..ot e oot e e oo e oo e e e e e oo e o e e e e e e e e e s e an e e e e e e e e e e sameeeeeeeeeaannnnneaaeeesannnneneeeeean 11

D I L0 o [N (@Y I 72 I A TR 14
2.1. INSTRUMENTS MANUFACTURED ON OR BEFORE DEC 1, 2007 ... .ciiiiiiiiiii e e et e e evtis e e e e e ettt s e e e e e e eaata e e e e e eeennaa s 15
2.2. INSTRUMENTS MANUFACTURED AFTER DEC L, 2007 ..ouuiitiiiiiiii it e et e e et e e ae e et s st e s e e e sberaaeeanessaeeanees 17

3. ISONIC 2007 — SCOPE OF SUPPLY ...ttt ettt e e ettt et e e e e e et e e e e e e e e et aeeeeeeeesaaaba e aseeeeerssraaaanaaes 19

4, OPERATING ISONIC 2007 .. .iiiiietueiie ettt e e e e e ettt e e e e e et e e ab e seee e e e e st seea e e e s aaa e seeeessrssasaaneeesesessaanneeeeeeeeres 24
4.1. PRECONDITIONS FOR ULTRASONIC TESTING WITH ISONIC 2007 ......ccciiiiiiiiie e eeeis e e et s e e e e e e e e e e aeeees 25
4.2. ISONIC 2007 CONTROLS AND TERMINALS .. ceuuuiiitti ettt eetttteeestteesstueasauaeessstnaesataaeesaneestaaesstnaasssneessnnaeessnaaersnnaeees 26
L R NN [Nl O NI O 1= = STURRR 28

5. UDS 3-5 PULSER RECEIVER CHANNELS ......oeiiiiiee ettt e e e e et e e e e e e e et e e e e e e e e e e aabbaaaeeees 30
5.1. START UP UDS 3-5 PULSER RECEIVER ......citiittiiiiiee e ettt e e e e e e eettaas e e e e eesattaaaeeee e s estaa e eeeeesasta s eeeeeessaanaaeeeeserrnnaneeas 31
5.2, MAIN OPERATING SURFACE ...uuuiiitueitttiieeetaeettteestttaesataeesttaeestaeetataaaeata ettt et st easatteetttaesetnaeeesneesstaeersnaeareesnnns 32

LT RV =Y T 1Y =Y o IO RO
5.2.2. Sub Menu BASICS
5.2.3. SUD MENU PULSER ......cooiiiiiiiieeeeeeeeeeeee ettt ettt ettt e et et e e e e e e e e e e e e e e e e e e e e e eeanananas

5.2.4. SUD MENU RECEIVER ..ottt etttk etttk e bt ekt e ebe e et san e et esbneenee s
5.2.5. Sub Menu GATE A
5.2.6. Sub Menu GATE B
5.2.7. Drag and Drop: Gate A and Gate B..................
5.2.8. Sub Menu ALARM ......cooiiiiiiiiieiiiiieeeee e
5.2.9. Sub Menu DAC/TCG..................
5.2.10. Create / Modify DAC
5.2.10.1 Theoretical DAC: dB/mm (dB/in)
5.2.10.2 Experimental DAC: recording signals from variously located reflectors. ...

LY B R B L1 T PO P PP U PR TUPPOTPT
5.2.12. SUD MENU MEASURE .......ooiiiiiiieite ettt b ekt h e e kbt e sab e e s bt e e sabenbb e e sbb e e bt e e sbneenee s
5.2.13. Time Domain Signal Evaluation - Measurements Guide..............ccccccceenn.
5.2.13.1. Values available for Automatic Measurements and Digital Readout
5.2.13.2. Flank, Top, Flank-First, and Top-First Modes of MeasuremMent ..............eevieeiiiiiiiiieee e
5.2.13.3. Advanced Scheme for Reflectors Depth Measurement Whilst Using Angle Beam Probe — Thickness /
Skip / Curved Scanning SUMace COMECHION. ........ciuiiiiiee ettt e e st e e e e s s r e e e e e e ssteeeaeesaanaraeeeas 92
5.2.13.4. Dual Ultrasound Velocity Measurement Mode — Typical Example..........cccccooiiiiiiiiiiniieeiee, 96
5.2.13.5. Determining Probe Delay - Miniature Angle Beam Probes (contact face width 12.5 mm / 0.5 in or less) -
Shear or Longitudinal Waves — Typical EXAMPIE........c..oiiiiiiiiiiie et 100
5.2.13.6. Determining Probe Delay - Large and Medium Size Angle Beam Probes (contact face width more than
12.5 mm /0.5 in) - Shear or Longitudinal Waves — Typical EXample.........cccccceiiiiiiiiiiie e 101
5.2.13.7. Determining Probe Delay - Straight Beam (Normal) Single Element and Dual (TR) Probes — Typical
S 1001 o] [T TP TP ST PP P UPRPPOPPPP 102
5.2.13.8. Automatic Calibration (AUTOCAL) of Probe Delay and US Velocity - Angle Beam Probes - Shear or
Longitudinal Waves — TYPIiCal EXAMPIE ......ccciiiiiiiiiieeiie ettt sate e nre e e e st e e eneeas 103
5.2.13.9. Automatic Calibration of Probe Delay and US Velocity - Straight Beam (Normal) Single Element and
Dual (TR) Probes — Typical EXAMPIE.........eiiiiiiiie ittt e s 108

5.2.13.10. Determining Incidence Angle (Probe Angle)
5.2.14. Frequency Domain Signal Presentation and Evaluation
5.2.15. Freeze A-SCan / FFT Graph ... oottt ettt e e e e et e e e e e e e e nne e e e e e e e annnneeaaaaaan 116
5.2.16. Zoom A-Scan [ FFT Graph .......ccccccveiiiiiiiicin e 117
5.2.17. Save an A-Scan and its Calibration Dump into a file............ 118
5.2.18. Load an A-Scan and its Calibration Dump from afile .......... 119
5.2.19. Print A-Scan/FFT Graph and Settings LiSt..........cooiiiiiiiiiieiiiiieeeee e 120
5.2.20. Activate Main Recording Menu for Single Channel Operation using CH 1 ...
5.2.21. SWItCh OFF UDS 3-5 ...ttt 120

6. RECORDING AND IMAGING — SINGLE CHANNEL (CH 1) ..ottt 121

6.1. MAIN RECORDING MENU — SINGLE CHANNEL (CH 1) ....iiiiiiiiii ittt e e e et e e e e e e e e smtbeeeaaaeeeannnes
6.2. TIME BASED AND TRUE TO LOCATION RECORDING SUBMENUS........iiinaes
6.3. THICKNESS PROFILE IMAGING AND RECORDING — T-BSCAN(TH) AND BSCAN(TH)
6.3.1. Setup Pulser Receiver for Thickness Profile Imaging and Recording...........
6.3.2. Thickness Profile Imaging — Implementation
6.3.2.1. t-BScan(Th) — Prior to Scanning................
6.3.2.2. t-BScan(Th) — Scanning ............ccccvvveeennnn.
6.3.2.3. BScan(Th) — Prior to Scanning .................
6.3.2.4. BSCAN(TH) — SCANNING . ...ctttiiiiiiiiiiie ettt e e e e e ettt e e e e e e e atbe et e e e e e s aanbaeeeeeeeaannsbeeeaeeeaannneeeaeas

ISONIC 2007 from Sonotron NDT - Operating Manual — Revision 1.14 - Page 8 of 320



6.3.2.5. t-BScan(Th) / BScan(Th) — POSLPIOCESSING ......cciiiuutiiiiiaai ittt ee e e ettt e e e e st e e e e e e sibbee e e e e s anneeeeeas 138
6.4. B-SCAN CROSS-SECTIONAL IMAGING AND RECORDING OF DEFECTS FOR LONGITUDINAL AND SHEAR WAVE INSPECTION — T-
ABISCAN OR ABISCAN. ...ttt ettt ettt ettt ettt ettt et et ettt eeaeaaaeeeaaaaaaeas
6.4.1. Setup Pulser Receiver for t-ABIScan or ABIScan Imaging and Recording
6.4.1.1. Straight BEAM PrODES........ciiii ittt e e e e ettt e e e e e s bbb e e e e s nb b b e e e e e e e annrneeeeas
6.4.1.2. ANGIE BEAM PrODES ...ttt e ettt e e e e e e bbbt e e e e e nnee e e e e e e e aannneeeaeas
6.4.2. B-Scan Cross Sectional Imaging — Implementation...............
6.4.2.1. t-ABIScan — Prior to Scanning (Straight Beam Probes)..
6.4.2.2. t-ABIScan — Scanning (Straight Beam Probes) ..............
6.4.2.3. ABIScan — Prior to Scanning (Straight Beam Probes)....
6.4.2.4. ABIScan — Scanning (Straight Beam Probes).................
6.4.2.5. t-ABIScan — Prior to Scanning (Angle Beam Probes).....
6.4.2.6. t-ABIScan — Scanning (Angle Beam Probes)..................
6.4.2.7. ABIScan — Prior to Scanning (Angle Beam Probes) .......
6.4.2.8. ABIScan — Scanning (ANgle BEaAM PrODES) .......ccoiiiiiiiiiiieiiiie ettt
6.4.2.9. t-ABIScan / ABISCAN — POSIPIOCESSING ....vvviiiieeiiiiiiiiiieeeeeesiiiteee e e e s esiiirereeaeaessstaaeeeaeesssataseseesaassareeens
6.5. TOFD INSPECTION — RF B-SCAN AND D-SCAN IMAGING AND RECORDING — T-TOFD orR TOFD
6.5.1. Setup Pulser Receiver for t-TOFD and TOFD ..........coiiiiiiiiiiiiie et e e e e e e e e e enaeeeeaeaaas
6.5.1.1. Accumulated Probe Pailr DEIAY ..........euiiiiiiieiiiiie ettt
6.5.1.2. Display Delay and Range
Lo 0 JR €TV o OO PP UPT PP
LRSI B o (0] o TS =T o F= = L1 o P ERT O
6.5.2. t-TOFD and TOFD — Implementation...............
6.5.2.1. t-TOFD — Prior to Scanning
6.5.2.2. t-TOFD — Scanning.............
6.5.2.3. TOFD — Prior to Scanning ..
6.5.2.4. TOFD — SCaNNiNg ......cvvverireieiinieeeiiiieeenne
6.5.2.5. t-TOFD / TOFD - Postprocessing.............
6.6. CB-SCAN HORIZONTAL PLANE-VIEW IMAGING AND RECORDING OF DEFECTS FOR SHEAR, SURFACE, AND GUIDED WAVE
INSPECTION — T-FLOORMARP L OR FLOORMARP L.ttt 227
6.6.1. Setup Pulser Receiver for t-FLOORMAP L and FLOORMAP L.......ccoiiiiiiiiiiieiniiee et 227
6.6.1.1. Angle Beam Inspection — Shear and Longitudinal Waves ............cccooviiiiiiieieiiiiiiiiiee e eeiiieeee e 227
6.6.1.2. Guided, Surface, Creeping, and Head Wave INSPECLION...........ccoiiiiiiiiiiiiie i 228
6.6.1.3. Determining Probe Delay and Ultrasound Velocity for Guided / Surface / Creeping / Head Wave
1455 o1=T o (T I TP PSP PP PP POPPPPI
6.6.1.4. Setting Gain and DAC for Guided / Surface / Creeping / Head Wave Inspection
6.6.2. t-FLOORMAP L and FLOORMAP L — Implementation ..............ccccceeiiniiieeiee e
6.6.2.1. t-FLOORMAP L — Prior to Scanning
6.6.2.2. t-FLOORMAP L — Scanning.............cccec....
6.6.2.3. FLOORMAP L — Prior to Scanning...........
6.6.2.4. FLOORMAP L — SCaNNING.......cueeeeiiiiieeriiieeeniieeeanieeeenns
6.6.2.5. t-FLOORMAP L / FLOORMAP L — Postprocessing

7. RECORDING AND IMAGING — DUAL CHANNEL ..ottt

7.1. MAIN RECORDING MENU — DUAL CHANNEL. .....vttiiiiiiie ittt sttt s sba et n e st s s s bn e e e s sanaee s
7.2. DUAL CHANNEL THICKNESS PROFILE IMAGING AND RECORDING — BSCAN(TH)
7.2.1. Setting Pulser Receiver Channels
7.2.2. SCANNING....teeeeiiiiie et
7.2.3. POSIPIOCESSING ..eeieiiiiititieteeeeeeitttt et e e e s e st ta et e eaeeeasatbaeeaeeeassastbaraeaaeesaasstsaesaaeesaanssseseesanses
7.3. DUAL CHANNEL TOFD INSPECTION — RF B-SCcAN AND D-SCAN IMAGING AND RECORDING ...............
7.3.1. Setting Pulser Receiver Channels
7.3.2. Pre-Scanning Settings .......ccccovvvveerieeee e
A%< e TS Y%= o o113 Vo PRSPPI
RS T a0 11 o] ool =21 o Vo OO PP UPP P UOPPPPPPN
7.4. CB-SCAN HORIZONTAL PLANE-VIEW IMAGING AND RECORDING OF DEFECTS FOR SHEAR, SURFACE, AND GUIDED WAVE
INSPECTION — FLOORMARP L.ttt ettt ettt e ettt e e e e e et e e e e e et e e e e e e e e nr e e e e e e s esnnneeeees
7.4.1. Setting Pulser Receiver Channels
7.4.2. Pre-Scanning Settings ........cccoovvviiiieeeeeeiiniienns
A RS TS Yox= g o1 Vo SRR PSPPSR
T4 4. POSTPIOCESSING ....veeeeeteteeiiteee sttt ee e ettt e e st e e st et e aah bt e e e sttt e 4ok b et a2 aa kbt e oo s b et e e aab e e e e ek b et e eh e e e e anne e e e an b e e e e n b e e e s

8. INCREMENTAL ENCODERS. ...ttt e e e s sba e sra e

8.1. STANDARD ENCODER SK 2001108 ABI — SINGLE CHANNEL OPERATION
8.2. STANDARD ENCODER SK 2001108 FM — SINGLE CHANNEL OPERATION

L 0 R O ] 5 OO RUPPPRRUPPPRRt

S T o @ 1@ ] Y 1A = IO UPUPTR
8.3. CUSTOMIZED ENCODERS FOR PROPRIETARY INSPECTION TASKS — SINGLE AND DUAL CHANNEL OPERATION........ccuuv.... 284
8.4, ENCODER CALIBRATION ...uutttuuetttteesstuaeetueeestaaeesstaaasetaeeesunasstanaaesanasssanaesssnnaessanaesssnseessnnaesssnaeesssnsesssnneessmsnneeeees 284

ISONIC 2007 from Sonotron NDT - Operating Manual — Revision 1.14 - Page 9 of 320



9. MISCELLANEOUS ... .o e e e e e s s e e e e e e e s sh b e e e e e e e s s s bbb e b e e e e e s s snaaeee s 289

0.1, INTERNATIONAL SETTINGS .. ettuuetttteeeetaeeetueeestaaeesttaaeataeeeat e staeaestnasssanasstasaessanaasssneessanaasssnsesstnaeessnnaassnnsaeasees 290
Lo 2 O =T g T T =T = OO PP PPPPPRTPN 291
9.1.2. Metric and IMPEHAI UNIES .....uiiiiiiiiiiiiii ettt e e e e e et e e e e e e st aeeeaeeessasbbaseeeaassbsaeeaeeessssaneeaaeaaans 292

9.2. DISPLAY SETTINGS
[ B Yo | W O] (o] T =T 1 [ TP 293
9.2.2. TOFD DiSPIAY SELUNGS ...eeeitteeeiiiiie ettt ettt eit ettt e ettt s et e ekt e e aa bt e e ab et e sk et e e aabe e e sabe e e e anbr e e e abn e e e nnnneas 295

9.3. FIRING MODE
9.4. PRINTER SELECTION
0.5, EXIT TO WINDOWS ...uuiiiitieeitie e ettt e ee et e e e et e ee et e e e e et e e e et e e e e aan e e s saneeesanaassaan e ssannaeesanaesanseessanassnnsaeesnnaassessnnaasnsnnaanes
9.6. CONNECTION TO NETWORK .........cuu......
9.7. EXTERNAL USB DEVICES ......ccccceeveee.

9.7.1. Mouse..................

9.7.2. Keyboard

9.7.3. Memory Stick (Disk on Key)

9.7.4. PriNter .ccovvviveieieieieieieeeeeeeeeeeeeeeveeeees

9.7.5. ISONIC Alarmer
9.8. EXTERNAL VGA SCREEN / VGA PROJECTOR
0.9, SOFTWARE UPGRADE ......uuiiittietiiteettt e e ettt ee et e ee st ae e et e eettaes st eae st esetaneetstaeestaneesstaeesstnaesstaseesstnaesssanaaeessrnneares
9.9. ISONIC OFFICE AND ISONIC OFFICE 2005 SOFTWARE PACKAGES FOR OFFICE PC
9.10. ISONIC PAR2TXT CONVERTER SOFTWARE PACKAGE
9.11. ISONIC D-LINE AND ISONIC D-SPREADSHEET CREATOR SOFTWARE PACKAGES
.12, CHARGING BATTERY .. itiiiiiiiieiiie ettt e ettt e e e e ettt e ettt e e ettt e e e st e e e et s e s eta e e s st e e s taneessbaee s st e sataseeestnaeessanaaeessrnnaaees
.13, SILICON RUBBER JACKET ..tttuuuitettttttttiteeeeessstnaaseesessstsnaeesssssssnaeeesssstanseesssssttnnaeeeesssrsnaaeeerersnaeeersssrrn

10. DUAL CHANNEL TOFD PREAMPLIFIER

ISONIC 2007 from Sonotron NDT - Operating Manual — Revision 1.14 - Page 10 of 320



1. Introduction
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ISONIC 2007 uniquely combines functionality and mobility of high performance single/dual portable digital
ultrasonic flaw detector with recording, imaging, and data processing capabilities of smart computerized
inspection system

ISONIC 2007 resolves a variability of ultrasonic inspection tasks:

O A-Scan-based inspection using conventional pulse echo, back echo attenuation, and through
transmission techniques

O Single Channel Straight Line Scanning Record - based inspection:

a Thickness Profile B-Scan imaging and recording, which is performed through continuous
measuring of thickness value along straight line type probe trace

O B-Scan cross-sectional imaging and recording of defects for longitudinal and shear wave
inspection, which is performed through continuous measuring of echo amplitudes and reflectors
coordinates along straight line type probe trace

Q@ CB-Scan horizontal plane-view imaging and recording of defects for shear, surface, and guided
wave inspection, which is performed through continuous measuring of echo amplitudes and
reflectors coordinates along straight line type probe trace

Q TOFD Inspection — RF B-Scan and D-Scan Imaging along straight line type probe trace
For Single Channel Straight Line Scanning records it may be used:

o0 Time-based mode — ISONIC 2007 is equipped with built-in real time
clock

0 True-to-location mode — ISONIC 2007 is equipped with built-in
incremental encoder interface

O Dual Channel Straight Line Scanning Record - based inspection:

a Thickness Profile B-Scan imaging and recording, which is performed through continuous
measuring of thickness value along straight line type probe trace

a CB-Scan horizontal plane-view imaging and recording of defects for shear, surface, and guided
wave inspection, which is performed through continuous measuring of echo amplitudes and
reflectors coordinates along straight line type probe trace

Q TOFD Inspection — RF B-Scan and D-Scan Imaging along straight line type probe trace
For Dual Channel Straight Line Scanning records it may be used:

0 True-to-location mode — ISONIC 2007 is equipped with built-in
incremental encoder interface

O XY-Scanning Record - based inspection:

Q Thickness Map imaging and recording, which is performed through continuous measuring of
thickness value along probe trace

O Flaw Detection — Pulse Echo 3D imaging (C-Scan, B-Scan, D-Scan) and recording of defects
for straight beam inspection, which is performed through continuous measuring of echo
amplitudes and reflectors coordinates along probe trace

O Flaw Detection — Through Transmission / Back Echo Attenuation 2D imaging and recording
(C-Scan) which is performed through continuous measuring of signal amplitudes along probe
trace

For XY-Scanning records it is necessary to use optional items such as scanning
mechanism driven either manually or automatically, 2 incremental encoders
built-in into a scanning mechanism, dual axis encoder USB Interface, and
MULTISCAN COMBO S ME inspection software package

For all types of Straight Line Scanning and XY-Scanning records A-Scans are captured for each probe
position along probe trace and may be played back and evaluated off-line at postprocessing stage. This
unique feature makes it possible off-line defect characterization through echo-dynamic pattern
analysis

Thickness Profile B-Scan Data recorded during Straight Line Scanning and Thickness Map data
recorded during XY-Scanning is presented in the format compatible with various Risk Based Inspection and
Maintenance procedures. Off-line measurements and statistical analysis functions also meet the
requirements of said procedures
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ISONIC 2007 has practically unlimited capacity for storing of

e Single A-Scans accompanied with corresponding instrument settings

e Ultrasonic signal spectrum graphs (FFT Graphs) accompanied with corresponding RF A-Scans and
instrument settings

e Various A-Scans sequences along with corresponding Thickness Profiles, or B-Scans, or CB-
Scans, or TOFD Maps depending on mode of operation selected accompanied with corresponding
instrument settings

ISONIC 2007 complies with the requirements of National and International Codes:

ASME Section | — Rules for Construction of Power Boilers

ASME Section VIII, Division 1 — Rules for Construction of Pressure Vessels

ASME Section VIII, Division 2 — Rules for Construction of Pressure Vessels. Alternative Rules

ASME Section VIII Article KE-3 — Examination of Welds and Acceptance Criteria

ASME Code Case 2235 Rev 9 — Use of Ultrasonic Examination in Lieu of Radiography

Non-Destructive Examination of Welded Joints — Ultrasonic Examination of Welded Joints. —

British and European Standard BS EN 1714:1998

O Non-Destructive Examination of Welds — Ultrasonic Examination — Characterization of
Indications in Welds. — British and European Standard BS EN 1713:1998

Q Calibration and Setting-Up of the Ultrasonic Time of Flight Diffraction (TOFD) Technique for the
Detection, Location and Sizing of Flaws. — British Standard BS 7706:1993

Q WI00121377, Welding — Use Of Time-Of-Flight Diffraction Technigue (TOFD) For Testing Of
Welds. — European Committee for Standardization — Document # CEN/TC 121/SC 5/WG 2 N
146, issued Feb, 12, 2003

Q Non-Destructive Testing — Ultrasonic Examination — Part 5; Characterization and Sizing of
Discontinuities. — British and European Standard BS EN 583-5:2001

@ Non-Destructive Testing — Ultrasonic Examination — Part 2; Sensitivity and Range Setting. —
British and European Standard BS EN 583-2:2001

Q Manufacture and Testing of Pressure Vessels. Non-Destructive Testing of Welded Joints.

Minimum Requirement for Non-Destructive Testing Methods — Appendix 1 to AD-Merkblatt

HP5/3 (Germany).— Edition July 1989

OO000O0D
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2. Technical Data
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2.1. Instruments manufactured on or before Dec 1, 2007

Pulse Type*:
Initial Transition*:
Pulse Amplitude*:

Pulse Duration*:

Energy (Spike Pulse)*:
Modes*:

Damping*:

Internal Matching Coil — Probe
Impedance Matching*:

PRF*:

Optional Sync Output / Input*:
Gain*:

Advanced Low Noise Design*:
Frequency Band*:

Ultrasound Velocity*:

Range*:

Display Delay*:

Probe Angle*:

Probe Delay*:

Display Modes*:

Reject*:

DAC/TCG*:

DGS*:
Gates*:
Gate Start and Width*:

Gate Threshold*:
Measuring Functions — Digital
Display Readout*:

Freeze (A-Scans and Spectrum
Graphs)*:

Encoder Interface:

Encoding:

Imaging Modes:

Length of one Straight Line
Scanning record:

Method of Record**:
Region of Interest**:

Off-Line Image Analysis**:

Data Reporting**:

Data Storage Capacity:

On-Board Computer:

RAM:

Internal Flash Memory - Quasi
HDD:

Outputs:

Screen:

Controls:

Compatibility with the external
devices:

Operating System:

Power:

Positive Spike Pulse / Positive Square Wave Pulse

<5 ns (10-90%)

Spike pulse - smoothly tunable (18 levels) 50 V ... 400 V into 50 Q at 4 levels of excitation Energy
Square wave pulse - smoothly tunable (18 levels) 50V ... 400 V into 50 Q

Spike pulse - 10...70 ns for 50 Q load depending on Energy and Damping setup

Square wave pulse - 65...600 ns independently controllable in 5 ns step

4 discrete energy values / 40 uJ (min) to 250 uJ (max) — at 400V amplitude

Single / Dual

17 discrete resistances values / 25 Q min to 1000 Q max

16 discrete inductivity values / 2 pH min to 78 uH max

0 — optionally; 15...5000 Hz controllable in 1 Hz resolution

Max +5V, 1< 5ns, t 2100 ns, Load Impedance > 50 Q

0...120 dB controllable in 0.5 dB resolution

93 nV peak to peak input referred to 80 dB gain / 35 MHz bandwidth

0.35 ... 35 MHz Wide Band / 34 Sub Bands

300...20000 m/s (11.81...787.4 "/ms) controllable in 1 m/s (0.1 "/ms) resolution

0.5...7000 ps controllable in 0.01 us resolution

0...3200 pus controllable in 0.01 us resolution

0...90° controllable in 1° resolution

0to 70 us controllable in 0.01 us resolution - expandable

RF, Rectified (Full Wave / Negative or Positive Half Wave), Signal's Spectrum (FFT Graph)

0...99 % of screen height controllable in 1% resolution

Theoretical — through keying in dB/mm (dB/") factor

Experimental — through sequential recording echo amplitudes from variously distanced equal reflectors
46 dB Dynamic Range, Slope <20 dB/us, Capacity < 40 points

Available for Rectified and RF Display

Standard Library for 18 probes / unlimitedly expandable

2 Independent Gates /unlimitedly expandable

Controllable over whole variety of A-Scan Display Delay and A-Scan Range

in 0.1 mm /// 0.001" resolution

5...95 % of A-Scan height controllable in 1 % resolution

27 automatic functions / expandable; Dual Ultrasound Velocity Measurement Mode for Multi-Layer
Structures; Curved Surface / Thickness / Skip correction for angle beam probes; Ultrasound velocity and
Probe Delay Auto-Calibration for all types of probes

Freeze All — A-Scans and Spectrum Graphs / Freeze Peak — A-Scans / All measurements functions,
manipulating Gates, and £6dB Gain varying are available for frozen signals

Built-in controller and interface for incremental mechanical encoder

Time-based (built-in real time clock — 0.02 sec resolution) — for single channel operation only
True-to-location (incremental encoder — 0.5 mm resolution) — for single and dual channel operation
Single Channel: Thickness Profile B-Scan, Cross-sectional B-Scan, Plane View CB-Scan, TOFD
Dual Channel: Thickness Profile B-Scan, Plane View CB-Scan, TOFD

50...20000 mm (2"...800"), automatic scrolling

Complete raw data recording

Controllable over entire Display Delay, Probe Delay, Range, Ultrasound Velocity and other appropriate
instrument settings

Recovery and play back of A-Scan sequence at various gain levels

Echo-dynamic pattern analysis

Defects sizing, outlining, pattern recognition

Converting Record into ASCII Format / MS Excel format / MS Word Format

Direct printout of Calibration Dumps, A-Scans, Spectrum Graphs, Thickness Profile B-Scans, cross-
sectional B-Scans, plane view CB-Scans, TOFD maps

At least 100000 sets including calibration dumps accompanied with A-Scans and/or Spectrum Graphs
At least 10000 sets including calibration dumps accompanied with Thickness Profile B-Scans, cross-
sectional B-Scans, plane view CB-Scans, TOFD maps, and complete sequence of A-Scans captured during
scanning

Pentium M 300MHz

128 Megabytes

2 Gigabytes

LAN, USB X 2, PS 2, SVGA

6.5" High Color Resolution (32 bit) SVGA 640x480 pixels 133x98 mm (5.24" x 3.86") Sun-readable LCD;
Maximal A-Scan Size (working area) — 130x92 mm (5.12" x 3.62")

Front Panel Sealed Keyboard, Front Panel Sealed Mouse, Touch Screen

PS 2 Keyboard and Mouse, USB Keyboard and Mouse, USB Flash Memory card, Printer through USB or
LAN, PC through USB or LAN, SVGA External Monitor

Windows™98SE — instrument operation

Fully compatible for networking and / or USB connection and off-line data analysis and reporting in
external PC running under Windows™98SE, Windows™2000, Windows™XP

Mains - 100...240 VAC, 40...70 Hz, auto-switch; Battery 12V 8AH up to 6 hours continuous operation
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Housing: IP 53 rugged aluminum case with carrying handle

Dimensions: 265x156x121 mm (10.43"x6.14"x4.76") - without battery
265x156x159 mm (10.43"x6.14"x6.26") - with battery
Weight: 3.150 kg (5.83 Ibs) - without battery

4.280 kg (7.88 Ibs) - with battery

* - for both channels
** _ for single and dual channel operation
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2.2. Instruments manufactured after Dec 1, 2007

Pulse Type*:
Initial Transition*:
Pulse Amplitude*:

Pulse Duration*:

Energy (Spike Pulse)*:
Modes*:

Damping*:

Internal Matching Coil — Probe
Impedance Matching*:

PRF*:

Optional Sync Output / Input*:
Gain*:

Advanced Low Noise Design*:
Frequency Band*:

Ultrasound Velocity*:

Range*:

Display Delay*:

Probe Angle*:

Probe Delay*:

Display Modes*:

Reject*:

DAC/TCG*:

DGS*:
Gates*:
Gate Start and Width*:

Gate Threshold*:
Measuring Functions — Digital
Display Readout*:

Freeze (A-Scans and Spectrum
Graphs)*:

Encoder Interface:

Encoding:

Imaging Modes:

Length of one Straight Line
Scanning record:

Method of Record**:
Region of Interest**:

Off-Line Image Analysis**:

Data Reporting**:

Data Storage Capacity:

On-Board Computer:

RAM:

Internal Flash Memory - Quasi
HDD:

Outputs:

Screen:

Controls:

Compatibility with the external
devices:

Operating System:

Power:

Positive Spike Pulse / Positive Square Wave Pulse

<5 ns (10-90%)

Spike pulse - smoothly tunable (18 levels) 50 V ... 400 V into 50 Q at 4 levels of excitation Energy
Square wave pulse - smoothly tunable (18 levels) 50V ... 400 V into 50 Q

Spike pulse - 10...70 ns for 50 Q load depending on Energy and Damping setup

Square wave pulse - 65...600 ns independently controllable in 5 ns step

4 discrete energy values / 40 uJ (min) to 250 uJ (max) — at 400V amplitude

Single / Dual

17 discrete resistances values / 25 Q min to 1000 Q max

16 discrete inductivity values / 2 pH min to 78 uH max

0 — optionally; 15...5000 Hz controllable in 1 Hz resolution

Max +5V, 1< 5ns, t 2100 ns, Load Impedance > 50 Q

0...120 dB controllable in 0.5 dB resolution

93 nV peak to peak input referred to 80 dB gain / 35 MHz bandwidth

0.35 ... 35 MHz Wide Band / 34 Sub Bands

300...20000 m/s (11.81...787.4 "/ms) controllable in 1 m/s (0.1 "/ms) resolution

0.5...7000 ps controllable in 0.01 us resolution

0...3200 pus controllable in 0.01 us resolution

0...90° controllable in 1° resolution

0to 70 us controllable in 0.01 us resolution - expandable

RF, Rectified (Full Wave / Negative or Positive Half Wave), Signal's Spectrum (FFT Graph)

0...99 % of screen height controllable in 1% resolution

Theoretical — through keying in dB/mm (dB/") factor

Experimental — through sequential recording echo amplitudes from variously distanced equal reflectors
46 dB Dynamic Range, Slope <20 dB/us, Capacity < 40 points

Available for Rectified and RF Display

Standard Library for 18 probes / unlimitedly expandable

2 Independent Gates /unlimitedly expandable

Controllable over whole variety of A-Scan Display Delay and A-Scan Range

in 0.1 mm /// 0.001" resolution

5...95 % of A-Scan height controllable in 1 % resolution

27 automatic functions / expandable; Dual Ultrasound Velocity Measurement Mode for Multi-Layer
Structures; Curved Surface / Thickness / Skip correction for angle beam probes; Ultrasound velocity and
Probe Delay Auto-Calibration for all types of probes

Freeze All — A-Scans and Spectrum Graphs / Freeze Peak — A-Scans / All measurements functions,
manipulating Gates, and £6dB Gain varying are available for frozen signals

Built-in controller and interface for incremental mechanical encoder

Time-based (built-in real time clock — 0.02 sec resolution) — for single channel operation only
True-to-location (incremental encoder — 0.5 mm resolution) — for single and dual channel operation
Single Channel: Thickness Profile B-Scan, Cross-sectional B-Scan, Plane View CB-Scan, TOFD
Dual Channel: Thickness Profile B-Scan, Plane View CB-Scan, TOFD

50...20000 mm (2"...800"), automatic scrolling

Complete raw data recording

Controllable over entire Display Delay, Probe Delay, Range, Ultrasound Velocity and other appropriate
instrument settings

Recovery and play back of A-Scan sequence at various gain levels

Echo-dynamic pattern analysis

Defects sizing, outlining, pattern recognition

Converting Record into ASCII Format / MS Excel format / MS Word Format

Direct printout of Calibration Dumps, A-Scans, Spectrum Graphs, Thickness Profile B-Scans, cross-
sectional B-Scans, plane view CB-Scans, TOFD maps

At least 100000 sets including calibration dumps accompanied with A-Scans and/or Spectrum Graphs
At least 10000 sets including calibration dumps accompanied with Thickness Profile B-Scans, cross-
sectional B-Scans, plane view CB-Scans, TOFD maps, and complete sequence of A-Scans captured during
scanning

Pentium M 300MHz

1 Gigabyte

4 Gigabytes

LAN, USB X 2, PS 2, SVGA

6.5" High Color Resolution (32 bit) SVGA 640x480 pixels 133x98 mm (5.24" x 3.86") Sun-readable LCD;
Maximal A-Scan Size (working area) — 130x92 mm (5.12" x 3.62")

Front Panel Sealed Keyboard, Front Panel Sealed Mouse, Touch Screen

PS 2 Keyboard and Mouse, USB Keyboard and Mouse, USB Flash Memory card, Printer through USB or
LAN, PC through USB or LAN, SVGA External Monitor

Windows™98SE — instrument operation

Fully compatible for networking and / or USB connection and off-line data analysis and reporting in
external PC running under Windows™98SE, Windows™2000, Windows™XP

Mains - 100...240 VAC, 40...70 Hz, auto-switch; Battery 12V 8AH up to 6 hours continuous operation

ISONIC 2007 from Sonotron NDT - Operating Manual — Revision 1.14 - Page 17 of 320



Housing: IP 53 rugged aluminum case with carrying handle

Dimensions: 265x156x121 mm (10.43"x6.14"x4.76") - without battery
265x156x159 mm (10.43"x6.14"x6.26") - with battery
Weight: 3.150 kg (5.83 Ibs) - without battery

4.280 kg (7.88 Ibs) - with battery

* - for both channels
** _ for single and dual channel operation
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3. ISONIC 2007 — Scope of Supply
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Item Order Code (Part Note
#)
ISONIC 2007 — Dual Channel Portable Digital Ultrasonic Flaw Detector SA 80470

. ISONIC 2007 Electronic unit — including:
> Internal PC (P-MMX-S - 300 MHz, RAM-1G, Quazi-HDD Flash Memory
Card 4G, active TFT sVGA LCD High Color Sun-Readable Touch Screen,
Built-In Interfaces: 2XUSB; Ethernet; PS/2; Front Panel Sealed Keyboard
and Mouse; sVGA output)
> 100 ... 250 VAC AC/DC converter
> SE 248000 - UDS 3-5 Pulser Receiver Card X 2:
Q Combined “Spike wave — Selectable Energy” / “Square Wave
— Tunable Width” Tunable Firing Level Pulser; Single / Dual Modes of
Operation; Damping: 17 discrete resistances values / 25Q min to 1000Q
max; Internal Matching Coil — Probe Impedance Matching: 16 discrete
inductivity values / 2 uH min to 78 uH max; Special Probe Protection
Circuit to Prevent Probe Damage for Not Properly Adjusted Pulse Width
d Gain: 0...120 dB controllable in 0.5 dB resolution; Advanced
Low Noise Design: 93uV peak to peak input referred to 80 dB gain / 35
MHz bandwidth; Frequency Band: 0.35 ... 35 MHz Wide Band / 34 Sub
Bands
O  Built-In Incremental Encoder Interface

. Software
4d  ISONIC 2006 Multi-Functional Package (SWA 99C07200)

® Single Channel A-Scan Inspection and Straight Line
Scanning Inspection and recording
4 A-Scan

= A-Scan (Full Wave / Neg Wave / Pos Wave
rectification; RF)
= Selectable A-Scan color scheme

= DAC, DGS, TCG

= Auto Calibration for Straight Beam and Angle Beam
Probes

= Curved Surface / Wall Thickness / Skip - Correction
for Angle Beam Inspection

= Smart Automatic Measurements of Gated Signals -
Flank / Flank First / Top / Top First; Auto-Marking Measuring Points on A-
Scan

= FFT (Frequency Domain Signal Presentation) -
additional feature for defects evaluation and / or pattern recognition /
probes characterization

= Enhanced Signal Evaluation for Live and Frozen A-
Scans including Gain Adjustments whilst in Freeze Mode

= Dual Ultrasound Velocity Multiecho Measuerements
Mode

= Comprehensive Setup and A-Scan / FFT graph
report, Direct Connection To any Type of USB or LAN Windows Printer

€  Thickness Profile Imaging and Recording (Typical
Application: Corrosion characterization)

= Continuous measuring of thickness value along
probe trace

= Time-based (real time clock) and true-to-location
(built-in incremental encoder interface) modes of data recording

= Recording of complete sequence of A-Scans along
with thickness profile

= Off-line evaluation of thickness profile images
featured with:

P Sizing of thickness damages at any location
along stored image - remaining thickness, thickness loss, and length
of damage

» Play-back and evaluation of A-Scans obtained
during thickness profile recording

» Echodynamic pattern analysis

»  Off-line reconstruction of thickness profile image
for various Gain / Gate setup
= Comprehensive Setup and Scanning Reporting,
Direct Connection To any Type of USB or LAN Windows Printer
€  B-Scan cross-sectional imaging and recording of
defects for longitudinal and shear wave inspection (Typical
Application: Pulse echo inspection of welds, composites, metals,
plastics, and the like)
= Continuous measuring of echo amplitudes and
reflectors coordinates along probe trace
= Time-based (real time clock) and true-to-location
(built-in incremental encoder interface) modes of data recording
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Item Order Code (Part Note
#)

= Recording of complete sequence of A-Scans along
with B-Scan defects images
= Off-line evaluation of B-Scan record images featured
with:
P Sizing of defects at any location along stored
image — coordinates and projection size

» Play-back and evaluation of A-Scans obtained
during B-Scan imaging and recording

» Echodynamic pattern analysis

» Defects outlining and pattern recognition based
on A-Scan sequence analysis

» Off-line reconstruction of B-Scan defects images
for various Gain / Rejection level setup

» DAC /DGS B-Scan normalization

= Comprehensive Setup and Scanning Reporting,
Direct Connection To any Type of USB or LAN Windows Printer
€  CB-Scan horizontal plane-view imaging and
recording of defects for shear, surface, and guided wave inspection
(Typical Application: Long range pulse echo and CHIME inspection of
annular plates and piping, stress corrosion, etc; weld inspection,
surface wave inspection)
= Continuous measuring of echo amplitudes and
reflectors coordinates along probe trace
= Time-based (real time clock) and true-to-location
(built-in incremental encoder interface) modes of data recording
= Recording of complete sequence of A-Scans along
with CB-Scan defects images
= Off-line evaluation of CB-Scan record images
featured with:

P Sizing of defects at any location along stored
image — coordinates and projection size

» Play-back and evaluation of A-Scans obtained
during CB-Scan imaging and recording

» Echodynamic pattern analysis

» Defects outlining and pattern recognition based
on A-Scan sequence analysis

» Off-line reconstruction of CB-Scan defects
images for various Gain / Rejection level setup

» DAC /DGS CB-Scan normalization

= Comprehensive Setup and Scanning Reporting,
Direct Connection To any Type of USB or LAN Windows Printer
€ TOFD Inspection — RF B-Scan and D-Scan Imaging
(Typical Application: weld inspection; CHIME inspection)
= Time-based (real time clock) and true-to-location
(built-in incremental encoder interface) modes of data recording

= Averaging A-Scans whilst recording as per operator's
selection

= Recording of complete sequence of A-Scans along
with TOFD map

= Off-line evaluation of TOFD Map featured with:

» Improvement of near to surface resolution
through removal of lateral wave and back echo records from TOFD
Map

P Linearization and straightening of TOFD Map

P Increasing contrast of TOFD images through

varying Gain and rectification
» A-Scan sequence analysis

» Defects pattern recognition and sizing

= Comprehensive Setup and Scanning Reporting,

Direct Connection To any Type of USB or LAN Windows Printer
® Dual Channel A-Scan Inspection and Straight Line
Scanning Inspection and recording
¢ A-Scan

= A-Scan (Full Wave / Neg Wave / Pos Wave
rectification; RF)

= Selectable A-Scan color scheme

= DAC, DGS, TCG

= Auto Calibration for Straight Beam and Angle Beam
Probes
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Item Order Code (Part Note
#)

= Curved Surface / Wall Thickness / Skip - Correction
for Angle Beam Inspection

= Smart Automatic Measurements of Gated Signals -
Flank / Flank First / Top / Top First; Auto-Marking Measuring Points on A-
Scan

= FFT (Frequency Domain Signal Presentation) -
additional feature for defects evaluation and / or pattern recognition /
probes characterization

= Enhanced Signal Evaluation for Live and Frozen A-
Scans including Gain Adjustments whilst in Freeze Mode
= Dual Ultrasound Velocity Multiecho Measurements
Mode
= Comprehensive Setup and A-Scan / FFT graph
report, Direct Connection To any Type of USB or LAN Windows Printer
€ Dual Channel Thickness Profile Imaging and
Recording
= Continuous measuring of thickness value along
probe trace
= True-to-location (built-in incremental encoder
interface) modes of data recording
= Recording of complete sequence of A-Scans along
with thickness profile
= Off-line evaluation of thickness profile images
featured with:
P Sizing of thickness damages at any location
along stored image - remaining thickness, thickness loss, and length
of damage

» Play-back and evaluation of A-Scans obtained
during thickness profile recording

» Echodynamic pattern analysis

»  Off-line reconstruction of thickness profile image
for various Gain / Gate setup
= Comprehensive Setup and Scanning Reporting,
Direct Connection To any Type of USB or LAN Windows Printer
€  Dual Channel CB-Scan horizontal plane-view
imaging and recording of defects for shear, surface, and guided wave
inspection
= Continuous measuring of echo amplitudes and
reflectors coordinates along probe trace
= True-to-location (built-in incremental encoder
interface) modes of data recording
= Recording of complete sequence of A-Scans along
with CB-Scan defects images
= Off-line evaluation of CB-Scan record images
featured with:
P Sizing of defects at any location along stored
image — coordinates and projection size
» Play-back and evaluation of A-Scans obtained
during CB-Scan imaging and recording

» Echodynamic pattern analysis
» Defects outlining and pattern recognition based
on A-Scan sequence analysis

» Off-line reconstruction of CB-Scan defects
images for various Gain / Rejection level setup
» DAC /DGS CB-Scan normalization
= Comprehensive Setup and Scanning Reporting,
Direct Connection To any Type of USB or LAN Windows Printer
€ Dual Channel TOFD Inspection — RF B-Scan and
D-Scan Imaging
= True-to-location (built-in incremental encoder
interface) modes of data recording
= Averaging A-Scans whilst recording as per operator's
selection
= Recording of complete sequence of A-Scans along
with TOFD map
= Off-line evaluation of TOFD Map featured with:
» Improvement of near to surface resolution

through removal of lateral wave and back echo records from TOFD
Map

» Linearization and straightening of TOFD Map
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# Item Order Code (Part Note
#)
P Increasing contrast of TOFD images through
varying Gain and rectification
» A-Scan sequence analysis
» Defects pattern recognition and sizing
= Comprehensive Setup and Scanning Reporting,
Direct Connection To any Type of USB or LAN Windows Printer
. USB Flash Drive for External Data Storage
. 12 months warranty
. Lifetime free software update
2 | Backup Pen-drive SFD 2007098 [Operating Manual on the
Pen-Drive
3 | Silicon Rubber Jacket SK 2007111  (Optional item
4 | Rechargeable Battery Ni MH 9 AH / 12V SK 2005102  [Optional item
5 | Battery Charger SK 2005103  [Optional item
Required for battery charge
6 | Travel Hard Case SK 2005104  (Optional item
IAllows safe cargo
transportation
7 | External USB Keyboard SK 2005105  [Optional Item
Extremely Useful at
Postprocessing Stage
8 | External USB Optical Mouse SK 2005106  (Optional Item
Extremely Useful at
Postprocessing Stage
9 | Postprocessing SW Package for Office PC: IOFFICE - ISONIC Office SWAQ9C0203 |Optional
= comprehensive postprocessing of inspection results files captured
by ISONIC 2001, ISONIC 2005, ISONIC 2006, ISONIC 2007, ISONIC
2008
= automatic creating of ISONIC 2001, ISONIC 2005, ISONIC 2006,
ISONIC 2007, ISONIC 2008 inspection reports in MS Word® format
10 |Dual Channel TOFD preamplifier package including: SA 80442 Optional Item

= Dual Channel TOFD preamplifier
= Set of 2 low noise coaxial cables (10 meters length each) for
connection to the signal input of ISONIC instrument

Improves long cable
connection to ultrasonic
probes. Typical applications
are TOFD, Corrosion
Detection, etc performed
with probes fitted into
scanner / crawler frame —
refer to chapter 10 of this
Operating Manual

11

ISONIC Alarmer - standard firmware configuration and hardware platform
including:

= Internal Speaker functioning according to alarm logic settings of UDS
3-5 Pulser Receiver in the ISONIC 2005, 2006, 2007 instruments / UDS
3-6 Pulser Receiver of ISONIC 2008 Instrument

= Speaker Volume Control Wheel

= Headphone Connector

= 25-pin programmable Input / Output interface (blank)

= USB port and cable for connecting to ISONIC 2005, 2006, 2007,
2008 instrument

SE 554780987

Optional Item
Refer to paragraph 8.8.5 of
this Operating Manual

12

Ultrasonic probes, fixtures, scanners, cables and other accessories
depending on the inspection tasks to be resolved

Optional ltems

Ultrasonic probes, fixtures,
scanners, cables and other
accessories from any

manufacturer may be used
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4. Operating ISONIC 2007
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Please read the following information before you use ISONIC 2007. It is essential to read and understand
the following information so that no errors occur during operation, which could lead damaging of the unit or
misinterpretation of inspection results

4.1. Preconditions for ultrasonic testing with ISONIC 2007

Operator of ISONIC 2007 must be certified as at least Level 2 Ultrasonic Examiner additionally having the
adequate knowledge of

e operating digital ultrasonic flaw detector

e basics of computer operating in the Windows™ environment including turning computer on/off,
keyboard, touch screen and mouse, starting programs, saving and opening files
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4.2. ISONIC 2007 Controls and Terminals

®

PS 2 Port Switch has 2 positions:
Front — Front Panel Keyboard and Mouse active; PS2 Port inactive
Rear — Front Panel Keyboard and Mouse inactive; PS2 Port active
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4.3. Turning On / Off

ISONIC 2007 may be powered from:

O 100...250 VAC through external AC/DC converter
O External 11...16V DC source (12V — typical)
O Rechargeable battery (optionally)

AC Power Supply

O  Ensure that power switch is in O position before connecting power cords

O Connect one end of AC power cord to AC/DC converter and plug another end into AC mains

O Connect DC power cord with suppression filter outgoing from AC/DC converter to DC Supply
Voltage Input of ISONIC 2007

External DC Power Supply

O Ensure DC mains do supply voltage between 11 V and 16 V

O Ensure that power switch is in O position before connecting power cord
O Connect one end of DC power cord with suppression filter to DC Supply Voltage Input of
ISONIC 2007 and plug another end into DC mains

Battery

O Ensure that power switch is in O position
O Plug in battery and fix it using 4 screws

Power-Up and Turn Off

To Power-Up ISONIC 2007 set power switch into | position. An automatic system test program will then be
executed; during this test various texts and information appear followed by the screen as below while
booting up

Instruments manufactured on or before Dec 1, Instruments manufactured after Dec 1, 2007
2007

Sonron NDT

ISONIC Instruments Line

Wait until |ISONIC 2007 start sgreenl becomes active automatically upon boot up is completed

[1|operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down
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— ' -
Click on 1o Jorpress 1 on front panel keyboard or press [F1{ on external keyboard to operate
ISONIC 2007 — refer to Chapters 5 through 7 of this Operating Manual

2 |Settings . -
Click on LJ or press 2 on front panel keyboard or press on external keyboard to proceed
with general settings of ISONIC 2007 — refer to Chapters 8 and 9 of this Operating Manual

| 3 |Exit To Windows
Click on —J or press _3 Jon front panel keyboard or press on external keyboard if it is

necessary to fulfill some general purpose Windows procedures such as setting up drivers for external
devices (printers, USB memory card, and the like), connecting to LAN, quasi-disk management, etc — refer
to Chapter 8 of this Operating Manual

= ' -
To turn ISONIC 2007 off click on ™" or press on —%__ on front panel keyboard or press [F4| on
external keyboard then wait until the screen as below appears:

Instruments manufactured on or before Dec 1, Instruments manufactured after Dec 1, 2007
2007

It°'s now safe to turn off
the ISONIC

Set power switch into O position upon

®

After turning ISONIC 2007 OFF wait at least 10...30 seconds before switching it ON again
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5. UDS 3-5 Pulser Receilver Channels
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5.1. Start Up UDS 3-5 Pulser Receiver

. . . . T‘Opsrata 7
While ISONIC 2007 start screen| is active click on or press _J on the front panel

[1]|operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down

keyboard or press on external keyboard

ISONIC 2007 from Sonotron NDT - Operating Manual — Revision 1.14 - Page 31 of 320



5.2. Main Operating Surface

Both UDS 3-5 pulser receiver channels of ISONIC 2007 instrument are fully controllable through identical

main operating surface:

UDS3-5 - ISONIC Pulser/Beceiver

CH 1+2 |

CH1

CH 2 |

B -

= By

5 Range
R «

LER S

20  US Velocity
5920 mfs ‘

e By

0.2 Dizplay Delay ‘
5 2 s

4= By

Beject

"

0 %
Yl PULSER  RECEIVER  GATEA Menu "Df ? b%
GATE B ALARM  DAC/TCG  MEASURE  Selection
[ [ & H|l =&
Cloze EM| 11 mm Freeze Save | Open| Print

Value Box - Digital Readout

UD53-5 - ISONIC Pulzer/Receiver

CH1 CH?2 CH 1+2
f

0.5

36 dB ‘

Gain

= Ty

1 Range
«

Mo By

10 U5 Velocity
"1 3256 mis ‘

o By

1 Display Delay
1? 45 1S ‘

4= By

Al -

e By

BASICS PULSER RECEIVER

ALARM DAC/TCG
]
Close | IRy | 19.21 ps

GATE A
MEASURE

Menu
Selection

- »

(ll)s' 3

=

Print

GATE B

=
Open

Save

Freeze

Value Box - Digital Readout

CH1 CH 2 |

To switch between Channels (CH) 1 and 2 click on | and
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Clicking on CH 1+2 |al|ows monitoring of both A-Scans obtained by CH 1 and CH 2 simultaneously:

ISONIC 2007 |

CHANMEL 1

CHANMEL 2

CHANMEL 1 e
Click on or press _1_J on the front panel keyboard or on external keyboard to return to

control of CH 1

CHANMEL 2 Fa
Click on or press _2_J on the front panel keyboard or on external keyboard to return to

control of CH 2

I
Click on or press I J on the front panel keyboard or on external keyboard to proceed

with dual channel scanning, recording, and imaging — refer to paragraph 7.1 of present Operating Manual
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5.2.1. Main Menu

Main Menu consists of eight topics; each topic is associated with corresponding submenu appearing as
vertical bar showing names for five parameters or modes of operation, their current settings and current
value of increment/decrement for a parameter. The active topic is highlighted

B -

Range

«

20  US Yelocity
5920 m/s ‘

0.2 Display Delay

«

UD53-5 - ISONMIC Pulser/Receiver

I CH1 CH?2 | CH 1+2 |

BASICS PULSER RECEIVER GATE A Menu
GATE B ALARM DAC/TCG /A MEASURE Selection

Active Topic : i Main Menu : Vertical bar — Submenu
e . ] E Correspondlng to E
To activate a topic the following manipulations are applicable: : highlighted active tOpiC 1
* Keyboard T D 5

B Press EJ on front panel keyboard or on external keyboard until highlighting required topic
OR
B Press <Alt>+<M> on external keyboard = Menu Selection fore color changes to white - then use
e Mouse / Touch Screen
B Click on topic's name

-»

B Click on

e Combined

*t »

B Click on Menu Selection = Menu Selection fore color changes to white - then use =, "=/,

‘ , ‘ / on front panel keyboard orI . . Ion external keyboard
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5.2.2. Sub Menu BASICS

To control Gain the following
manipulations are applicable:

. .
T

v dhdh dh 4 4

R Sk 3 3%

i T N Y NS

Mouse / Touch Screen

B Click or press and hold on the appropriate

Keyboard
-
B Press 1 J on front panel keyboard or or <Alt>+<G> on external keyboard = Gain fore color

changes to white - then use !J '_’J _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on Gain = Gain fore color changes to white - then use !J '_’J :J ij on front panel
keyboard or , , on external keyboard

®

Gain setup is also possible through a number of other submenus following the same rules as above
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e

T b | by | o by |

L
0% b
. I /
To control Range the following I
manipulations are applicable: I /
/
e Mouse / Touch Screen ly

B Click or press and hold on the appropriate

e Keyboard

®

-
Press 2 J on front panel keyboard or or <Alt>+<A> on external keyboard = Range fore color

changes to white - then use !J _J _J !J on front panel keyboard or , , , on

external keyboard
Combined

Click on Range = Range fore color changes to white - then use !J '_’J :J ij on front
panel keyboard or ,, , on external keyboard

Range setup is also possible through a number of other submenus following the same rules as above

ISONIC 2007 from Sonotron NDT - Operating Manual — Revision 1.14 - Page 36 of 320



To control US Velocity the following
manipulations are applicable:

5 US Velocity

5920 mfs
100 Dizplay Delay

0 ps

Mouse / Touch Screen

B Click or press and hold on the appropriate

Keyboard

rd
m Press 3 J on front panel keyboard or or <Alt>+<U> on external keyboard = US Velocity fore

color changes to white - then use !J '_’J _J ij on front panel keyboard or , , , on

external keyboard
Combined

B Click on US Velocity = US Velocity fore color changes to white - then use !J '_’J !J !J
on front panel keyboard or , , , on external keyboard
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To control Display Delay the following l
manipulations are applicable: | /
/
e Mouse / Touch Screen 1/
4

B Click or press and hold on the appropriate
Keyboard

F
B Press _4 j on front panel keyboard or or <Alt>+<E> on external keyboard = Display Delay

fore color changes to white - then use !J '_’J _J !J on front panel keyboard or , , ,

on external keyboard

Combined
B Click on Display Delay = Display Delay fore color changes to white - then use !J '_’J !J

!J on front panel keyboard or , , , on external keyboard
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F
Click on this button or press 5 _

on front panel keyboard or or
<Alt>+<5> on external keyboard

Current value of
increment/decrement for
Reject setup,

%
to select value of
N N increment/decrement for Reject
\ setting
N\
: Current value of : N
: Reject ; N
3 % i
LT T R — ~
~
~

To control Reject the following
manipulations are applicable:

N

I
I
I

e Mouse / Touch Screen

B Click or press and hold on the appropriate

e Keyboard

F
B Press _3 _ on front panel keyboard or or <Alt>+<E> on external keyboard = Reject fore color

changes to white - then use ' ‘ ‘ , '.' on front panel keyboard or , , , on

external keyboard

e Combined

LINCIARIAA .

B Click on Reject = Reject fore color changes to white - then use = ~ J on front
panel keyboard or , , , on external keyboard

¢ Signals below Reject level (small signals) are suppressed

¢ Signals exceeding Reject level (large signals) are presented on the A-Scan without affecting their
original height

¢ Part of large signal wave form below Reject level is suppressed

Reject =20 %

A R
++++++||+-

+ +
+ +
+ +
+ +
+ A+
+ +
+ +
+ +
+ +

LY
L T
)

)
+ —— e
|II
i
!
!
{
! ;
I
|II
!
|II
+ + + + F o+ O+ S+

¢ Reject level may be applied to rectified signals only (Display Modes Full, NegHalf and PosHalf -
refer to paragraph 5.2.4 of this Operating Manual)
¢ Reject setup is also possible through a number of other submenus following the same rules as above
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5.2.3. Sub Menu PULSER

Amplitude of initial pulse (Firing Level) is controllable through button J appearing on the main operating
surface upon activating submenu PULSER

To activate |Firing Level Control subwindowl click on @

\

Tunin
e
Pulzer Mode
.
Pulze Width
226 nS ‘
D ampin
.
. "I | . 50 PEF ‘

BASICS PULSER GATE A Menu

GATE B ALARM DAC/TCG  MEASURE Selectiof.

T [ RO PPN

ln By

Cloze EM| 90 dB Freeze
L =
To control Firing Level the following manipulations are appllcabli. ,’/, -
Mouse / Touch Screen 2% -

® Click or press and hold on the appropriate Click on 2L

Firing Level Control popup window upon completing

or on any control outside

Combined

Click on Firing Level = Firing Level fore color changes to white - then use '. , ‘ , ‘ , '.'

ESC En re.r

on front panel keyboard or ﬂ E g @ on external keyboard. Press X" Jor *= on front panel
keyboard or ESc|or [Enter| on an external keyboard upon completing

®

There are 18 grades (1 through 18) for setting Firing Level — amplitude of initial pulse is controlled from
50 V (Firing Level = 1) to 400 V (Firing Level = 18)
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i Current value of
: Tuning :
5 pH 5
i o
PEEEEEEEEEEEEEEEEEEEEEREEREM ~
Pulser Mode
SINGLE
Pulse Width
220 nS
D amping
H}ﬂﬂ ‘.-'.1 *
4ﬂﬂ Hz *I
& UDS 3-5
11
To control Tuning the following 11
manipulations are applicable: 1]
e Mouse/ Touch Screen 1}
B Click or press and hold on the appropriate
e Keyboard
F 2
B Press _1 J on front panel keyboard or or <Alt>+<G> on external keyboard = Tuning fore
color changes to white - then use ?_ , ‘ ‘ '.' / on front panel keyboard orI . . Ion
external keyboard
e Combined
B Click on Tuning = Tuning fore color changes to white - then use ?_ ? . , " on front

panel keyboard or I . I on external keyboard

®

+ There are 16 (sixteen) matching coils, which may be connected at parallel to ultrasonic probe in
order to obtain best available probe impedance matching / signal to noise ratio. Possible values for

the matching coil inductance are: 2uH, 7uH, 12uH, 17uH, 24uH, 29uH, 34uH, 39uH, 41uH, 46uH,
51pH, 56pH, 63uH, 68uH, 73uH, and 78 uH

¢ Setting the Tuning to "NO" disconnects matching coil
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= By

Iro By

Pulse Width

220 nS ‘
Bl e
R «
& uns :'57’-5

To control Pulser Mode the following

——

=%

o2
vAhAh AR dh 4

iy

manipulations are applicable: III
|
e Mouse/ Touch Screen "
B Click or press and hold on the appropriate
e Keyboard
F

B Press _2 _J on front panel keyboard or or <Alt>+<U> on external keyboard = Pulser Mode

fore color changes to white - then use !_ ?/ . , !' on front panel keyboard or , , ,
on external keyboard

e Combined

®

There are two Pulser Modes available: Single and Dual
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Current value of Pulse Width

: Tuning
----------------- \-:-:---------" ]2 I.I.H ‘
~

(Duration of Square Wave
Initial Pulse)
ns

Pulser Mode
SINGLE ‘

ﬂl
e «
\_I uM 3-5

To control Pulse Width the following

>~

"'""l""""

Ty | = by [ 1o by | o by [ =y

manipulations are applicable: ' I
Iy

e Mouse/Touch Screen I/

B Click or press and hold on the appropriate
e Keyboard

i
B Press 3 J on front panel keyboard or or <Alt>+<E> on external keyboard = Pulse Width
fore color changes to white - then use ' , ‘ ‘ ‘ / on front panel keyboard orl . .

on external keyboard
e Combined

INCINIIR S

B Click on Pulse Width = Pulse Width fore color changes to white - then use
on front panel keyboard or , , , on external keyboard

®

¢ Pulse Width (Duration of Square Wave Initial Pulse) is tunable between 65 ns to 600 ns in 5 ns steps

¢ Attempt to decrease Pulse Width below 65 ns switches to excitation of Spike Pulse instead of Square
Wave Pulse. There are 4 (four) energy levels available for the Spike Pulse excitation; said levels are
indicated in the Pulse Width field:

0 Spike (250uJ) — spike pulse with the 250 nJ energy of excitation
0 Spike (160uJd) — spike pulse with the 160 pJ energy of excitation
0 Spike (90uJ) — spike pulse with the 90 pJ energy of excitation
0 Spike (40uJ) — spike pulse with the 40 pJ energy of excitation

¢ The energy of Spike Pulse excitation is controllable through the same controls as Pulse Width

¢ Attempt to increase energy of Spike Pulse excitation above 250 pJ switches to excitation of Square
Wave Pulse instead of Spike Pulse

¢ Energy levels of Spike Pulse excitation are calibrated at Firing Level =
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Current value of
Damping

E 0 ; Tuning
.............. -‘--\-----------1 12 I-IH ‘
N Pulzer Mode
\\ SINGLE ‘

= by

Ina By

S Pulse Width
N

e By

N\ 220 nS

N\ D -
amping
1000 &2 '
i1} FRF
400 Hz

&| uns

4= By

Itn By

To control Damping the following
manipulations are applicable:

\\\w
LS

e Mouse/Touch Screen /

B Click or press and hold on the appropriate

e Keyboard
F 3
B Press _4 J on front panel keyboard or or <Alt>+<A> on external keyboard = Damping fore

color changes to white - then use !_ ? ‘ , .' on front panel keyboard or , , , on

external keyboard

e Combined

L IACIRRIAR

B Click on Damping = Damping fore color changes to white - then use =, "=, = J ' T J on

front panel keyboard or , , , on external keyboard

®

There are 17 (seventeen) discrete damping resistors, which may be connected at parallel to ultrasonic
probe, their resistance values are 25€2, 30€2, 35€2, 40Q2, 45Q), 56Q2, 6502, 7602, 90C2, 115C2, 13012,
15002, 18002, 24002, 320Q2, 50002, and 1000 2
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Pulser Mnde

SINGLE
Pulse YWidth
136 nS
| Ddmping
1000 2
I /
I /
To control PRF the following I /
manipulations are applicable: I /
/
e Mouse/Touch Screen 1/
|4

B Click or press and hold on the appropriate |button|

e Keyboard
-
B Press _5 J on front panel keyboard or or <Alt>+<R> on external keyboard = PRF fore color

changes to white - then use !J '_’J :J !J on front panel keyboard or , , , on

external keyboard

e Combined

B Click on PRF = PRF fore color changes to white - then use !J '_’J :J !J on front panel

keyboard or , ,, on external keyboard

®

UDS 3-5 is equipped with a protection circuit preventing probe damage, which may be caused by not proper
setting of Tuning, or Damping, or Pulse Width, or Firing Level, or combination of them. Protection circuit
limits total energy delivered to firing output through automatic reducing of PRF until reaching safe mode of
operation
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5.2.4. Sub Menu RECEIVER

Current setting of Filter
representing central frequency
of the narrow band (resonant)

SssssassssssssEss
TR RN NN NN

Filter
MHz
..................... — Gain 47
-~ 1 1 dB 1
Filter o
BB ’ —
Frequency o
0.35-3b HHZ 3
Diszplay * _pl
Full 4
Beject 4
0% ‘ 2
1
To control Filter the following I II
manipulations are applicable: 1y
e Mouse/ Touch Screen I
!
B Click or press and hold on the appropriate
e Keyboard
F
® Press _2 J on front panel keyboard or or <Alt>+<L> on external keyboard = Filter fore color
changes to white - then use ? , * . " on front panel keyboard or , , , on
external keyboard
e Combined
B Click on Filter = Filter fore color changes to white - then use ? ‘ « '.' / on front panel

keyboard or , , , on external keyboard
®

¢ The are 6 (six) narrow bands (resonant) filters with central frequencies as below:
Q 0.5%0.15 MHz — recommended for 0.3 ... 0.8 MHz probes
Q 1+0.3 MHz-recommended for 0.8 ... 1.5 MHz probes
Q 2+0.6 MHz — recommended for 1.5 ... 3.2 MHz probes
Q 4+ 1.2 MHz —recommended for 3.2 ... 7.5 MHz probes
Q 10+ 3 MHz — recommended for 7.5 ... 12.4 MHz probes
Q 15+ 4.5 MHz — recommended for 12.4 ... 17 MHz probes

¢ The narrow band (resonant) filtering is negated upon setting Filter to BB (Broad Band)
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Current Frequency band of
the receiver

MHz
From —To
................. -
N\
N\ < -
SN 1
N
_
2
_
3
_
4/
LT Beject ﬁ
/
0% ‘ 3
To control receiver's Frequency band ) /
the following manipulations are /
applicable: /

I
|
Iy
e Mouse/ Touch Screen I/
B Click or press and hold on the appropriate
e Keyboard

-
B Press 2 J on front panel keyboard or or <Alt>+<E> on external keyboard = Frequency fore

color changes to white - then use ? ‘_ « , '.' on front panel keyboard or , , , on

external keyboard
e Combined

! ‘_ ‘ '.' on

B Click on Frequency = Frequency fore color changes to white - then use
front panel keyboard or ,, , on external keyboard

®

There are 28 (twenty eight) receiver's Frequency bands:

035-35MHz 035-195MHz 035-13MHz 0.35-52MHz 035-26MHz 035-13MHz 0.35-0.65MHz
0.7 — 35 MHz 0.7 -19.5 MHz 0.7 — 13 MHz 0.7 —5.2 MHz 0.7 — 2.6 MHz 0.7 - 1.3 MHz
1.4 - 35 MHz 1.4-19.5 MHz 1.4—-13 MHz 1.4-52MHz 1.4-2.6 MHz
2.8 —35 MHz 2.8 -19.5 MHz 2.8 -13 MHz 2.8 -5.2 MHz
7 — 35 MHz 7 —19.5 MHz 7 —-13 MHz
10.5-35MHz  10.5-19.5 MHz 10.5-13 MHz
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<
Current mode of signal 1 1_ dB
: presentation (Display) : Filter ‘
'---------------{--: ---------------- ] BB
S - Frequency ‘
S~ 0.35-35 MHz
S - Dizplay ‘
Full b,
5 Beject
0% /g
To select mode of signal presentation S, 2
7/

|u?~l{ b By e by o By =y

(Display) the following manipulations
are applicable: /
//
e Mouse/ Touch Screen 4y

’

B Click or press and hold on the appropriate

e Keyboard
-
B Press _%_J on front panel keyboard or or <Alt>+<I> on external keyboard = Display fore color

changes to white - then use !_ ?/ . ! on front panel keyboard or , , , on

external keyboard

e Combined

LINCINEINS 4

B Click on Display = Display fore color changes to white - then use =/, 4, = / on front

panel keyboard or , , , on external keyboard
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®

+ There are four Display modes for time domain signal presentation:

RF —no
rectifying

PosHalf —
positive half
wave
rectifying

NegHalf —
negative half
wave
rectifying

Full — both
waves
rectifying
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¢ Frequency domain signal presentation is available through FFT Display mode. Refer to paragraph 5.2.14
of this Operating Manual for instructions related to frequency domain signal presentation

Time Domain

0.5 Gain
= )
R il «

B «
Al «
uns 2-5

1 |

DG5S

o By

ln By

]
Close Em | Freeze

Frequency Domain Signal presentation is not possible if:
o DAC is active (refer to paragraph 5.2.9 of this Operating Manual)
0 TCG is active (refer to paragraph 5.2.9 of this Operating Manual)

=
Open

«|=

Save

ISONIC 2007 from Sonotron NDT - Operating Manual — Revision 1.14 - Page 50 of 320



5.2.5. Sub Menu GATE A

Current status of Gate A

N 05 Gain
N  IEXL ‘

il 4

2 aStart *
26 mm

2 awidth [N
mm

10 aThrezhold I
45 2% ‘

7

o iy [ ety oy | |y

To switch Gate A ON / OFF the

|
following manipulations are applicable: I II
e Mouse/ Touch Screen Iy
B Click or press and hold on the appropriate
e Keyboard
F

B Press _2 _ on front panel keyboard or or <Alt>+<T> on external keyboard = aSwitch fore

color changes to white - then use !_ ?/ « , !' on front panel keyboard or , , , on

external keyboard
e Combined

B Click on aSwitch = aSwitch fore color changes to white - then use !_ ?/ « , !' on front

panel keyboard or , , , on external keyboard
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Gain -
3 dB ‘ L
aSwitch o
~
/
R o] 2
~ o
3
a"w'ldth -
8 mm ‘ 4/
aThreshold -,
45 %% * ,d
/
To control delay of Gate A (aStart) | /
the following manipulations are applicable: 1y
11/
e Mouse/Touch Screen 1/

B Click or press and hold on the appropriate

Keyboard
Fd
B Press 3 J on front panel keyboard or or <Alt>+<A> on external keyboard = aStart fore color

changes to white - then use !J '_’J !J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on aStart = aStart fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)

®

¢ aStart setup is also possible through a number of other submenus following the same rules as

above
¢ Counting of aStart value starts after finishing of Probe Delay count (refer to paragraphs 5.2.12
and 5.2.13 of this Operating Manual)
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aStart
26 mm

g | 0 By [0 | 1=y

awidth
8 mm ‘ 2
10 aThreshold " o

4b 2% 5
To control duration of Gate A (awidth) , /
the following manipulations are applicable: I /

/

e Mouse/ Touch Screen 1y

B Click or press and hold on the appropriate

Keyboard
F
B Press _4 j on front panel keyboard or or <Alt>+<W> on external keyboard = aWidth fore

color changes to white - then use !J _J _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on awidth = awidth fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)

ISONIC 2007 from Sonotron NDT - Operating Manual — Revision 1.14 - Page 53 of 320



To control threshold level of Gate A
(aThreshold) the following manipulations
are applicable:

aT hrezhold
45 2% ;

/
/

|

|

|
Mouse / Touch Screen 1/

[ 4

B Click or press and hold on the appropriate

Keyboard

-
B Press'_5 J on front panel keyboard or or <Alt>+<E> on external keyboard = aThreshold fore

color changes to white - then use !J '_’J _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on aThreshold = aThreshold fore color changes to white - then use !J '_’J :J !J
on front panel keyboard or , , , on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)
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5.2.6. Sub Menu GATE B

thdth
ozmm K

hT hreshold
B «

7

To switch Gate B ON / OFF the

|
following manipulations are applicable: I II
e Mouse/ Touch Screen Iy
B Click or press and hold on the appropriate
e Keyboard
F
B Press _2 J on front panel keyboard or or <Alt>+<T> on external keyboard = bSwitch fore
color changes to white - then use !_ , ‘ « ! on front panel keyboard or , , , on

external keyboard

e Combined

L)

B Click on bSwitch = bSwitch fore color changes to white - then use =/,

panel keyboard or , , , on external keyboard

» & (&
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b witch

ON
2 bS5tart

47 .9 mm

2 bwidth

13.2 mm
10 bThreshold

40 %5

To control delay of Gate B (bStart) (I
the following manipulations are applicable: 1y

11/
e Mouse/Touch Screen 1/

B Click or press and hold on the appropriate

Keyboard
Fd
B Press 3 J on front panel keyboard or or <Alt>+<A> on external keyboard = bStart fore color

changes to white - then use !J _J _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on bStart = bStart fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)

®

Counting of bStart value starts after finishing of Probe Delay count (refer to paragraph 5.2.12 and
5.2.13 of this Operating Manual)
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To control duration of Gate B (bWidth)
the following manipulations are applicable:

Mouse / Touch Screen

B Click or press and hold on the appropriate
Keyboard

F
B Press _4 j on front panel keyboard or or <Alt>+<W> on external keyboard = bWidth fore

color changes to white - then use !J _J _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on bWidth = bWidth fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)
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To control threshold level of Gate B
(bThreshold) the following manipulations
are applicable:

bSwnlch
N

2,  bwdth

13.2 mm
bThrezhold

40 %%

|

|

|
Mouse / Touch Screen 1/

[ 4

B Click or press and hold on the appropriate
Keyboard

-
B Press'_5 J on front panel keyboard or or <Alt>+<E> on external keyboard = bThreshold fore

color changes to white - then use !J '_’J _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on bThreshold = bThreshold fore color changes to white - then use !J '_’J :J !J
on front panel keyboard or , , , on external keyboard

Drag and Drop (refer to paragraph 5.2.7 of this Operating Manual)
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5.2.7. Drag and Drop: Gate A and Gate B

Gate A and Gate B may be manipulated through Drag and Drop provided that they are visible in the A-
Scan area. |[Mouse pointer changes shape| while placing it above appropriate section of a gate

05 Gain
e K
1

Range

«
Alarm Switch

«
Alarm Logic

+ «

Setup Gate

uns 2-5

=

Print

"

o By

e By

= By

)
Illl'| f

nj
—h e W, . LT il W

[en By

e,

BASICS PULSER RECEIVER GATE A Menu
GATE B ALARM DAC/TCG  MEASURE Selection

[~ [@ M
Cloze m I Freeze

e
DG5S

Save

=
Open

-

To manage a gate just press and hold left mouse button or touch screen stylus and drag, then drop through
releasing of left mouse button or touch screen stylus
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5.2.8. Sub Menu ALARM

------------------------------------- 1
Alarm Switch status for 3dB 3dB

! selected Gate is shown here 1 Range ‘ 1 Range ‘
FesssEsEEEEEEEEEEEEEEEEEEEEREEREE ‘- -: ‘I ﬂﬂ mm .I ﬂﬂ mm
AN Alarm Switch Alarm Switch ‘

GN ON

Alarm Logic Alarm Logic

Positive Negative
~ Setup Gate

GATE B

To select a Gate for Alarm Setup the 4 //
following manipulations are applicable: / p -
I ” -
/ - -
e Mouse/Touch Screen 1, o -
-
m Click or press and hold on the appropriate

e Keyboard

F
B Press _3 _ on front panel keyboard or or <Alt>+<T> on external keyboard = Setup Gate fore

color changes to white - then use ?_ ? « , '.' on front panel keyboard or , , , on

external keyboard
e Combined

LY

B Click on Setup Gate = Setup Gate fore color changes to white - then use =,
on front panel keyboard or , , , on external keyboard

® = =
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0.5 Gain

3 dB ‘
1 Ra
100mm B

8  Alarm Switch
ON

Alarm Switch
ON

R

Alarm Logic * Alarm Logic
Positive 7 Negative
Setup Gate I y g Sehup Gate
GATE A ‘ y 5 GATEB
L
/
To control Alarm Switch the Iy
following manipulations are Iy
applicable: 1y P
lr <, s
e Mouse/ Touch Screen llé//
B Click or press and hold on the appropriate
e Keyboard

-
B Press 2 J on front panel keyboard or or <Alt>+<W> on external keyboard = Alarm Switch

fore color changes to white - then use ?_ ? . , " on front panel keyboard or , , ,
on external keyboard

e Combined

D &

B Click on Alarm Switch = Alarm Switch fore color changes to white - then use ?

" on front panel keyboard or , , , on external keyboard
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"

A A A A A nn ke . Gai 05 Gain
Alarm Logic : 1 3 dB ‘
- » 1

................................ R al Range
» oo R

Alarm Switch
on K

Alarm Logic Alarm Logic

Positive : Negative
Setup Gale

o By

e By

len g = By

To select Alarm Logic the
following manipulations are applicable:

e Mouse/Touch Screen Iy 2
&

B Click or press and hold on the appropriate Ibuttonl

e Keyboard
-
m Press _4 J on front panel keyboard or or <Alt>+<L> on external keyboard = Alarm Logic

fore color changes to white - then use ?_ ? « , '.' on front panel keyboard or , , ,
on external keyboard

e Combined

LRI

B Click on Alarm Logic = Alarm Logic fore color changes to white - thenuse =, =, ~J ' T
on front panel keyboard or , , on external keyboard
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®

Alarm Example

= By

vdh dh 4bh 4h 4

05 Gain
e K
1

Range

T

100 mm
Alarm Switch
«
Alarm Logic
«
Setup Gate

GATE A

BASICS _ PULSER _ RECEIVER  GATE A Menu "D" ? - s
GATE B ALARM DAC/TCG MEASURE Selection
|_ Yalue: OFF ﬁ ﬂ & = I L
Cloze b Alarm ~ ~ Freeze Save | Open DGS
L. ~ -

S [ e ‘

: Alarm Indicator for : : Alarm Indicator for :

: Gate A : i GateB :

+ There is a pulse matching with Gate A and exceeding its threshold; the Alarm Logic setting for Gate A
is Positive = Alarm Indicator for Gate A is active

+ There is a pulse matching with Gate B and not exceeding its threshold; the Alarm Logic setting for Gate
B is Negative = Alarm Indicator for the Gate B is active
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5.2.9. Sub Menu DAC/TCG

Current status of ]
3 DAC/TCG/DGS N 1
PR TP P PP P P PP PN —
DAC/TCG/DGS "
Current quantity of : OFF 2
: stored echoes \ 2 aStart I r
: composing DAC :~ ~ 30 mm :‘ 3/
A ——_ ~ ~ ] F"
: Status of DAC : shombac T
: curve o~ - now o
Curve OFF 5
To select required mode for /
DAC/TCGI/DGS the following Iy
manipulations are applicable: Iy
I/
e Mouse/Touch Screen Iy
B Click or press and hold on the appropriate

e Keyboard

Fa

B Press _2_ on front panel keyboard or or <Alt>+<T> on external keyboard = DAC/TCG/DGS

fore color changes to white - then use ? ‘_ « , '.' on front panel keyboard or , , ,
on external keyboard

e Combined

B Click on DAC/TCG/DGS = DAC/TCG/DGS fore color changes to white - then use !
'.' on front panel keyboard or , , , on external keyboard

®

» &

S ——
[ | ’

¢ There are four possible modes for DAC/TCG:
There are four possible modes for DAC/TCG:

OFF - DAC Curve switches automatically to OFF while in OFF

DAC - available if quantity of stored echoes is 2 (two) or more. DAC Curve switches
automatically to ON while in DAC mode. Both experimental and theoretical methods for creating
DAC are available

TCG - available if quantity of stored echoes is 2 (two) or more. DAC Curve switches
automatically to OFF while in TCG mode

Update - allows to create/update new/existing DAC. Update of existing DAC performed through
erasing of a number of sequentially recorded echoes, starting from the latest one, and/or
recording of new echoes. The maximal number of echoes recorded into the one DAC is 40
(forty). DAC Curve switches automatically to ON if the number of recorded echoes is 2 (two) or
more and switches automatically to OFF if number of recorded echoes is less than 2 (two) while
in Update mode

¢ Itis possible to Create / Modify / Activate DAC and TCG for all Display modes (RF, Full, Negative, and
Positive)

¢ To create / modify DAC/TCG or DGS refer to paragraphs 5.2.10, 5.2.11 of this Operating Manual
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5.2.10. Create / Modify DAC
5.2.10.1 Theoretical DAC: dB/mm (dB/in)

Theoretical DAC represents pure exponential law for distance amplitude curve; said law is determined by
dB/mm (dB/in) factor and value of Probe Delay - refer to paragraphs 5.2.12, 5.2.13 of this Operating
Manual: at zero material travel distance theoretical DAC has start point at 100% of A-Scan height

Set DAC/TCG/DGS to Update then click

UD53-5 - ISONMIC Pulser/Receiver

1 Gain

s K

= Ty

32 dB
DAC/ICG/DGS
Update ‘
2 aStart
.
Show DAC
Curve OFF

BASICS PULSER _RECEIVER  GATE A Menu dwmml "D’l ? - s
GATE B ALARM DI MEASURE  Selection
ol Value: OFF I i = &

Close Em I Freeze Save EBrint

LERL 8

o By

= By

e By

L
DG5S

=
DOpen
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Click on this button or press
rF
1 on front panel keyboard or

or <Alt>+<1> on external
keyboard to select value of
increment/decrement for dB/mm
(dB/in) factor setting

Current value of

Current value of i . £
. increment/decrement for :

i dB/mm (dB/in) factor _ _
i dB/mm (dB/in) factor setting

DAC/TICG/DGS

Update
2 aStart

29 ¢ mm

Show DAC
Curve OFF

BASICS PULSER BRECEIVER GATE A _ dB/mm 10.001
GATE B ALARM MEASURE Selection

/7

i Theoretical DAC according to P // s
: entered dB/mm (dB/in) factor : /7 7
To control dB/mm (dB/in) factor the following P // 7
manipulations are applicable: P s
e Mouse /Touch Screen ,é

B Click or press and hold on the appropriate
e Keyboard

B Press '. , ‘ ‘ , ‘ on front panel keyboard or , , , on external keyboard
On completing dB/mm (dB/in) factor setting click on Ok or press =4/ on front panel keyboard

Enter|on external keyboard. This will return to main operating surface of UDS 3-5 Pulser Receiver and

dB/mm
activate theoretical DAC. Button becomes green while theoretical DAC is setup; set
DAC/TCG/DGS to DAC to activate theoretical DAC or to TCG if it is necessary to perform time correction of
gain in accordance with theoretical DAC law.

dB/
To modify or switch theoretical DAC off set DAC/TCG/DGS to Update then click on o . In the
appeared popup subwindow modify value dB/mm (dB/in) factor as it is described above or click on

OFF then on OK
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5.2.10.2 Experimental DAC: recording signals from variously located reflectors
If theoretical DAC is active then it must be switched off according to paragraph 5.2.10.1 of this Operating
Manual prior to building of experimental DAC. Switch on Gate A then set DAC/TCG/DGS to Update. Place

probe onto DAC calibration block and maximize echo from the reflector closest to the probe (first echo) then
place Gate A over received signal and capture first DAC echo

UD53-5 - ISONIC Pulser/Beceiver |
‘
¢
¢
o -

Show DAC
Curve OFF

BASICS PULSER RECEIVER GATE A Menu
GATE B ALARM DAC/TCG oAl Selection

HE
Cloze m I Freeze

To capture DAC echo the following
manipulations are applicable:

e Mouse/ Touch Screen

m Click fon]

e Keyboard
-
B Press _4 J on front panel keyboard or or <Alt>+<R> on external keyboard = Rec fore color

changes to white - then use ' ‘ ‘ , '.' on front panel keyboard or , , , on

external keyboard

e Combined

T » ol

B Click on Rec = Rec fore color changes to white - then use =, ' -~ on front panel keyboard or
on external keyboard

will appear

As a result the first DAC echo will be stored and corresponding
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Place probe onto DAC calibration block and maximize echo from next reflector then place Gate A over
received signal and capture next DAC echo. As result next DAC echo will be stored causing appropriate
modifying of [corresponding indications)

1 Gain

= Yy

24 dB ‘
DAC/ICG/DGS

Update ‘

1 aStart

3.3 mm

o By

[ By

= By

Show DAL
Curve ON

len By

¢ The highest echo in the Gate A will be stored said echo may either exceed Gate A threshold level or not
¢ Stored echo must be below 100% of A-Scan height

+ Atotal number of 40 echoes may be stored one by one by the same way as described above
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After creating a DAC (2 or more echoes stored) the DAC and / or TCG may be activated.
There are two styles of DAC indication in the DAC mode: Main Curve Only and Main Curve £ N dB, where

IN may be setup either as 2, 4, 6, 8,10, 12, or 14 dB|. To proceed follow the rules below:
1 Gain
.
DAC/TCG/DGS
.
1 aStart
.

= by

P By

o2
v Ah A AA 4

= By

len By

N
= B\

I~
vAhAh A\ 4

DAC/TC
DAC
1 aSkart
165 .3 mm

e By

= By

Show CALC
Curve+6dE

o iy

v =T
e Mouse/ Touch Screen y‘ = z -
B Click or press and hold on the appropriate
e Keyboard
F

B Press _35__ on front panel keyboard or or <Alt>+<H> on external keyboard = Show DAC fore
color changes to white - then use ' , * , . , " on front panel keyboard or , , , on

external keyboard
e Combined

B Click on Show DAC = Show DAC fore color changes to white - then use ' ‘ ‘ , '.'
on front panel keyboard or , , , on external keyboard
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It's possible to erase the last stored echo from the DAC. To proceed set the DAC/TCG/DGS to Update:

To erase the last stored echo from the DAC the following manipulations are applicable:
e Mouse/ Touch Screen

B Click Jonj.,

UDS53-5 - ISONIC Pulser/Neceiver
~

= by

DAC/ICG/DGS
Update

e By

Show DAC
Curve ON
BASICS PULSER _RECEIVER  GATE A Menu "D’l 2 - 5
GATE B ALARM DXV MEASURE  Selection
P Value: OFF = “
1 || I
LCloze m Freeze Save | Open DG5S
e Keyboard
F

B Press _4 J on front panel keyboard or or <Alt>+<R> on external keyboard = Rec fore color

changes to white - then use ‘ , ‘ on front panel keyboard or E Q on external keyboard

e Combined

B Click on Rec = Rec fore color changes to white - then use ‘ , ‘
Q, { on external keyboard

As a result the last stored echo will be erased causing appropriate modifying of |corresponding indications|

/ on front panel keyboard or

DAC/ICG/DGS
Update

e By

.
.
| Tyl Tl T TrrT T T T
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5.2.11. DGS
DGS A
To setup DGS set Display to Full then click on L= or press ﬂj on front panel keyboard or or

<Alt>+<D> on external keyboard. The following screen appears:

Disk shaped reflector (flat bottom hole - FBH)
: echo amplitude as function of metal travel

Back echo amplitude as function of metal :
travel distance in the reference block for the
selected probe :

distance in the material under test for the
selected probe and FBH diameter

= Ty

Mo By

o By

5 U5 Velocity
3250 mjs ‘
100 Dizplay Delay
982 s ‘
L] Beject

BACICC . sl B
| DGES Setup: SWB-60-5 f 7.7 mm

I |
|swB-60-5 i 3 dB

R Eouivalont Dia |~ Tianstertoss
| ~ 0dB

L
A
Y
I Materiarattenuation JIY ¢
L
Al
Y

4= By

e By

K1 AVgq[1 51 =-165dB Backwall Echo

S
|‘| 0 dB/m
Reference Attenuation

Setup Step
G dB [dE./m] (+ 2 dB [dB/m] — 1 dB [dB/m)

Close |\\ 0 dB/m \\

: Equivalent Diameter  :
TR R R =
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To activate DGS follow the steps below:

Step 1: Probe Selection

The following manipulations are applicable for the Probe selection:

e Mouse/ Touch Screen

B Click on m |Scroll probes list to see the selected onel

MwB-60-2

B Click on |selected probe

e Keyboard

2 »

B Press <Alt>+<P> on external keyboard = Probe fore color changes to white — then use =/, '~

:‘r, _!,/ on front panel keyboard or , , , on external keyboard

e Combined

t » @&« 3

B Click on Probe = Probe fore color changes to white - then use =, "=, = J ' T J on front

panel keyboard or , , , on external keyboard
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Step 2: Equivalent Diameter of disk shaped reflector (flat bottom hole — FBH)

The following manipulations are applicable for the selection of the Equivalent Diameter of disk shaped
reflector:

e Mouse/ Touch Screen
m Click m  |Scroll diameters list to see the selected on

\

[o.-8 mm—per|

B Click on |selected equivalent diameter|

e Keyboard

B Press <Alt>+<D> on external keyboard = Equivalent Dia fore color changes to white — then use

_t/, 2» tj !/ on front panel keyboard or , , , on external keyboard

e Combined

Z;

B Click on Equivalent Dia = Equivalent Dia fore color changes to white — then use .tx . ﬂ

!/I on front panel keyboard or , , , on external keyboard
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Step 3: Attenuation in the reference block

DG5S Setup: MWB-70-4 /1.5 mm

BTN TR 7
weezos = 125dB ¥ a0
A 1 -
[5em =]l §dB Y ! Y Y

Modify M aterial Attenuation E " \

/ \

Apply | 42 dB/m 1 KZ Avgz=+208 Backwall Echo
)

Close 38 dB/m & dB [dB/m) 2 dB (dB/m) 1 dB [dB/m)

\
The following manipulations are \
applicable: \
\

e Mouse/ Touch Screen \

. N
B Click or press and hold on the appropriate |button|

e Keyboard

B Press <Alt>+<N> on external keyboard = Reference Attenuation fore color changes to white -

then use !J '_’J , :J , !J on front panel keyboard or , , , on external keyboard

e Combined

B Click on Reference Attenuation = Reference Attenuation fore color changes to white - then use

!J, 2] , :J , !J on front panel keyboard or , , , on external keyboard
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Step 4: Attenuation in the object under test

DG5S Setup: MWB-70-4 /1.5 mm
Probe

[Mwe704 =]} 12,5 dB
{1.5 mm =] \ & dB

Modity
v 42 dB/m

Close 38 dBim

o - | o - | o e

L=

Transfer Loss

3\
§.£ AVo = +2 dl’ Backgall Echo
Setup Step
& dB [dE/m)] f« 2 dB [dB/m] 1 dB [dB/m)

Apply

\
\
\

e Mouse/ Touch Screen \
B Click or press and hold on the appropriate

Keyboard

The following manipulations are
applicable:

B Press <Alt>+<M> on external keyboard = Material Attenuation fore color changes to white - then
use !J '_’J , :J , !J on front panel keyboard or , , , on external keyboard

Combined

B Click on Material Attenuation = Material Attenuation fore color changes to white - then use y

'_’J , :J , !J on front panel keyboard or , , , on external keyboard
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Step 5: Transfer loss

DG5S Setup: MWB-70-4 /1.5 mm

|MwB-70-4 |

|1.5 mm vI

Hodify M aterial Attenuation

12.5 dB

Transfer Loss

Apply

Cloze

42 dB/m

4 / ’
A
| \
I = (]
| 3
p \ B
f \
\
K2/ Avg; = +2 dB/ Bagkwall Echo

Reference Attenuatlun

[ 38dB/m

dB [dE/m] ¢ dB [dB/m)] T dB [dB /m]

The following manipulations are applicable:

e Mouse/ Touch Screen

\
\

\
A W
B Click or press and hold on the appropriate |button|

e Keyboard

B Press <Alt>+<T> on external keyboard = Transfer Loss fore color changes to white - then use

!J, 2] :J !J on front panel keyboard or , , , on external keyboard

e Combined

B Click on Transfer Loss = Transfer Loss fore color changes to white - then use !J 2] :J

!J on front panel keyboard or , , , on external keyboard

) )
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Step 6: Gain

Apply probe to the reference block to get the appropriate echo. There are two methods available:
B K1 or K2 reference block (reference block and reflector are defined in the probe data sheet and
reproduced automatically from the DGS data base upon probe selection)
\ B Inclined reference block (reference reflector — back surface)

\ \
\ \
0.5 Gain ‘ o
125 dB 1
1 Range ‘ o
100 mm 2
5 U5 Yelocity ‘ o
3260 mfs 3
100 Diszplay Delay ‘ o
6.23 ps 4
L] Beject o
i a
RACICS : . : : : bl ¢ T H Y L B o
| DG5S Setup: MWEB-70-4°/ 1.5 mm
\
[MwB-70-4 = 7\ \
= T— 9
E quivalent Di ¢
: Trahsfer Loss L \ \ 1
1.5 mm -
| [ 6 dB L X NG
Material hitenuation ‘
; A
42 d\B" m ¥ 2 avke-+2m Backwall Echo
ki st \ekitmiiin L Setup Step
Close ‘| 38 dE/m ¥~ idB [dE ] & 2dB (dB/m) _ ¢ 1dB([dB/m]
-
A A A A AR A .l................_ \ PP T .s..‘.é.d.’. ................................... .
Current Gain : \ : Click on Setup Step option or press <Alt>+<1> or .
: dB 1 \ i <Alt>+<2> or <Alt>+<6> on external keyboard to select
T s\ : required value for increment / decrement for increment /
\ : decrement for setting Gain. The last selected value of
\ : increment / decrement is checked: ®
\ : :
............................. | S

The goal of Gain setup is
: obtaining tip of maximized
: reference echo reaching back :
echo level (blue curve) E
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05 Gain
125 dB ‘

1 Range
Y «

5 U5 Velocity
3250 mjs ‘

100 Dizplay Delay
ﬁ s ls ‘

BACICG
| DG5S Setup: MWB-70-4 !1 5 mm

G
| |MwWB-70-4 T 12_5 dB

i Eauivalent Dia | Transfer Loss )
[1.5mm =] 6 dB A

;\

42 dB/m
! K2 AVygo =+2dB Backwall Echo

p———] Reference Attenuatiun Setup Step

Close 38 dB/m F\EdB (B /m] (v 2dB [dB/m) ¢ 1dE[dB/m)]

[ ]

The following manipulations are \
applicable for Gain setup: \

\
e Mouse/ Touch Screen \

B Click or press and hold on the appropriate

e Keyboard

t »

B Press <Alt>+<G> on external keyboard = Gain fore color changes to white - then use S, =

‘ , '.' / on front panel keyboard orI u u Ion external keyboard

e Combined

tT » @& 3

B Click on Gain = Gain fore color changes to white - then use o, =) J, = on front panel
keyboard or , H_H on external keyboard
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Step 7: Finalizing DGS curve and return to the main UDS 3-3/ UDS 3-4 window

Before finalizing the DGS curve:

Finalized back echo curve (blue) — depends on : i Finalized FBH echo curve (white) — depends on

: Probe and Reference Attenuation : = Probe, Equivalent Dia, and Material Attenuation

S esssssswEEEmEEEEEEEEEEE 7. .............................. *" "seEsEEsEEEEEEEEEEEEEEEEEEEEEEEEE ; .............................
. e

1 Range
.
5 U5 Yelocity
3250 m/s ‘

100 Diszplay Delay
623 s ‘
5

RACITES H

| DGES5 Setup: MWEB-70-4 /1.5 mm
— &
[MwB-70-4 = 125 dB ¥

Equvalont Dia  Transter Loss |

-

[

[1.5mm =] 6 dB i
A g
A
¥ ¢
42 dB/m 1 K2 AVgp=+2dB Backwall Echo o
I < oo Avenuation Y
Closze 38 dB/m L I @ 2B (dB/m) 148 4B/
- I
/ /
To finalize the DGS curve the following / /
manipulations are applicable: / /
/
Case 1 (K1 or K2 reference block) » Case 2 (Inclined reference block)//
/
e Mouse/ Touch Screen , / e Mouse/Touch Screen //
m click or]” m Click
e Keyboard e Keyboard
B Pressing <Alt>+<K> on external B Pressing <Alt>+<B> on external
keyboard keyboard
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The finalized DGS curve appears upon accompanied with Automatic Gain Correction:

Finalized back echo : FIdDGS """""" d‘ : Finalized FBH echo 3 aui',rﬁgtziig"y 3
i ! ! Finalize curve (re : i ;3 . .
: curve (blue)  § (red) : curve (white) : i corrected Gain I

5 US Velocity

3250 mfs
100 Dizplay Delay

623 s

+

I
ﬁ,EIL,..,,. " ' "im'l |I‘Hl* |f W 1"" ™,

435 dB

| [ 6dB
Modity N
42 dB/m
Apply .
Elu=s 38 dB/m & dB [dB./m) & 2dB [dB/m] 1dB [(dB/m

To accept finalized DGS curve and return to the main operating surface the following manipulations are
applicable:

e Mouse/ Touch Screen

m Click on Apply

then

B Click on Close
e Keyboard

§ ESC
B Press <Alt>+<A> on external keyboard, then ESC or <Alt>+<C> or JF_) on front panel keyboard
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To negate the finalized DGS curve and return to main UDS3-5 window the following manipulations are
applicable:

e Mouse/ Touch Screen
B Click on M odify

B Click on Cloze

_ May |
e |

e Keyboard

ESC

B Press <Alt>+<0O>on external keyboard, then or <Alt>+<C> or “X_J on front panel keyboard

To create new DGS curve the following manipulations are applicable:

e Mouse/ Touch Screen

B Click on Modify |

e Keyboard

B Press <Alt>+<0> on external keyboard
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Step 8: Work whilst DGS is active

A typical screenshot with active DGS is shown below

UDS3-5 - ISONIC Pulser/Receiver

+
III+

W MoAt o
W .
'.\".II Y 'ﬂlll LY LW T

GATE A
MEASURE

PULSER RECEIVER
ALARM DAC/TCG

O
Cloze EMI

BASICS
GATE B

-

Freeze

Menu
Selection

Probe and FBH Equivalent Diameter

corresponding to active DGS are indicated in the

caption of UDS3-5 window

DGS active [MWB-70-4 1.5 mm FEH]

05 Gain
435 dB

pr

1 Range
«

5 U5 Yelocity
3250 mjs ‘
100 Dizplay Delay
6.23 s ‘
I L] 1
Hy -

=

Print

=
Open

Save

»

e
DGS

Some parameters and modes may not be modified whilst DGS is active - corresponding messages appear if

attempting to modify:

v Attention!

tadification of thiz parameter is impozzible

while DG5S curve iz active

Changing aof thiz mode iz impozzible
while DGS curve iz active

1 Attention!

-
-
7 -
/ -
/ -
-
‘ E{S\C Enl'l’,'r

To continue operation click on the after message appears or press

keyboard or or on external keyboard

o
. ) DG5S
To negate the active DGS or create a new one click on
or <Alt>+<D> on external keyboard

or on front panel

%
or press ﬂj on front panel keyboard or
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5.2.12. Sub Menu MEASURE

Value

(]
Meaz Mode
-
0.2 Probe Delay h
b 84 ps
10 h

Angle

60 °

J
B uns 3-5

To select Measured Value

the following manipulations 1
are applicable: 1/
1/
e Mouse/ Touch Screen i
B Click or press and hold on the appropriate
e Keyboard
F

B Press _2 J on front panel keyboard or or <Alt>+<V> on external keyboard = Meas Value fore

color changes to white - then use ?_ ? ‘ , '.' on front panel keyboard or , , , on

external keyboard

e Combined

LY

B Click on Meas Value = Meas Value fore color changes to white - then use =/,

») & (&
on front panel keyboard or , , , on external keyboard

®

Refer to paragraph 5.2.13 of this Operating Manual for information about values available for automatic
measurement and indication in the Value Box (Digital Readout)
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Currently Active
Measurement Mode
........................... B . 3 dB

\ Meaz Yalue
\ OFF
i
0.2 Probe Delay
b 84 s
10 Angle
60 ° _

e | ey | | =y

jLann |
bl uny 2-5
To select Measurement Mode I /
the following manipulations are /
applicable: Iy
Iy
Mouse / Touch Screen 17
B Click or press and hold on the appropriate
Keyboard
-
B Press 3 Jon front panel keyboard or |[F3 or <Alt>+<E> on external keyboard = Meas Mode fore

color changes to white - then use ?_ ? ‘ , '.' on front panel keyboard or , , , on

external keyboard

Combined

» = =

B Click on Mgas Mode = Meas Mode fore color changes to white - then use !

on front panel keyboard or , , , on external keyboard

®

There are four Measurement Modes possible:

¢ Flank

¢ Top

¢ Flank-First
¢ Top-First

Refer to paragraph 5.2.13 of this Operating Manual for further information
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T il
il 4
il

-

To control Probe Delay the following I /
manipulations are applicable: ; /
/
e Mouse/ Touch Screen I/
4

B Click or press and hold on the appropriate
e Keyboard

-
B Press _4 J on front panel keyboard or or <Alt>+<R> on external keyboard = Probe Delay

fore color changes to white - then use !J '_’J _J !J on front panel keyboard or , , ,

on external keyboard

e Combined

B Click on Probe Delay = Probe Delay fore color changes to white - then use !J '_’J !J !J
on front panel keyboard or , , , on external keyboard

@ Refer to paragraph 5.2.13 of this Operating Manual for some hints on determining Probe Delay
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05 Gain
3 dB

Meas Yalue

OFF

= by

Ina By

o2
v b4 dh 4

= By

B uns 3;4

To control Incident Angle the following

manipulations are applicable: I /
e Mouse/ Touch Screen :,/

B Click or press and hold on the appropriate
e Keyboard

-
B Press' _5 J on front panel keyboard or or <Alt>+<N> on external keyboard = Angle fore color

changes to white - then use !J _J _J !J on front panel keyboard or , , , on

external keyboard

e Combined

B Click on Angle = Angle fore color changes to white - then use !J '_’J :J ij on front
panel keyboard or , , , on external keyboard

®

Refer to paragraph 5.2.13 of this Operating Manual for some hints on determining and / or checking Probe
Angle
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Advanced Measurements Settings Menu

£
. . b . .
Advanced measurement settings are available through button El_l appearing on the UDS 3-5 main
operating surface upon activating submenu MEASURE. Clicking on that button activates Advanced
Measurements Settings Menu:

[1] <=
[2] AUTOCAL
AS
4] X

- o
Press ' on front panel keyboard or on external keyboard or click on III |to
activate Advanced Scheme for Reflectors Depth Measurement Whilst Using Angle Beam Probe —

Thickness / Skip / Curved Scanning Surface Correction

F
Press 2 on front panel keyboard or on external keyboard or click on
activate Automatic Calibration Procedure

2] autocaL |

i
Press 2 J on front panel keyboard or on external keyboard or click on EI AS Ito
activate Dual Ultrasound Velocity Measurement Mode

> ESC
Press % Jor _)‘(\ on front panel keyboard or on external keyboard or click on

EI o |to return to main operating surface

®

Refer to paragraph 5.2.13.3 of this Operating Manual to get instructed on:
¢ Advanced Scheme for Reflectors Depth Measurement Whilst Using Angle Beam Probe —
Thickness / Skip / Curved Scanning Surface Correction
¢ Automatic Calibration Procedure
¢ Dual Ultrasound Velocity Measurement Mode
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5.2.13. Time Domain Signal Evaluation - Measurements Guide
5.2.13.1. Values available for Automatic Measurements and Digital Readout

Time of Flight - us of an echo matching
&-Scan with Gate A measured with respect to
Probe Delay:

T(A) = Absolute Delay A - Probe Delay

Value 2: T(B)

Time of Flight - us of an echo matching
with Gate B measured with respect to
Probe Delay:

T(B) = Absolute Delay B - Probe Delay
Value 3: S(A)

Material Travel Distance - mm or in of an
echo matching with Gate A:

s(A) =% - T(A) - US Velocity

n|r.'rtia| Pulse Value 1: T(A)

Display Delay Value_4: s(B) _ _
Material Travel Distance - mm or in of an
Abzolute Delay & - Flank echo matching with Gate B:
Abzolute Delay B - Flank s(B) =% - T(B) - US Velocity
Value 5: a(A)
Projection Distance - mm or in of reflector
Straight Beam Probe Angle Beam Probe returning an echo matching with Gate A,

measured with respect to Beam Incident
Point:

a(A) =s(A) -sin (Angle)

I_l Value 6: a(B)

a Projection Distance - mm or in of reflector
returning an echo matching with Gate B,
measured with respect to Beam Incident
Point:

Angle

€@ 0
nn
o W
o

a(B) =s(B) - sin (Angle)

Value 7: t(A)
Depth - mm or in of reflector returning an
echo matching with Gate A:

t(A) =s(A) - cos (Angle)

Value 8: t(B)
Depth - mm or in of reflector returning an echo matching with Gate B:

t(B) =s(B) - cos (Angle)

Value 9: AT - ps:

AT =T(B) - T(A)
Value 10: As - mm orin:

As =s(B) —s(A)
Value 11: Aa - mm orin:

Aa=a(B) —a(A)
Value 12: At - mm orin:

At =t(B) —t(A)
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C&bsolute Delay B- Top)  Value 13: H(A)
Clabsolute Delay & - Top) Azsean Amplitude - % of A-Scan height of an echo
matching with Gate A

Value 14: H(B)
Amplitude - % of A-Scan height of an echo
matching with Gate B
Value 15: V(A)
Amplitude - dB of an echo matching with
Gate A with respect to aThreshold:

V(A) =20 - logyp (H(A) / aThreshold )
Value 16: V(B)
Amplitude - dB of an echo matching with
Gate B with respect to bThreshold:

V(B) = 20 - log1o (H(B) / bThreshold )

a-Threshold b-Threshaold

Value 17: AV - dB:
AV =V(B) - V(A)
Value 18: AVC(A) (dB to DAC)-dB:
AVC(A) = 20 - logyo (H(A) / C (Absolute Delay A_Top) )
Value 19: AVC(B) (dB to DAC)-dB:
AVC(B) =20 - logip (H(B) / C (Absolute Delay B_Top) )

¢ To proceed corresponding Gate or both Gates to be active
¢ AVC(A) (dB to DAC) measurements require active DAC/DGS

+ Amplitude measurements of echoes may be performed provided their heights don't exceed 200% of A-
Scan height

+ For 2 and more echoes matching with a Gate - refer to paragraph 5.2.13.2 of this Operating Manual
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5.2.13.2. Flank, Top, Flank-First, and Top-First Modes of Measurement

The table below represents distinguishing points on an A-Scan, which will be taken for automatic

measurements depending on Meas Mode setting

Meas Mode setting

A-Scan

Meaz Mode

Flank

- T(A)1 T(B)7 S(A)1 S(B)1 t(A), t(B), a(A)v
a(B), AT, As, At, Aa
#® - V(A), V(B), H(A), H(B), AV, AVC(A),
AVC(B)

1

| I T
Ly Fl ] ~|" l.'J'l
|r| [*)

Meaz Mode
- T(A), T(B)! S(A), S(B)! t(A)! t(B), a(A)v
a(B), AT, As, At, Aa

® - V(A), V(B), H(A), H(B), AV, AVC(A),
AVC(B)

%

B |
bl 1
g I"# " b w A
¢ I'rJ‘L.‘|| ]J f | '-Irl.lt'rl I|u.||| il

Meaz Mode

Flank-First

- T(A)1 T(B)7 S(A)1 S(B)1 t(A), t(B), a(A)v
a(B), AT, As, At, Aa
#® - V(A), V(B), H(A), H(B), AV, AVC(A),
AVC(B)

lru"l-,ﬁ.‘J ]ll ¥

¥

|+ i
M, I" I'| -ﬁ'l 1| lfu.,l,.L

I
|I J|

Meaz Mode

Top-First

- T(A), T(B)! S(A), S(B)! t(A)! t(B), a(A)v
a(B), AT, As, At, Aa
# - V(A), V(B), H(A), H(B), AV, AVC(A),
AVC(B)

+ 1|| +I
[PRLNAY"

¥+
0 I-,,'L‘II | J f
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®

Distinguishing points of signals are automatically marked on A-Scan whilst measuring:

Gains
51.5 dB
Value: AT+

12.75 ps

'Il;—';';

+ + + |I,lll +1 L
|
T ‘l‘l’lﬁll"ﬂf‘a'i '.,I,l.llu‘llllu"n,hlIII F|,|II|' full |r|r1

Gains
51.5 dB
Value: AV

-3.5dB

J+k

K
ﬁ-‘: }|+ ||

+
|
L
I'I |||lll"| I|| |.|||II I'I'I'I
¥

1 Il I
+ + + ||,l|| + L th | I‘H |.||IHH"||+ ||,J|

|
Uy I'I.r._.'III.-'."'l,\.h'n'llu'u.r-.w,ll ‘l‘l’lﬁll"ﬂf‘a'i '.,I,l.llu‘llllu"n,hlIII F|,|II|' full |r|r1
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5.2.13.3. Advanced Scheme for Reflectors Depth Measurement Whilst Using Angle
Beam Probe — Thickness / Skip / Curved Scanning Surface Correction

[1] <=

Button

submenu MEASURE. The window as below appears after clicking on

-
_1_J on front panel keyboard or on external keyboard

Object under test may be designated as either

1] <=

or

£
| becomes available upon clicking on M if Angle setting differs from 0%in

pressing

* Flat - [click here

Or

>

e Curved -

While scanning above plates, tube wall, and the like the finite
thickness of object under test may be either

>

P

pr

o
1

»

¥ Ignore Thickness

e Ignored — |c|ick here_l
Or

e Entered —

Case 1 represents simplest scheme supposing that scanning
is performed above hemi-space whereas coordinates t(A),
t(B) are determined in accordance with appropriate sketches,
equations, and A-Scans shown in paragraphs 5.2.13.1 and
5.2.13.2 of this Operating Manual

Case 2 represents scanning above plate, or scanning above
tubular object longitudinally. Reflectors depth for half skip, full
skip, and multi skip insonification will be determined with
respect to actual Thickness value — t(A), t(B) readings will be
in accordance with sketches below:

wﬂh}’ uby Thickness
w—;}:t{h} Thickness

\ vﬂh}’ e f Thickness
Thickness

EVAN%i

> .

a
2

»

Apply

Cancel

Casel

* Flat Object

o~

pr

1 |p

" lgnore Thickness

@ 1 Thickness ‘ o .
25 mm =
Apply Cancel

Case 2
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Case 3 represents scanning above curved wall surface
circumferentionally. Reflectors depth for half skip, full skip,
and multi skip insonification will be determined with respect to
actual Thickness and Diameter values — t(A), t(B) readings
will be in accordance with sketch below:

Thickness

HA). tib)

0.5xDiameter

Thickness

t{ﬂ}: )

0.5xDiameter

Case 4 represents scanning above solid cylindrical object
cirmuferentionally or above spherical object. If this is a case
Thickness setting to be: Thickness = 0.5xDiameter and
reflectors depth will be determined with respect tio actual
Diameter value — t(A), t(B) readings will be in accordance
with sketch below:

t{ﬁ}.’:{h}

Diameter

™ Flat Object

10 Diameter

400 mm

pr

L
1

»

" Ignore Thickness

'S

pr

AL 4

Apply

Cancel

Case 3

™ Flat Object

2 Diameter

=
254 mm

pr

il 4

" Ignore Thickness

'S

pr

AL 4

Apply

Cancel

Case 4
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/

J

7
" Flat viect

10 Diameter

=
400 mm

" Ignore Thickness

Apply / Cancel
v A

To control Diameter the following
manipulations are applicable:

e Mouse / Touch Screen

B Click or press and hold on the appropriate

e Keyboard

-
B Press ! J on front panel keyboard or -1 on external keyboard = Diameter fore color changes to

white - then use !J '_’J :J !J on front panel keyboard or , , , on external

keyboard

e Combined

Click on Diameter = Diameter fore color changes to white - then use !J -' '_’J :J !J on front panel

keyboard or , , , on external keyboard
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To control Thickness the following
manipulations are applicable:

e Mouse / Touch Screen

" Flat O ect
b ?: 2 Diameter ‘
2b4 mm

" Ignore Thickness

B Click or press and hold on the appropriate

e Keyboard

'l
B Press LJ on front panel keyboard or on external keyboard = Thickness fore color changes

to white - then use !J '_’J gj !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Thickness = Thickness fore color changes to white - then use !J '_’J :J !J on
front panel keyboard or , , , on external keyboard

Apply
¢ Clickon

activate new settings

Cancel
¢ Clickon

negate new settings

| Enter
or press i,] on front panel keyboard or [Enter| on external keyboard to

| esc
or press \L] on front panel keyboard or on external keyboard to
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5.2.13.4. Dual Ultrasound Velocity Measurement Mode — Typical Example

For some practical applications it is necessary to measure sound path distances in dissimilar materials,
multi-layer structures, and the like. Also it may occur a need in measuring sound path distances for signals
representing various kinds of ultrasonic waves in the same object. Such cases are characterized by variety
of US Velocity values to be used while measuring intervals between signals on the same A-Scan. To
simplify measurement procedure and avoid operator's computations it may be activated Dual Ultrasound
Velocity Measurements Mode, which's use is illustrated by the example below

Supposing it's necessary to measure thickness of each layer of
bi-metallic part made through by means of explosion welding
between regular carbon steel ( US Velocity = 5920 m/s ) and
brass alloy ( US Velocity = 4720 m/s ) plates while probe to be
placed on low carbon steel plate. While placed on the steel side
10 MHz dual element probe with Probe Delay = 5.8 ps receives
two clear echoes 1 and 2 form the steel-to-brass boundary and
from the back surface of the brass layer correspondingly:

Steel
Braz=

UDS3-5 - ISONIC Pulser/Receiver

05 Gain
2 dB

= Ty

I By

5 U5 Velocity

H920 mfs
0.02 Display Delay

b8 s

o By

4 By

ln By

BASICS PULSER  RECEIVER  GATE A Menu "Ds’ ? - s
GATE B ALARM  DAC/TCG _ MEASURE _ Selection

] Value: OFF PPN g | = | -
Cloze Em | Freeze Save | Open DGE5S

US Velocity setting is suitable for steel and thickness of steel layer may be found through direct reading
upon placing Gate A above signal 1:

UDS53-5 - ISONMIC Pulser/Receiver

05 Gain

2 dB ‘
Meas Yalue

.
Meas Mode

.

0.5 Probe Delay
4'

BASICS PULSER RECEIVER GATE A Menu
GATE B ALARM IS InEE MEASURE Selection

]
Cloze EM| 3.08 mm Freeze
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If placing now Gate B above signal 2 and selecting As as Meas Value then interval between signals 1 and 2
will be measured. To obtain proper As readout value of US Velocity valid for brass alloy layer (second
material) must be keyed in

UDS3-5 - ISONIC Pulser/Receiver

0.5 G ain
72 dEﬁ ‘
;
Measz Mode
.
0.5 Fiobe Delay

|
"“I"‘ -| Ill +

BASICS PULSER RECEIVER GATE A Menu
GATE B ALARM DAC/TCG Selection

]
Close | IRy | 2 92 mm

This digital readout was obtained through use of steel

= US Velocity setting (first material) and may not be 3
_ recognized as a thickness of brass alloy layer (second _
matenal)

To obtain proper reading for the thickness of brass layer actlvate DuaI UItrasound VeIocny Measurements
£

M if:

Mode - Button AS becomes available upon clicking on

+ Both Gate A and Gate B are active (refer to paragraphs 5.2.5 and 5.2.6 of this Operating Manual)
¢ Meas Value setting is As (refer to paragraph 5.2.12 of this Operating Manual)

0.5 Gain ‘ o
12 dB 1
Meas Yalue
As ‘
Meas Mode ‘
- . LY
[2] AUTOCAL
. AS
BASICS PULSER RECEIVER GATE A Henu E E >
GATE B ALARM DAC/TCG MEASURE Selection
00 PN = [
Cloze M| 2.92 mm Freeze Save | Open DGES
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The screen as below appears after clicking on
keyboard or on external keyboard:

BASICS

GATE B ALARM

PULSER

+

| II.,|||\|

RECEIYER
DAC/TCG

HS

why

or pressing

|; gi

‘}\H

II||

GATE A
MEASURE

[ e Y—

Close | PR |

2_92 mm

Freeze

’+|HF|'--| I|I +

Menu
Selectio

.

L

05 Gain

_= Jon front panel

{2 dB ‘
Meas Yalue

e Ko
Meas Mod
e R

0.5 Probe Delay

L
5 U5 Velocity
5920 mfs

Click on this button or press 1
-~ keyboard or |[F1/or <Alt>+<1> on external keyboard

to select value of increment/decrement for second

US Velocity setting

-
-
-
0 o
02 1
292mm /
()% Tt
Click on appropriatelbuttonlorpress ' ‘ « '.'
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05 Gain
2 dB ‘
Meas Yalue

vl «

Asg
Meas Mode

Bl «

Flank

0.5 Probe Delay ‘
I'l,l 58 s
| .

+ N
|!";"1 "'Fli" 5 US Velocity
LI

4720 mfs

BASICS PULSER RECEIVER GATE A Menu
GATE B ALARM PEIwa Nty MEASURE Selectic

HE
Close MI 2.92 mm Freeze

-

[Digital readout for actual thickness of the brass alloy layer (second material)] is obtained upon completing
setting for second US Velocity

To return to the main ISONIC Pulser Receiver window click on 0k |or press = or '\ X Jon
front panel keyboard or <Alt>+<K> or [Enter|or on external keyboard

To printout A-Scan accompanied with setup list, measured value of As, and second US Velocity value click

on Erint | or press <Alt>+<P> on external keyboard (printer to be accessible through either USB or
LAN port and defined as default in the ISONIC 2007)
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5.2.13.5. Determining Probe Delay - Miniature Angle Beam Probes (contact face
width 12.5 mm /0.5 in or less) - Shear or Longitudinal Waves — Typical Example

Activate submenu PULSER then set:

O Pulser Mode to Single or Dual depending
on probe

O Pulse Width to Spike (240 pJ) for probe
having resonant frequency of 8 MHz and
higher or to PW ns, were PW =0.5/F (F
is the probe resonant frequency) for
probes having resonant frequency below 8
MHz

Q Firing Level to 18

Q Damping to 1000 Q

Q Tuning to NO

Activate submenu RECEIVER then set:

o Display to Full or RF
a Filter to BB
Q Frequency to completely cover probe's
effective bandwidth
Activate submenu BASICS topic then set:

Q US Velocity to 5920 m/s (233.1 in/ms) for
longitudinal wave probes or 3255 m/s
(128.1 in/ms) for shear wave probes

@ Rangeto50.0 mm (2in)

a Display Delay to 0 ps

QO Reject to 0%

Stage 1: Manipulate probe over main working
surface of V-2 reference standard and maximize
echo from 25 mm (1 in) radius concave reflector

Stage 2: Fix probe in found position - the center of
25 mm (1 in) radius concave reflector will indicate
incident point while the distance between probe's
frontal edge and incident point is equal to X-
Value

Stage 3: Tune Display Delay while probe is still
fixed in found position until rising edge of
maximized echo will match with 50%-grid of the A-
Scan width. Upon completing the obtained value
of Display Delay will be equal to actual Probe
Delay

+ It's necessary to setup Gain bringing height of maximized echo to 75-80% of A-Scan height

¢ Itis recommended to optimize Tuning in PULSER submenu upon obtaining maximized echo. The goal of
such optimization is increasing of ultrasonic excitation energy through better matching between firing
output and probe. Level of ultrasonic excitation energy is clearly represented by echo amplitude. Upon
completing Tuning optimization Gain to be adjusted to bring echo to 75-80% of A-Scan height
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5.2.13.6. Determining Probe Delay - Large and Medium Size Angle Beam Probes
(contact face width more than 12.5 mm /0.5 in) - Shear or Longitudinal Waves —

Typical Example

+ +
maving probe

v

f
!

!

+

* o

Activate submenu PULSER then set:

Q Pulser Mode to Single or Dual depending
on probe

O Pulse Width to Spike (240 pJ) for probe
having resonant frequency of 8 MHz and
higher or to PW ns, were PW =0.5/F (F
is the probe resonant frequency) for
probes having resonant frequency below 8
MHz

Q Firing Level to 18

a Damping to 1000 Q

Q Tuning to NO

Activate submenu RECEIVER then set:

a Display to Full or RF

o Filterto BB

Q Frequency to completely cover probe's
effective bandwidth

Activate submenu BASICS topic then set:

a US Velocity to 5920 m/s (233.1 in/ms) for
longitudinal wave probes or 3255 m/s
(128.1 in/ms) for shear wave probes

O Range to 200.0 mm (8in)

O Display Delay to O ps

O Reject to 0%

Stage 1. Manipulate probe over main working
surface of V-1 reference standard and maximize
echo from 100 mm (4 in) radius concave reflector

Stage 2: Fix probe in found position - the center of
100 mm (4 in) radius concave reflector will indicate
incident point while the distance between probe's
frontal edge and incident point is equal to X-
Value

Stage 3: Tune Display Delay while probe is still
fixed in found position until rising edge of
maximized echo will match with 50%-grid of the A-
Scan width. Upon completing the obtained value
of Display Delay will be equal to actual Probe
Delay

It's necessary to setup Gain bringing height of maximized echo to 75-80% of A-Scan height

It is recommended to optimize Tuning in PULSER submenu upon obtaining maximized echo. The goal of

such optimization is increasing of ultrasonic excitation energy through better matching between firing
output and probe. Level of ultrasonic excitation energy is clearly represented by echo amplitude. Upon
completing Tuning optimization Gain to be adjusted to bring echo to 75-80% of A-Scan height
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5.2.13.7. Determining Probe Delay - Straight Beam (Normal) Single Element and Dual
(TR) Probes — Typical Example
Activate submenu PULSER then set:

Q Pulser Mode to Single or
Dual depending on probe

O Pulse Width to Spike (240
pJ) for probe having resonant
frequency of 8 MHz and
higher or to PW ns, were PW
=0.5/F (F is the probe
resonant frequency) for
probes having resonant
frequency below 8 MHz

Q Firing Level to 18

o Damping to 1000 Q

O Tuning to NO

Activate submenu RECEIVER then
set:

1 US Velocity
b920 m/s

* 153&;38;:?: O Display to Full or RF
. Q Filter to BB
+ Q Frequency to completely
+ cover probe's effective
bandwidth
Activate submenu BASICS topic then

set:

O US Velocity to 5920 m/s
(233.1 in/ms) for longitudinal
= wave probes or 3255 m/s
(128.1 in/ms) for shear wave
probes
O Rangeto25.0mm (1in)
o Display Delay to 0 ps
O Rejectto 0%

Stage 1. Apply probe to a side surface of V-2 reference standard to receive back echo

Stage 2: Tune Display Delay until rising edge of the back echo will match with the 50%-grid of the A-Scan
width: in such case the obtained value of the Display Delay is equal to the actual Probe Delay

®

¢ It's necessary to setup Gain bringing height of back echo to 75-80% of A-Scan height

¢ Itis recommended to optimize Tuning in PULSER submenu upon obtaining back echo. The goal of such
optimization is increasing of ultrasonic excitation energy through better matching between firing output
and probe. Level of ultrasonic excitation energy is clearly represented by back echo amplitude. Upon
completing Tuning optimization Gain to be adjusted to bring echo to 75-80% of A-Scan height
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5.2.13.8. Automatic Calibration (AUTOCAL) of Probe Delay and US Velocity - Angle
Beam Probes - Shear or Longitudinal Waves — Typical Example

There are 2 maximized reference
echoes from 2 concave reflectors
with different radius 25 mm (1 in)
and 50 mm (2 in) in use for
performing automatic calibration
of Probe Delay and US Velocity.
A-Scan settings (Range, Display
Delay, US Velocity — refer to
paragraph 5.2.2 of this Operating
Manual) must allow observing of
both signals. Gate A to match
with first reference echo received
from concave reflector with
smaller radius (shorter material
travel distance) — refer to
paragraph 5.2.5 of this Operating
Manual. Gate B to match with
second reference echo received
from concave reflector with larger
radius (longer material travel
distance) — refer to paragraph
5.2.6 of this Operating Manual

®

¢ It's necessary to setup
Gain bringing height of
back echo to 75-80% of A-
Scan height

¢ Itis recommended to
optimize Tuning in
PULSER submenu upon
obtaining back echo. The
goal of such optimization is
increasing of ultrasonic
excitation energy through
better matching between
firing output and probe.
Level of ultrasonic
excitation energy is clearly
represented by back echo
amplitude. Upon
completing Tuning
optimization Gain to be
adjusted to bring echo to
75-80% of A-Scan height
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=

i

Obtain first reference echo, activate submenu MEASURE then click on

05 Gain
16 dB

= Ty

Meas Yalue
OFF
- . Ly

E AUTOCAL %

pr
p™
P

BASICS PULSER RECEIVER GATE A Menu H» IE' b
GATE B ALARM PEIwa Nty MEASURE Selection

Yalue: OFF 3 e
T & B3 I
Close Em Freeze Save | Open DGS
Fa
To activate AUTOCAL procedure click on SAUTDIEL | or press 2_ on front panel keyboard or

on external keyboard — the |AUTOCAL Control Surfacel appears

Gain

2 MTD-s[A)
sem K
B

T(A)
21.1 ps

S

GATE B ALARM priwgn gy MEASURE Selection

BASICS ~ PULSER  RECEIVER _ GATE A Eanmﬂk] ‘

0 O =
Cloze EM| Freeze ﬁ ﬂ Save ﬂpe}\ I

Click on this button or press press X" J on front

panel keyboard or or <Alt>+<C> on external
keyboard to interrupt AUTOCAL Procedure and
return to main UDS 3-5 control surface

If necessary Gain may be re-adjusted in the AUTOCAL Control Surface by the same way as it is explained
in paragraph 5.2.2 of this Operating Manual
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: Click on this button or press
Fa
2 on front panel

: keyboard or F2 or

: <Alt>+<2> on external
: keyboard to select value of
~ increment/decrement for
"

: Current value of :
: increment/decrement for =
: keying in Material Travel ;

Distance MTD-s(A),
: mm or in

1 Material Travel Distance

: MTD-s(A) in mm or in for the
i first reference echo to be

entered here while the said ST TPV

i echo matches with Gate A 3 2 MTD-s(A) RIS TR Y
S ssssEs s TN EEEEEEEEEEEEEEEEENEEEEEEEEEM 25 mm ‘
T L[ 0] R
: Digital readout box indicating  * 21.1 ps I
: automatically determined delay : 2 MTD-s(B) y
i of the first reference echo ¥ 74 3 i
: relatively firing pulse excitation : -0 mm I
: hs LS &
--------------------------------------- = ﬂ I.I.S | !
4
Eﬂﬂ[:El ’ I ‘ :....................' .................. .:
Ly S & Click on this buttonto  :
To key in Material Travel Distance MTD-s(A) I/ confirm er_‘tered Material :
the following manipulations are applicable: I : Travel Distance MTD-
e Mouse / Touch Screen [ : S(A)
B Click or press and hold on the appropriate

e Keyboard
Fa )
B Press _2_J on front panel keyboard or B or <Alt>+<A> on external keyboard = MTD-s(A) fore

color changes to white - then use L) , .4 , - , '.' on front panel keyboard or , H & on
external keyboard
e Combined
B Click on MTD-s(A) = MTD-s(A) fore color changes to white - then use L) , » , - , '.' on
front panel keyboard or ﬂ E g @ on external keyboard

Upon confirming keying in Material Travel Distance MTD-s(A) obtain second reference echo

05 Gain

Yl «

»

= &y

16 dB
Z MTD-sA)
T(A)
21.1 ps
0.1 MTD-s(B)
Rl «

L= By

BASICS PULSER RECEIVER GATE A !
GATE B ALARM PEIwa Nty MEASURE Selection

] &
Close Em | Freeze
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2 MTD-zlA)

2b mm

Click on this button to
N~ confirm entered Material
Travel Distance MTD-
s(B) :
To key in Material Travel Distance MTD-s(B) 1/ ]
the following manipulations are applicable: I

Click on this button if it is

necessary to return backto  :_.
keying in Material Travel

Distance MTD-s(A)

e Mouse /Touch Screen
B Click or press and hold on the appropriate
e Keyboard

-
B Press _4 j on front panel keyboard or or <Alt>+<B> on external keyboard = MTD-s(B) fore

color changes to white - then use !J '_’J :J !J on front panel keyboard or (T, , , on

external keyboard
e Combined

B Click on MTD-s(B) = MTD-s(B) fore color changes to white - then use !J '_’J :J !J on
front panel keyboard or , , , on external keyboard
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Material Travel Distance MTD-s(B) The screen as below appears upon confirming keying in

GATE A
MEASURE

PULSER RECEIVER
ALARM DAC/TCG

oo
Close | TN |

BASICS
GATE B

Freeze

05 Gain

16 dB

Selection Autocal

p.

L
I DG5S

¢ Clickon J if it is necessary to return back to keying in Material Travel Distance MTD-s(A)

Autocal
¢ Clickon

[
Enter

or press

on front panel keyboard or Enter or <Alt>+<U> on external keyboard

to initialize automatic determining of US Velocity and Probe Delay based on above described keying

and echoes delays automatic measurements. As a result the screen as below appears:

Probe Delay

= Ty

05 Gain
16 dB ‘

Meas Yalue

OFF

| 5.82 IS
US Yelocity

Meas Mode

Flank
Probe Delap

.m

3272 mjs

Cancel

[ By

913 ps
10 Angle

ﬂﬁ

»
»
»
»
»

In by

Apply

GATE A
MEASURE

FECEIVER
DAC/TCG

Yalue: OFF

PULSER
ALARM

BASICS
GATE B

Freeze

Meru
Seledtion

p.

5 Uns 2-5

= ‘ 0| =

Save DGS

=
Open

\ 4

ESC
or press 'F_) on front panel keyboard or

Esc| or <Alt>+<C> on external keyboard to negate
AUTOCAL results and return to main operating
surface without modifying Probe Delay and US
Velocity settings

[
Enter

Click on| or press on front panel keyboard or

Enter| or <Alt>+<A> on external keyboard to
accept AUTOCAL results and return to main
operating surface with appropriate modifying Probe
Delay and US Velocity settings
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5.2.13.9. Automatic Calibration of Probe Delay and US Velocity - Straight Beam
(Normal) Single Element and Dual (TR) Probes — Typical Example

0.5

Gain

33 dB
LT Range
20 US Yelocity
4335 mfs

5

10 Display Delay

There are 2
sequentially
received back
echoes required for
performing
automatic
calibration of
Probe Delay and
US Velocity. A-
Scan settings
(Range, Display
Delay, US Velocity
— refer to
paragraph 5.2.2 of
this Operating
Manual) must allow
observing of both
signals.

Gate A to match with first back echo (shorter material travel distance) — refer to paragraph 5.2.5 of this
Operating Manual. Gate B to match with second back echo(longer material travel distance) — refer to
paragraph 5.2.6 of this Operating Manual

®

¢
*

It's necessary to setup Gain bringing height of back echo to 75-80% of A-Scan height

It is recommended to optimize Tuning in PULSER submenu upon obtaining back echo. The goal of such
optimization is increasing of ultrasonic excitation energy through better matching between firing output
and probe. Level of ultrasonic excitation energy is clearly represented by back echo amplitude. Upon
completing Tuning optimization Gain to be adjusted to bring echo to 75-80% of A-Scan height

All further operations to be performed identically to described in paragraph 5.2.13.8 of this Operating Manual

BASICS

GATE B ALARM

PULSER

05 Gain
33 dB ‘

Measz Yalue

Probe Delay

913 pus

US Yelocity

H(a)

Meaz Mode

.m

5952 mfs

Cancel

Apply

10

RECEIYER
DAC/TCG

[ T

Close | IFYERSY |

1796 %

GATE A
MEASURE

Freeze

Menu
Selection

Flank
Probe Delay

0 ps
Angle
ﬂ o
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5.2.13.10. Determining Incidence Angle (Probe Angle)

Caze Iltll

Case 3

L=

CF

Cazeh

-

o

Determining of incidence angle is
based on maximizing echo from
side-drilled hole in reference block
and reading the value of angle from
corresponding scale. Depending on
probe dimensions and angles there
are various reference blocks and
scales applicable:

Case 1. Miniature angle beam

probe, incidence angle 35° to 65°,
V-2 reference block

Case 2: Miniature angle beam

probe, incidence angle 65° to 75°,
V-2 reference block

Case 3: Medium or large size angle
beam probe, incidence angle 40° to
66°, V-1 reference block

Case 4: Medium or large size angle
beam probe, incidence angle 60° to
76°, V-1 reference block

Case 5: Medium or large size angle
beam probe, incidence angle 74° to
80°, V-1 reference block
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5.2.14. Frequency Domain Signal Presentation and Evaluation

Using Range and Delay parameters select a portion of A-Scan for frequency domain (FFT) presentation
then do activate submenu RECEIVER and switch Display to FFT (refer to paragraph 5.2.4 of this Operating
Manual). The screen as below appears:

FFT Measurements

Controls N ..,
\\\\ : : : : A
N ~N O 0 MHz
N\ * - * * UpperFreq
S N 5 MHz
N + + + +
+ + + + ﬁeiect
- 0% \‘
\
2l Uns'3-5
rdRd AT R P
Freeze Save | Open| Funt a DGS
A A AR B B e S | VR
: FFT Measurements : : Displayed Frequency
: Indicator 1 ] Range Controls

@ Display may not be switched into the FFT if the Range value is too long or DAC/TCG/DGS is active
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Lower frequency bound (LowerFreq)

To control LowerFreq the following
manipulations are applicable:

I
Mouse / Touch Screen ’//
B Click or press and hold on appropriate

Keyboard

-
B Press 2 J on front panel keyboard or or <Alt>+<W> on external keyboard = LowerFreq fore

color changes to white - then use !J ZJ _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on LowerFreq = LowerFreq fore color changes to white - then use !J ZJ :J !J
on front panel keyboard or , , , on external keyboard
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Upper frequency bound (UpperFreq)

To control UpperFreq the following
manipulations are applicable:

0.1 LowerFreq

0.1 UpperFreq

I

1
I

Mouse / Touch Screen /1,

B Click or press and hold on the appropriate Ibuttonl

Keyboard

Fd
B Press 3 jon front panel keyboard or or <Alt>+<U> on external keyboard = UpperFreq fore

color changes to white - then use !J ZJ _J !J on front panel keyboard or , , , on

external keyboard

Combined

B Click on UpperFreq = UpperFreq fore color changes to white - then use !J 2J :J !J on
front panel keyboard or , , , on external keyboard
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Find maximum

Click on J — mouse pointer may be guided then just over FFT graph. FFT Readout Box displays
frequency corresponding to pointer position whilst guiding the cursor. Select first point of interest by mouse

click or through release of touch screen stylus. The appropriate mark 0 appears. Select the second point
of interest by the same way

Selection of Second
point FFT Mark and
corresponding
frequency value

Maximum’s frequency mark @appears and FFT Readout Box displays the found value automatically
upon mouse click or releasing of touch screen stylus:

Maximum’s
frequency mark and
digital readout

n
oo a o n s sy
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Find the —3db / —20db level bounds:

Maximum’s

frequency mark

- 3 dB bounds —
marks and digital
readout

Return to FFT Measurements toolbar:

=
Click on

Find frequency corresponding to selected single point on FFT graph:

Click on J — mouse pointer may be guided then just over FFT graph. FFT Readout Box displays
frequency corresponding to pointer position whilst guiding the cursor. Select first point of interest by mouse

click or through release of touch screen stylus. The appropriate mark n appears and FFT Readout Box
displays corresponding frequency:

Selected point
and
corresponding
freauency

+ + + 0+ + +, + + +

[+~ T
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Frequency difference (deviation) between two points:

Click on _I — mouse pointer may be guided then just over FFT graph. FFT Readout Box displays
frequency corresponding to pointer position whilst guiding the cursor. Select first point of interest by mouse

click or through release of touch screen stylus. The appropriate mark n appears. Select second point of

interest by the same way - the appropriate mark e appears and the FFT Readout Box displays difference
(deviation) between corresponding frequencies:

1 Selected points and
:  difference (deviation)
! between corresponding
: frequencies

f2 -1 = 0.85 MHz

Clear FFT Marks:

]
Click on

Exit FEFT Mode:

Change Display mode
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5.2.15. Freeze A-Scan / FFT Graph
UD53-5 - ISONIC Pulzer/Receiver

Ty

1 Gain
37dB ‘

Measz Yalue
«
Meaz Mode

.
0.01 Probe Delay
h 13 pus ‘
10 Angle
60 ° ‘

BASICS PULSER  RECEIVER _ GATE A Menu ﬁ| "D" ?_s
GATE B ALARM  DAC/TCG IETTEIGEN Selection

4= By

len By

R @l B|=]|8 =
Cloze EM| 41 .3 mm ErzPe Save | Open | Print DG5S

To freeze / freeze peak / unfreeze the A-Scan click or press i) on front panel keyboard or or
<Alt>+<F> on external keyboard

®

¢ Freeze Peak mode allows representing of Hilbert envelop for sequence of echoes obtained while
manipulating probe over some reflector. This function may be useful for localization of echo maximum
when working in A-Scan mode:

¢ Freeze Peak mode may not be activated for RF and FFT signal presentation
¢ Appearing of at the upper left corner of A-Scan indicates that it is frozen (Freeze)

Appearing of at the upper left corner of A-Scan indicates that Freeze Peak mode is active

The following operations are available when time domain A-Scan is frozen:

0 =6 dB Gain varying according to paragraph 5.2.2 of this Operating Manual

0 Manipulating Gates A and B according to paragraphs 5.2.5, 5.2.6, 5.2.7 of this Operating Manual

o0 Varying Alarm mode according to paragraph 5.2.8 of this Operating Manual

0 Selecting parameter (Meas Value) for automatic measurements and varying settings Probe
Delay and Angle as per paragraph 5.2.12 of this Operating Manual and obtaining corresponding
measurements results in the digital readout box (Value)

¢ The following operations are available while frequency domain FFT Graph is frozen:
0 =6 dB Gain varying according to paragraph 5.2.2 of this Operating Manual
o0 All FFT evaluation / measurements as per paragraph 5.2.14 of this Operating Manual

+ Caption of appropriate button changes in the UDS 3-5 Pulser/Receiver window when freeze / freeze
peak / unfreeze A-Scan / FFT Graph

Freeze FrzPeak
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5.2.16. Zoom A-Scan / FFT Graph

Double click on A-Scan / FFT Graph to get it enlarged. Enlarged A-Scan / FFT Graph occupies screen
completely

In upright corner of A-Scan there is a digital readout box indicating current Gain value and digital readout of
automatic measurements provided that corresponding Gate is active

$

To control Gain while A-Scan is enlarged use ' and '~/ on front panel keyboard or , on external
keyboard

To freeze / freeze peak / unfreeze enlarged A-Scan press &J on front panel keyboard or on external
keyboard
If Gate A and / or Gate B is active then:

Parameters V(A), s(A), t(A), a(A) , V(B), s(B), t(B), and Parameters V(A), s(A), V(B), and s(B) are measured and
a(B) are measured and indicated automatically — refer to indicated automatically — refer to paragraph 5.2.13.1 of this
paragraph 5.2.13.1 of this Operating Manual Operating Manual

Parameters V(A), s(A), t(A), and a(A) are measured and Parameters V(A), and s(A) are measured and indicated
indicated automatically — refer to paragraph 5.2.13.1 of automatically — refer to paragraph 5.2.13.1 of this Operating
this Operating Manual Manual

Parameters V(B), s(B), t(B), and a(B) are measured and Parameters V(B), and s(B) are measured and indicated
indicated automatically — refer to paragraph 5.2.13.1 of automatically — refer to paragraph 5.2.13.1 of this Operating
this Operating Manual Manual

To select an additional parameter for automatic measurement and large character indication while A-Scan is

enlarged (Meas Value - refer taragraphs 5.2.12 and 5.2.13 of this Operating Manual) use ‘ and ‘

on front panel keyboard or , on external keyboard. Gate A and Gate B if active may be drag and drop
manipulated on the enlarged A-Scan according to paragraph 5.2.7 of this Operating Manual. To return to
main operating surface window double click on enlarged A-Scan / FFT Graph
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5.2.17. Save an A-Scan and its Calibration Dump into afile

=

=
To save the A-Scan / FFT Graph and Calibration Dump into a file click on ﬂ' or press 32 J on front

panel keyboard or or <Alt>+<S> on external keyboard — ISONIC 2005 Save/Open window becomes
active providing automatically created name for a new file in
File name: box:

ISONIC 2005 Save/Open EHE
Save in; I {23 UDS 35 Pulser Receiver j gl
0.par fit1.par P 000005, par P00
00 par hgb. par PUIOODDOE. par PUIOOOO 2 -
000, par PLOO0ODT. par PL000007. par P00 2 »
0000.par PU00000Z. par P00000S. par P00 -
chime defect.par PL000003. par PL00000S. par PLO0OOTE -
chime ok. par PL00000. par PL0000T 0. par PLOOOOTE 2
| | | |

4= By

ln By

M‘. el ‘ﬁ'l Lt it P

~fr e # 4|56 ||7}8|9I]|0 -H=H0"
BASICS
GATE B

=
=
M
-
-
-
=
=
=
-
|

VY7 Y7
o3 by
Mylvvee

| AINSHDHFHNGHHYJ KL ; ' %
Close

Shit [|Z || X[ CHY || BlN|MI.| .|l

| —
IL
=
=3}
(Iy]

Del BS

To save a file:
e select disk drive and directory for placing a file using mouse or touch screen

e approve automatically created new file name
OR
mark a file to be replaced from the list appearing in the destination directory
OR
type a new file name using either virtual keyboard generated in ISONIC 2005 Save/Open window or
external keyboard — standard Windows rules for file naming are applicable, long names (up to 64
characters) are supported

"
= Enter |

double click on file to be replaced or click on il or press ‘=== J or <+ on front panel
keyboard or press H or m or <Alt>+<S> on external keyboard
ISONIC 2005 Save/Open window disappears automatically upon completing saving a file

ESC
To exit from ISONIC 2005 Save/Open window without saving a file click on ﬂl or press &) on
front panel keyboard or on external keyboard
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5.2.18. Load an A-Scan and its Calibration Dump from afile

= | =
To load A-Scan/FFT Graph and Calibration Dump from a file click on "8P&R| or press ' &) on front panel
keyboard or or <Alt>+<0O> on external keyboard — <Alt>+<0O> on the keyboard — ISONIC 2005

Save/Open window becomes active

UDS3-5 - ISONIC P

ISOMIC 2005 5ave/Open EHE ‘ r »
= : . 1
Lok jn: Ia UDS 3-6 Pulser Receiver j ﬁl
-
O.par fit1.par PL00000S. par PLO000TT ‘ 2 »
00, par hgb. par PL00000E. par PLO000T 2 =
000, par PLO0O00T . par PL00000T. par PLO000T 2 ‘ 3 »
0000.par PL0000O0Z par PL00000S. par PLO000T4 -
chime defect.par PL000003. par PL00000S. par PLODOOTE ‘ - »
chime ok par PL000004. par P00 0. par PLODOOTE 4
-
L | o s |
BASICS Lois | EEEE N ? - 5
L Files of type:  |LIDS 35 Settings [+ par)
|~

- Cancel
~] _ Cancel | ) |

I_
Cloze Em I

1274 HS Un[leezel I | L | Save || Qpenl Print DG5S
To open a file:
e select disk drive and directory containing a file required
\ E-‘; Ente.r
e select then file then double click on its name or click on % or press &) or *=_ on front

panel keyboard or or or <Alt>+<0O> on external keyboard

ISONIC 2005 Save/Open window disappears automatically upon completing loading a file

ESC
To exit from ISONIC Save/Open window without opening a file click on ___=aMee! |or press Lj on front
panel keyboard or on external keyboard
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5.2.19. Print A-Scan/FFT Graph and Settings List

Ensure the printer connection is in order (printer to be accessible through either USB or LAN port and

ﬁ I é
defined as default in the ISONIC 2005) then click on Erint or press m) on front panel keyboard or m
or <Alt>+<P> on external keyboard

5.2.20. Activate Main Recording Menu for Single Channel Operation
using CH 1

I
Click on _| or press LJ on front panel keyboard or on external keyboard. Refer to Chapter 6 of

this Operating Manual for further instructions

5.2.21. Switch OFF UDS 3-5

ESC
To switch OFF UDS 3-5 click on _Llose |or press L) on front panel keyboard or or <Alt>+<C>

on external keyboard
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6. Recording and Imaging — Single
Channel (CH 1)
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6.1. Main Recording Menu — Single Channel (CH 1)

Main Recording Menu — Single Channel (CH 1) is shown below:

IfTime Based Recording

[2|True to Location Recording

@Back

There are 2 recording submenus available:

¢

*

Time Based Recording submenu relates to line scanning procedures where probe is

manipulated over object under test with constant speed and defects images are formed from

sequence of A-Scans captured at equal time intervals (real time clock). To open Time Based
| s

. . | [1]Time Based Recordi |
Recording submenu click on |- "B o nress 1 on front panel keyboard or

on external keyboard

True to Location Recording submenu relates to line scanning procedures where coordinate of
probe manipulated over object under test is transferred to ISONIC 2007 instrument by means of
position encoder while defects images are formed from sequence of A-Scans captured at equal

. . . . . | [2]True to Location Record
distance intervals. To open True to Location Recording submenu click on | 2™ '@ tection Recerdina
.

or press _2_ on front panel keyboard or on external keyboard

. . . | | 3 |Back J Ef\(‘. , "3' |
To return to main operating surface click on | or press or =2 Jon front panel

keyboard or or on external keyboard
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6.2. Time Based and True to Location Recording Submenus

Both Time Based Recording and True to Location Recording submenus allow activating 4 protocols of
data recording:

[1]t-BScan (Th) [1]BScan (Th)

[2]t-ABiscan [2]ABIScan
[8]t-ToFD [8]ToFD
IZ]t—Floarmap 1= z‘ Floormap L
J B &
|?] Back |?] Back

+ Thickness Profile imaging and recording —t-BScan(Th) or BScan(Th) — click on ‘MJ or

- )
1 |BScan (Th) | . . .
[TBscan or press _ ' _Jon front panel keyboard or on external keyboard — illustrative video

is available at http://www.sonotronndt.com/video.asp?VideolD=1

¢ B-Scan cross-sectional imaging and recording of defects for longitudinal and shear wave

;o

t-ABIScan 2 |ABIScan |
2] ‘orl 2] ‘orpress 2 Jon

inspection — t-ABIScan or ABIScan — click onl
front panel keyboard or on external keyboard — illustrative video is available at
http://www.sonotronndt.com/video.asp?VideolD=2

¢ TOFD Inspection — RF B-Scan and D-Scan Imaging — t-TOFD or TOFD - click on ‘&J or

-
3 TOFD |
2 or press 2 on front panel keyboard or on external keyboard — illustrative video

is available at http://www.sonotronndt.com/video.asp?VideolD=4

¢ CB-Scan horizontal plane-view imaging and recording of defects for shear, surface, and guided

l E‘t-Floormap L ‘ l EFloormap L
or

wave inspection — t-FLOORMAP L or FLOORMAP L click on
-

_4_J on front panel keyboard or [F4]| on external keyboard — illustrative video is available at
http://www.sonotronndt.com/video.asp?VideolD=3

ESC
To return to Main Recording Menu — Single Channel (CH 1) click on ‘lJor press L) or

r
_5_ on front panel keyboard or or |Foj on external keyboard

press
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6.3. Thickness Profile Imaging and Recording — t-BScan(Th)

and BScan(Th)

6.3.1. Setup Pulser Receiver for Thickness Profile Imaging and

Recording

UDS 3-5 Pulser Receiver window — main operating surface — appears on ISONIC 2007 screen upon

Lo l [1]t-BScan (Th) l [1]Bscan (Th) . . .
clicking on r . The following settings to be provided:
# | Parameter or Submenu Required Settings Note
Mode
1 aSwitch GATE A ON
2 Gain BASICS Gain and aThreshold settings to
aThreshold GATE A provide receiving an echo from the
minimal area of thickness degradation to
be detected; height of the said echo to
exceed aThreshold; signals from other
reflectors less then defined one not to
exceed aThreshold
3 DAC/TCG DAC/TCG DAC/TCG settings to meet requirements
of the Inspection Procedure
4 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
5 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing Level, To synchronize with Gain
Firing Level, and Damping settings to provide and aThreshold setting
Damping optimal signal to noise ratio procedure
6 Filter, Frequency RECEIVER Filter and Frequency settings to match | To synchronize with Gain
with probe's frequency and aThreshold setting
procedure
7 Display RECEIVER Display mode may be either Full, RF, The same Display mode to
PosHalf, or NegHalf be used for both Probe
Delay determining and
Thickness Profile Imaging
8 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
9 Probe Delay MEASURE Probe Delay setting to be equal to Probe delay may be
actual probe delay determined according to
paragraph 5.2.13.7 or
5.2.13.9 of this Operating
Manual or similarly
10 | Angle MEASURE Angle = 0°
11 | Meas Mode MEASURE Flank
12 | Range, Display BASIC Range, Display Delay, AStart, and
Delay, AStart, GATE A aWidth settings to be performed with

awidth

reference to the Region of Interest for
t-BScan(Th) and BScan(Th) table
below

13 | Settings for other
parameters and
modes have no
significance

I
Upon completing click on J or press LJ on front panel keyboard or on external keyboard
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Region of Interest for t-BScan(Th) and BScan(Th)

. Scanning Surface

Surface to ROI Distance = SRD

ROl = Region of Interest

ROl Width = R
E;Ek Wall Profile
Initial
Pulze
SRD = aStart
Case 1
—_— RW = aWidth
0
Display Range
" Delay
Initial DisplavDel
ISplaybela .
Pulse SRD = %xUSVelocny
Case 2
-1 RW = aStart + awidth — SRD
0
Dizplay Range
" Delay
Initial
Pulse SRD = aSta.rt
DisplayDelay .
Case 3 L RW = — 5, xUSVelocity +
0 —
| Display Range + Range — aStart
" Delay
Initial
Pulze
DisplayDela .
SRD = 2iplayoelay USVelocity
Case 4 2
0 RW = Range
Display Range
" Delay
Preferred Initial ¢ aStart and aWidth setting to provide
embodimen Pulse 1t back echo appearance of whole Gate A on the A-Scan
t ¢ aWidth =(0.75...0.95) x Range
¢ First Back Echo at the thickest area of object
under test to be fully matching with Gate A
0 — ¢ First Back Echo at the thickest area of object
Display Range under test to "occupy” 5-10% of the Gate A
" Delay width on the A-Scan
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6.3.2. Thickness Profile Imaging — Implementation

6.3.2.1. t-BScan(Th) — Prior to Scanning

t-BScan(Th) control panel is shown below

= By

1 L. mm
-
Time, sec

T K
Time-0Out, sec
3
4 =]

Current A-Scan

p

Start Save

2y,

UDS3-5 Text Close

% Empty t-BScan(Th) record field
Gate

d End a0 10

33 mm

Scan Length / Scan Time

®

Display Delay and Range settings for current A-Scan to be used for the recording are equivalent to the
same setting of UDS 3-5 Pulser Receiver predcessing entering into t-BScan(Th) mode
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Scan Length and Scan Time

Scan Length — L represents length of section of test object to be displayed, over which probe will be
scanning during recording period. Time (Scan Time) is the duration of recording period

To control Scan Length — L the following ,
manipulations are applicable: /7 7

VR
yd
e Mouse /Touch Screen /s

—t
B Click on corresponding |button|

e Keyboard
-
m Press 1! J on front panel keyboard or on external keyboard = L fore color changes to white -
then use !J '_’J , _J !J on front panel keyboard or , , , on external keyboard

e Combined

B Click on L = L fore color changes to white - then use !J '_’J :J !J on front panel
keyboard or , , , on external keyboard

®

The value of Scan Length — L is adjustable between 50 and 1000 mm or 2 and 40 in
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: Current value of
: Scan Time —Time

|r.ul|.\ i By | 1= By

To control Scan Time — Time

the following manipulations are applicable:/ /, “
7
e Mouse /Touch Screen ,//
/4
B Click on corresponding
e Keyboard
F
m  Press _2 J on front panel keyboard or on external keyboard = Time fore color changes to
white - then use !» !/ « ! on front panel keyboard or [T} , , on external
keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !» » « !

—J _/ on front panel
keyboard or , , on external keyboard

®

The value of Scan Time — Time is adjustable between 5 and 60 sec in 1 sec increment/decrement
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Time-out

Time-Out is waiting time for intermissions predcessing t-BScan(Th) recording, which starts unconditionally
upon Time-Out period is over

lllllllllllllllllllllllllll 1 L' mm
: Currentvalue of : 100 ‘
: Time-Out 3 Time, sec
1 sec :
b ’ 10 ‘
Time-Out, sec
3
7
. 7
To control Time-out 7 _ -

the following manipulations are applicable: P /’ -

z -
Mouse / Touch Screen P

B Click on corresponding Jbutton

Keyboard

?
B Press 3 J on front panel keyboard or on external keyboard = Time-out fore color changes

to white - then use !_ 2/, « ! on front panel keyboard or , , , on external
keyboard

Combined

LIRS NG I P

B Click on Time-Out = Time-Out fore color changes to white - then use —/,

front panel keyboard or , , , on external keyboard

®

The value of Time-Out is adjustable between 0 and 15 sec in 1 sec increment/decrements
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Insert Text Note

A text note may be entered to accompany t-BScan(Th) record. To proceed click on il or press
<Alt>+<X> on external keyboard

1 L. mm o
100 ‘ 1
Time, sec o
1 ‘ 2
s -
place your comments here ‘ 3
i =
e Open
~rif2fl3fl4lalell7z8l9lo)-|l=1| 1| @z_]_ Close
giwillellr ||ty lullillolprllll|] |
E aflsldll fHalfhlifdkf!ry:y"
Zllxllclivibln|mj, !
Del BS
Save Cancel
g
i
0 o 50 100
| “E

Type notes and comments to accompany scanning files: use either virtual keyboard appeared (touch screen
or mouse) or external keyboard

Save
Click on to store typed note and to return to t-BScan(Th) control panel
Cancel g
Click on or press L) on front panel keyboard or on external keyboard to

negate typed note and to return to t-BScan(Th) control panel
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Preview UDS 3-5 Settings

UDS 3-5 Pulser Receiver settings for the t-BScan(Th) record may be previewed through clicking on

UD53-5 | or pressing <Alt>+<D> on external keyboard . The corresponding window appears:

1 L. mm ar
oo KJH

UD53-5: Setup Data

UDS3-5: Setup Data

BASIC: PULSER

Gain = 44 4B Ratge = 41 mum Pulset Mode =DUAL  Tuning=T pH
Reject= 0 % Display Dielay = 6.63 ps PRF = 500 Hz Datrpitig = 1000 £
113 Velocity = 5920 mfs Pulge Width = 110 n3

GATE A: RECEIVER:

afwitch = ON adtart = 0 mm Filter = 4 MHz Diisplay = Full

Mt 25 25

BEEER| o Theeshold= 10 % a-Width= 332 mm Frequency =0.7-13 MHz
ga GATEB: ALARM:
bZwitch = OFF b-3tart = 30 fum afwitch = OFF al.ogic = Positive
b-Threshold = 40 2% b-Width = 25 tmam b3witch = OFF bLogic = Positive
DAC/TCGDGS: MEASTURE:
Mode: OFF Rec=10 FrobeDelay= 873 ps  Angle=0°
Cutve = OFF Measuring Mode = Flank
v

100

o 3Eimm
el | =
==

//

ESC
or press L) on front panel keyboard or <Alt>+<K> or on external keyboard to return to

return to t-BScan(Th) control panel
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Start/Stop t-BScan(Th) recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start t-BScan(Th) recording

4 | H |
stait | putton becomes invisible since t-BScan(Th) recording starts. __28P | putton occupies its

position. Click on stop | or press LJ on front panel keyboard or or <Alt>+<S> on external
keyboard to terminate t-BScan(Th) recording prior to automatic completion

= EA
stop | putton becomes invisible after completion / termination of t-BScan(Th) record. __ 3%t | putton

returns to its position

Save record into afile

Click on _38¥8 |or press ﬂ) on front panel keyboard or or <Alt>+<A> on external keyboard to
save captured t-BScan(Th) record accompanied with instrument calibration dump and text notes /
comments into a file. Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving

Open record from a file and starting postprocessing session

= | =
| &
Click on _Open | or press &) on front panel keyboard or or <Alt>+<0O> on external keyboard t-B-

Scan(Th) record accompanied with instrument calibration dump and text notes / comments from a file. Refer
to paragraph 5.2.18 of this Operating Manual to proceed with file opening. Refer to paragraph 6.3.2.5 of this
Operating Manual to proceed with postprocessing

Return to UDS 3-5 main operating surface

ESC
Click on __Elose |or press L) on front panel keyboard or <Alt>+<C> or on external keyboard
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6.3.2.2. t-BScan(Th) — Scanning

Q Apply probe to test object in the start point of selected scanning line

4

o Click on 3%t |or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard
O Guide probe over the scanning line synchronously with Recording Progress Bar — typical scanning
progress display during is shown and explained below

1 L. mm

+ -
10
Time-Out, zec
3
[ |
Stop
D=2377 mm
t-BScan(Th) record
Back Wall Profile
0 50 100
)|
Recording Currently
Progress Bar measured wall

thickness
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6.3.2.3. BScan(Th) — Prior to Scanning

BScan(Th) control panel is shown below

5 L. mm ‘ ) .
100 1
Encoder:
4 = =
Start Open Save Cloze
Text UD53-5
27.8 mm
g
=
Empty BScan(Th) record field

A

| 50 1o

Total Scan Length for L 1000 mm /40 in

¢ P

)41 L ]
g
=

BScan(Th) scrolling controls
20 L. mm ‘ - . %
2270 1
E Empty BScan(Th) record field
500 200 200 a0 1000 1100 1200 1300 1400 1500
1000 mm / 40 in Segment of Scrolled Total Scan Length exceeding 1000 mm /40 in

®

Display Delay and Range settings for current A-Scan to be used for the recording are equivalent to the
same setting of UDS 3-5 Pulser Receiver predcessing entering into BScan(Th) mode
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Scan Length

Scan Length — L represents length of section of test object to be displayed, over which probe will be
scanning during recording period

To control Scan Length — L the following P 7 i
manipulations are applicable: , -

s .-
e Mouse /Touch Screen 44 -

B Click on corresponding
e Keyboard

-
m Press 1 J on front panel keyboard or on external keyboard = L fore color changes to white -

then use !J '_’J , _J !J on front panel keyboard or , , , on external keyboard

e Combined

B Click on L = L fore color changes to white - then use !J '_’J :J !J on front panel
keyboard or , , , on external keyboard

®

The value of Scan Length — L is adjustable between 50 and 20000 mm or 2 and 800 in

Encoder
Select encoder to be used through appropriate box

Encoder:

Drefauilt j

Clamp probe into encoder — refer to Chapter 7 of this Operating Manual

Connect encoder to its input on the rear panel of ISONIC 2007 instrument

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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Start/Stop BScan(Th) recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start BScan(Th) recording

4 | u |
stait | hutton becomes invisible since BScan(Th) recording starts. _ 3B | button occupies its position.

-5
Click on _3%P_ | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate BScan(Th) recording

H 4

stop | putton becomes invisible after termination of BScan(Th) record. __2tamt | putton returns to its
position

Save record into afile

= |
Click on _38¥€ |or press ﬂ) on front panel keyboard or or <Alt>+<A> on external keyboard to

save captured BScan(Th) record accompanied with instrument calibration dump and text notes / comments
into a file. Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving

Open record from a file and starting postprocessing session

= | =
| &
Click on _Open | or press &) on front panel keyboard or or <Alt>+<0O> on external keyboard B-

Scan(Th) record accompanied with instrument calibration dump and text notes / comments from a file. Refer
to paragraph 5.2.18 of this Operating Manual to proceed with file opening. Refer to paragraph 6.3.2.5 of this
Operating Manual to proceed with postprocessing

Return to UDS 3-5 main operating surface

ESC
Click on __Elose |or press L) on front panel keyboard or <Alt>+<C> or on external keyboard
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6.3.2.4. BScan(Th) — Scanning

a Apply probe equipped with an encoder to test object in the start point of selected scanning line

4
O Click on 3%t |or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard

O Guide probe over the scanning line — typical scanning progress display is shown and explained below

o0 Rl
Encoder:

| E

D=2377 mm L=24.0 mm

BScan(Th) record
Back Wall Profile Currently
measured wall
thickness
0 - 50 100

Current Probe
Position
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6.3.2.5. t-BScan(Th) / BScan(Th) — Postprocessing
Postprocessing of t-BScan(Th) / BScan(Th) records is featured with:

Q Sizing thickness damages at any location along stored images (remaining thickness, thickness loss,

and length of damage)

Q Play-back and evaluation of A-Scans obtained and captured during thickness profile recording
@ Reconstruction of thickness profile image for various Gain and / or Gate A settings

The screen as below appears upon opening file. All postprocessing procedures are performed through
— touch screen stylus or front panel or external mouse to be used

~

| File: v|| Instrument || E dit v|| Measurements v|| A-Scan Recovery v|

£

18 3 mm

30 100 150 200

=

~Inspection Data— [ Thickness Measurements —

5Scan Length: 210 mm |
Encoder Mame: Default I I

Inspector’s Coments: ~Length Measurements

A
ol |

—A-5can Recovery

BScan (Th) |
POSTPROCESSING | |

Menu Bar Functions

File=>Open — opens new t-BScan(Th) / BScan(Th) file

File>Snapshots>Add Snapshot — stores current postprocessing screen snapshot accompanied with
appropriate settings and measurements into postprocessing session memory stack

File>Snapshots>Restore Snapshot — recalls earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

File>Snapshots>Delete Snapshot — deletes earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

File=>Print — prints out postprocessing screen snapshot(s) accompanied with appropriate settings and
measurements

File>EXit — returns to t-BScan(Th) / BScan(Th) control panel

Instrument — indicates setup of UDS 3-5 Pulser Receiver used for scanning when file was created

ISONIC 2007 from Sonotron NDT - Operating Manual — Revision 1.14 - Page 138 of 320



A-Scan Recovery>ON — generates cursor representing sound path of probe's central beam in the
object under test that may be guided over t-BScan(Th) / BScan(Th) image using either touch screen

-»

stylus or mouse or ' _—/, ‘ on front panel keyboard or , on external keyboard — corresponding
A-Scan is recovered synchronously according to sound path cursor position. In the A-Scan Recovery

field there are indicated coordinate (L) of sound path cursor along t-BScan(Th) / BScan(Th) record and
corresponding remaining thickness value (D)

| File: v|| Instrurment || Edit v|| Meazurements v|| A-Scan Recoverny v|

d

12 Jnm

=

0 110 150 200

~Inspection Data—— [ Thickness Measurements —

Scan Length: 210 mm I
Encoder Name: Default | |

| o+ o+ o 4+ 4+

Inspector’s Coments: ~Length Measurements
iy
ol |
—A-Scan Recovery
BScan (Th) | L-99.9mm
POSTPROCESSING | D =85 mm

To fix position of sound path cursor with corresponding recovered A-Scan and remaining thickness

Ente'r
value left mouse click or release touch screen stylus or press *=_/ on front panel keyboard or [Enter
on external keyboard

ESC
To interrupt recovery of A-Scans and empty A-Scan Recovery field right mouse click or press L‘\
on front panel keyboard or on external keyboard

A-Scan Recovery=>OFF — erases sound path cursor, switches off recovered A-Scan, and empties A-
Scan Recovery field
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e Edit>Change Gain>0N — generates cursor representing sound path of probe's central beam in the
object under test that may be guided over t-BScan(Th) / BScan(Th) image using either touch screen

stylus or mouse or !/ f on front panel keyboard or , on external keyboard — corresponding

A-Scan is recovered synchronously according to cursor position. To select reference A-Scan release
Ente.r |

touch screen stylus or left mouse click or press ' *=_ on front panel keyboard or [Enter| on external

keyboard — this generates subwindow allowing off-line re-adjusting of Gain for all A-Scans captured

during t-BScan(Th) / BScan(Th) recording in £6dB range with £0.1 dB increments through clicking or

A

pressing and holding on b J or pressing !; ! on front panel keyboard or , on external
keyboard
isonicaos ]
Select Gain Change:
+44dB O
OK Cancel
b
During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain click
DK Ente.! |
on or press ' *=_ on front panel keyboard or on external keyboard — this applies new

Gain value to all captured A-Scans and redraws t-BScan(Th) / BScan(Th) image accordingly

Cancel e
To interrupt re-adjusting of Gain click on 4| or press L) on front panel keyboard or on

external keyboard

Edit->Change Gain=>OFF — negates Gain re-adjustment and returns to originally recorded t-BScan(Th) /
BScan(Th) image and original Gain setting
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Edit>ROI=>0ON - generates cursor representing sound path of probe's central beam in the object under

test that may be guided over t-BScan(Th) / BScan(Th) image using either touch screen stylus or mouse
r ? ‘ on front panel keyboard or , on external keyboard — corresponding A-Scan is

recovered synchronously according to cursor position. To select reference A-Scan release touch screen

FnTEr

stylus or left mouse click or press ' *=_/ on front panel keyboard or [Enter|on external keyboard — this

generates off-line Gate A controls n n n u m m allowing to redefine Region Of

Interest for t-BScan(Th) / BScan(Th) imaging

| File v|| Instrument || Edit v|| Measurements v|| A-Scan Recovery =

£

1% 3 mm

cinspectionData——— | - hickness Measurements —

Scan Length: 210 mm I
Encoder Name: Default I I

Inspector’s Coments: rLength Measurements

A
iRl |

=h-Scan Becoveny

BScan (Th) |
POSTPROCESSING | |

+ o+
+ o+
+ o+
+ o+
+ o+
+ o+
+ o+
+ o+
+ o+

Upon completing redefining of Region Of Interest click on — this applies new Gate A to all
captured A-Scans and updates t-BScan(Th) / BScan(Th) image accordingly

ESC
To interrupt selection of reference of A-Scan right mouse click or press L‘\ on front panel keyboard

or on external keyboard

To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on

Edit2>ROI=>0OFF — negates Gate A re-adjustment and returns to originally recorded t-BScan(Th) /
BScan(Th) image and original Gate A setting
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Edit>Flip Horizontal — reorders A-Scans captured during t-BScan(Th) / BScan(Th) recording in
reverse succession and redraws t-BScan(Th) / BScan(Th) image accordingly. This service function
may be useful for merging scans of neighboring sections of an object, which were scanned in opposite

direction due to access conditions, etc

| File v|| Instrument || Edit v|| Measurements v|| A-Scan Recovery v|

ROI 4
Change Gain ¥

~Inspection Data
Scan Length: 100 mm
Scan Time: 10 sec
Time-Out: 3 sec
Inspector's Coments:

B

|

t-BScan (Th)
POSTPROCESSING

~ Thickness Measurements —

~Length Measurements

—A-5can Recovery

®

| File v|| Instrument || Edit v|| Measurements v|| A-Scan Recovery -

E

Stimm

=

~Inspection Data
Scan Length: 100 mm
Scan Time: 10 sec
Time-Out: 3 sec
Ingpector's Coments:

[ |
||

t-BScan (Th)
POSTPROCESSING

~ Thickness Measurements —

~Length Measurements

—A-5can Recovery

100

Applying of Flip Horizontal function empties postprocessing session memory stack
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Measurements=>Length->ON — generates first vertical cursor that may be guided over t-BScan(Th) /

BScan(Th) image using either touch screen stylus or mouse or ?/ « on front panel keyboard or
, on external keyboard . Coordinate of the first vertical cursor along t-BScan(Th) / BScan(Th)
image (Lg) is indicated in the Length Measurements field. To fix position of the first vertical cursor left

Ente'r
mouse click or release touch screen stylus or press + J on front panel keyboard or [Enter|on
external keyboard . To interrupt vertical cursor manipulations and empty Length Measurements field

ESC
right mouse click or press L) on front panel keyboard or on external keyboard
Second vertical cursor appears upon fixing first one, it may be manipulated by the same way. Coordinate
of the second vertical cursor along t-BScan(Th) / BScan(Th) image (Lr) is indicated in the Length
Measurements field along with parameter W = Lr — Lg. Parameter W represents length of defect
provided that vertical cursors are placed appropriately
Measurements=>Length->OFF — erases vertical cursors and empties Length Measurements field

Measurements=>Thickness=>ON — generates first horizontal cursor that may be guided over t-

Y |

BScan(Th) / BScan(Th) image using either touch screen or mouse or =, _—_ / on front panel
keyboard or , on external keyboard . Coordinate of the first horizontal cursor along t-BScan(Th) /
BScan(Th) image (Dg) is indicated in the Thickness Measurements field. To fix position of the first

"
Enter

horizontal cursor left mouse click or release touch screen stylus or press ' -*=_/ on front panel keyboard
or [Enter| on external keyboard . To interrupt horizontal cursor manipulations and empty Thickness

ESC
Measurements field right mouse click or press L) on front panel keyboard or on external
keyboard
Second horizontal cursor appears upon fixing first one, it may be manipulated by the same way.
Coordinate of the second horizontal cursor along t-BScan(Th) / BScan(Th) image (Dr) is indicated in
the Thickness Measurements field along with parameter H = Dr — Dg. Parameter H represents
thickness loss provided that horizontal cursors are placed appropriately

Measurements=>Thickness=>OFF — erases horizontal cursors and empties Thickness
Measurements field

| File v|| Instrurment || Edit v|| Meazurements v|| A-Scan Recavery v|

2

a0 100 150 200

-

123 nm

=

~Inspection Data—— [ Thickness Measurements —

Scan Length: 210 mm I H=53mm
Encoder Name: Default

| Dg=86mm | Dr=13.9mm

Inspector’s Coments: ~Length Measurements
=
B | W =57.1mm
o |Lg=859mm | Lr=143 mm

—A-Scan Recovery

BScan (Th) |
POSTPROCESSING | ||
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6.4. B-Scan cross-sectional imaging and recording of defects
for longitudinal and shear wave inspection — t-ABIScan or
ABIScan

6.4.1. Setup Pulser Receiver for t-ABIScan or ABIScan Imaging and
Recording

UDS 3-5 Pulser Receiver window — main operating surface — appears on ISONIC 2007 screen upon

[2]t-ABIscan ‘ l [2]|ABIScan
or

clicking onl
6.4.1.1. Straight Beam Probes

. The settings as below to be provided

# | Parameter or Submenu Required Settings Note
Mode
1 Gain BASICS Gain setting to be performed according
to inspection procedure providing
required echo heights from defects to be
detected
2 DAC/TCG DAC/TCG DAC/TCG settings to meet requirements
of inspection procedure
3 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
4 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing Level, To synchronize with Gain
Firing Level, and Damping settings to provide setting procedure
Damping optimal signal to noise ratio
5 Filter, Frequency RECEIVER Filter and Frequency settings to match | To synchronize with Gain
with probe's frequency setting procedure
6 Display RECEIVER Display setting may be either Full, RF, The same Display mode to
PosHalf, or NegHalf be used for both Probe
Delay determining and t-
ABIScan / ABIScan
Recording
7 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
8 Probe Delay MEASURE Probe Delay setting to be equal to Probe delay may be
actual probe delay determined according to
paragraph 5.2.13.7 or
5.2.13.9 of this Operating
Manual or similarly
9 | Angle MEASURE Angle = 0°
10 | Settings for other
parameters and
modes have no
significance

I
Click on _| or press LJ on front panel keyboard or on external keyboard upon completing
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6.4.1.2. Angle Beam Probes

# | Parameter or Submenu Required Settings Note
Mode
1 Gain BASICS Gain setting to be performed according
to inspection procedure providing
required echo heights from defects to be
detected
2 DACI/TCG DAC/TCG DAC/TCG settings to meet requirements
of inspection procedure
3 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
4 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing Level, To synchronize with Gain
Firing Level, and Damping settings to provide setting procedure
Damping optimal signal to noise ratio
5 Filter, Frequency RECEIVER Filter and Frequency settings to match | To synchronize with Gain
with probe's frequency setting procedure
6 Display RECEIVER Display setting may be either Full, RF, The same Display mode to
PosHalf, or NegHalf be used for both Probe
Delay determining and t-
ABIScan / ABIScan
Recording
7 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
8 Probe Delay MEASURE Probe Delay setting to be equal to Probe delay may be
actual probe delay determined according to
paragraph 5.2.13.5 or
5.2.13.6 or 5.2.13.9 of this
Operating Manual or
similarly
9 Angle MEASURE Angle setting to be equal to actual
probe angle
10 | Settings for other
parameters and
modes have no
significance

I
Click on _| or press LJ on front panel keyboard or on external keyboard upon completing

ISONIC 2007 from Sonotron NDT - Operating Manual — Revision 1.14 - Page 145 of 320




6.4.2. B-Scan Cross Sectional Imaging — Implementation

6.4.2.1. t-ABIScan — Prior to Scanning (Straight Beam Probes)

t-ABIScan control panel for straight beam probe is shown below

1 Thickness o Coloring
P o+ o+ 43 mm ‘ 1 » I Pseudo
+ + o+ o+ — — |
o vt 0.5 2 Grayscale |
_‘:- ¥ + o+ o+ 5 Length ‘ o » Th | | o
P+ ¥ + + Efma
S+ . .l || 200 mm 3 _UDS35
+ o+ o+ 1 Time r b ﬁ’, E
o Ts ‘ 4 » Start | Open| Save | Cloze
tABIScan || | 26-Jan-2006
o -50 -100 -150 % -200
Empty t-ABIScan record field
< Scan Length not exceeding 600 mm or 24 in / Scan Time
20 Length o
1000 mm ‘ 3 »
0 -100 -Z00 -300 -400 -500 -600
Empty t-ABIScan record field
t-ABIScan scrolling controls -
4 I
Segment of Scrolled Total Scan Length exceeding 600 mm or 24 in / Scan Time
. g

®

Display Delay for current A-Scan to be used for the recording is equal to Probe Delay setting in
submenu MEASURE of UDS 3-5 Pulser Receiver predcessing entering into t-ABIScan mode
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Thickness

Thickness setting defines the region of interest starting from the scanning surface and automatic Range
setting for current A-Scan to be used for the recording: Range = Thickness. For objects whereas back echo
is feasible it may be useful to key in Thickness value slightly exceeding actual thickness of the object under
test — this will allow to record simultaneously defects signals and back echo itself. For the screenshot as
above the actual thickness of the test piece is 40 mm while the Thickness setting is 43 mm thanks to such
setting back echo is clearly resolved at the end of A-Scan

1 Thickness
43 mm

5 Length
200 mm

1 Fime

To control Thickness the following y;
manipulations are applicable: ///
e Mouse / Touch Screen ///

B Click on corresponding
e Keyboard

+
m Press 1! J on front panel keyboard or on external keyboard = Thickness fore color changes

to white - then use !J 2) :J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Thickness = Thickness fore color changes to white - then use !J '_’J !J !J on
front panel keyboard or , , , on external keyboard

®

The value of Thickness is adjustable between 5 and 300 mm or 0.2 and 12 in (expandable on special
inquire)

Skip #

This setting is ignored while using straight beam probes
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Scan Length and Scan Time

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period. Time (Scan Time) is the duration of recording period

1 Thickness

43 inm

=y

I By

3b ‘
oo K

-\

3
r
4
To control Length the following , . 7
manipulations are applicable: P
,.7
7
e Mouse /Touch Screen 4

B Click on corresponding
e Keyboard

Fd
B Press 3 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J '_’J _J 4 on front panel keyboard or , =, k=, U on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J '_’J !J ij on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in
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1 Thickrdess
43 mim

5 Length
209 mm

To control Time
: . . _ -,
the following manipulations are applicable: 7 -

e Mouse /Touch Screen ¢ -’
B Click on corresponding
e Keyboard

-
m Press _4 j on front panel keyboard or on external keyboard = Time fore color changes to

white - then use !J '_’J _J 4 on front panel keyboard or , =, k=, U on external

keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !J '_’J !J ij on front panel
keyboard or , , on external keyboard

®

The value of Time is adjustable between 5 and 60 sec

Time-out

Time-Out is waiting time for intermissions predcessing ABIScan recording, which starts unconditionally
upon Time-Out period is over. Time-Out has fixed duration of 3 sec for t-ABIScan

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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t-ABIScan Record Palette

There are four palettes available through click on appropriate button:

— Coloring

Pseudo

Pzeudo? I

Grayscale I

Thermal I

Start/Stop t-ABIScan recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start t-ABIScan recording

4 |
ﬂ' button becomes invisible since t-ABIScan recording starts. ﬂ' button occupies its position.

-3 e
Click on _3%p | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate t-ABIScan recording prior to automatic completion

= | 2.
stop | putton becomes invisible after completion / termination of t-ABIScan record. __ 3%’ | putton

returns to its position

Save record into afile

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.4.2.2. t-ABIScan — Scanning (Straight Beam Probes)

a

Apply probe to test object in the start point of selected scanning line

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard

Guide probe over the scanning line synchronously with Probe Icon moving with constant speed above t-
ABIScan record field — typical scanning progress display during is shown and explained below

+ 4+ o+ -
+
+

£
++++;|f+++

)

+ o+ 4+ o+ o+ |+ o+ 4+ -

B+ + + + +

t+-ABlScan || Scanning... L=42_ 37 mm

1 Thickness o r Colurisy
43 mm ‘ 1 » | Pseudo
+ -
.
- 0.5 2 Grayscale |
* 5 Length o | 7
i 200 mm ‘ 3 » Thermal UDS3-5
+ 1 Time o = [
+1~’n*'q is ‘ 4 » Open| Save Cloze
| 26-Jan-2006

- 150

% =200

e ——

——

Current Probe
Position

t-ABIScan record
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6.4.2.3. ABIScan — Prior to Scanning (Straight Beam Probes)

ABIScan control panel for straight beam probe is shown below

m 1 Thickness o Coloring
43 mm ‘ 1 I Pseudo
0.5 2 Grayscale |
5 Length ] | -
200 mm ‘ 3 Thermal UDS3-5
Encoder: } - =
IDefauIt j Start | Open| Save Cloze
| 26-Jan-2006
o -50 -100 -150 -200
Empty ABIScan record field
Scan Length not exceeding 600 mm or 12 in
< >
P
X
100 Length o
2600 mm ‘ 3 »
0 -200 -400 -E00 -500 -1000
Empty ABIScan record field
p] ABIScan scrolling controls field Y
< Segment of Scrolled Total Scan Length exceeding 600 mm or 12 in q

®

Display Delay for current A-Scan to be used for the recording is equal to Probe Delay setting in
submenu MEASURE of UDS 3-5 Pulser Receiver predcessing entering into ABIScan mode
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Thickness

Thickness setting defines the region of interest starting from the scanning surface and automatic Range
setting for current A-Scan to be used for the recording: Range = Thickness. For objects whereas back echo
is feasible it may be useful to key in Thickness value slightly exceeding actual thickness of the object under
test — this will allow to record simultaneously defects signals and back echo itself. For the screenshot as
above the actual thickness of the test piece is 40 mm while the Thickness setting is 43 mm thanks to such
setting back echo is clearly resolved at the end of A-Scan

1 Thickness
43 mm

5 Length ~
e
To control Thickness the following /7 7
manipulations are applicable: //
e Mouse / Touch Screen &

B Click on corresponding
e Keyboard

-
B Press 1 J on front panel keyboard or on external keyboard = Thickness fore color changes

to white - then use !J _J _J !J on front panel keyboard or , , , on external

keyboard
e Combined

,!J, !JOI’]

B Click on Thickness = Thickness fore color changes to white - then use !J '_’J
front panel keyboard or , , , on external keyboard

®

The value of Thickness is adjustable between 5 and 300 mm or 0.2 and 12 in (expandable on special
inquire)

Skip #

This setting is ignored while using straight beam probes
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Scan Length

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period

1 Thickness

=y

43 inm

3b
~ -~ 5 Length
200 mm
V4
4 s

LR

P

g
To control Length the following
manipulations are applicable: 7
// -
e Mouse /Touch Screen P %
&
B Click on corresponding
e Keyboard

-
B Press 3 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J '_’J :J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 20000 mm or 2 and 800 in

Encoder
Select encoder to be used through appropriate box

Encoder:

I Drefauilt j

Clamp probe into encoder — refer to Chapter 7 of this Operating Manual
Connect encoder to its input on the rear panel of ISONIC 2007 instrument

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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ABIScan Record Palette

There are four palettes available through click on appropriate button:

— Coloring

Pseudo

Pzeudo? I

Grayscale I

Thermal I

Start/Stop ABIScan recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start ABIScan recording

4 |
ﬂ' button becomes invisible since ABIScan recording starts. ﬂ' button occupies its position.

- S
Click on _3%p | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate ABIScan recording

- KA
stop | putton becomes invisible after termination of ABIScan record. _ 3tait | putton returns to its

position

Save record into afile

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.4.2.4. ABIScan — Scanning (Straight Beam Probes)

a Apply probe equipped with an encoder to test object in the start point of selected scanning line

..o
O Click on 3t |or press _J on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line — typical scanning progress display during is shown and explained

below
1 Thickness ~ Coloring
Current A-Scan o
— 42 mm 1 I Pzeudo
+ o+ W+ + o+ o+ - — |
: : : + : : : ‘ ! PSEUdDZ TE!t
—. 7 ot 0.5 2 Grayscale |
+ 4+ ﬁ-x__.__;;\ + o+ o+ 5 Length - — : | 7
+ o+ o+ ¥ O+ erma
P P 200 mm ‘ 3 UDS3-5
+ o+ + 4 o+t Encoder: [ ] a [
___ .+ J: +1~’n*'q+ _, IDefauIt j Stop | Open| Save| Cloze
I N N |
ABIScan | Scanning... L=43.50 mm | 26-Jan-2006
] [ 140 -100 -150 -200
— Current Probe
Position
L\ |
ABIScan record %
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6.4.2.5. t-ABIScan — Prior to Scanning (Angle Beam Probes)
t-ABIScan control panel for angle beam probe is shown below

5 Thickness - LE L]
+ A0 mm ‘ 1 » | Pzeudo
e »
* 0.5 Grayzcale |
* 5 Length I h : | i
N 80 mm ‘ 3 » erma UDS3-5
Current A-Scan 1 Time ‘ o » 3 = =
. . _ _ 105 4 Start | Open| Save | Close
t-ABlIScan 26-Jan-2006
5 g 40
>
Full Scan Length / Scan Time
For Total Length of t-ABIScan Record
Not Exceeding 600 mm or 24 in
Empty ABIScan record field
< >
Total Length of t-ABIScan Record
Not Exceeding 600 mm or 24 in
5 Length o
640 mm ‘ 3 »

=100 -2I|:II:I -SIIIIIII -400 -5I|:II:I -EIIZII:I

Empty ABIScan record

ABIScan scrolling controls field

Segment of Scrolled Total Scan Length / Scan Time and t-ABIScan Record For Total
Length of ABIScan Record Exceeding 600 mm or 24 in

®

O Display Delay for current A-Scan to be used for the recording is equal to Probe Delay setting in submenu
MEASURE of UDS 3-5 Pulser Receiver predcessing entering into t-ABIScan mode
O Total Length of t-ABIScan Record is determined automatically according to:
Total Length of t-ABIScan Record = Total Scan Length + 2 * Skip # * Thickness * Tan (Angle)
whereas
¢ Thickness, Skip #, and Total Scan Length = Length are the settings of t-ABIScan control panel

¢ Angle is setting in submenu MEASURE of UDS 3-5 Pulser Receiver predcessing entering into t-
ABIScan mode
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Thickness and Skip #

Thickness and Skip # settings define the region of interest starting from the scanning surface and automatic
Range setting for current A-Scan to be used for the recording:

Range =2 x Skip # x Thickness x Cos (Angle)
whereas
¢ Thickness and Skip # are the settings of t-ABIScan control panel
¢ Angle is setting in submenu MEASURE of UDS 3-5 Pulser Receiver predcessing entering into
t-ABIScan mode

For objects with parallel surfaces the actual Thickness value to be entered for full skip inspection (Skip # =
1)

5 Thickness
40 mm

5 Length
80 mm

To control Thickness the following /7
manipulations are applicable: ///
e Mouse /Touch Screen /,/

B Click on corresponding
e Keyboard

-
m Press 1 J on front panel keyboard or on external keyboard = Thickness fore color changes

to white - then use !J '_’J _J ¥ on front panel keyboard or [f, 53}, [, U on external

keyboard

e Combined

B Click on Thickness = Thickness fore color changes to white - then use !J '_’J :J ij on
front panel keyboard or , , , on external keyboard

®

The value of Thickness is adjustable between 5 and 300 mm or 0.2 and 12 in (expandable on special
inquire)
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To control Skip # the following
manipulations are applicable:

Skip # 3

oy 1o B[ |1y

Mouse / Touch Screen

B Click on corresponding Jjbutton

Keyboard

-
m Press _2 J on front panel keyboard or on external keyboard = Skip # fore color changes to

white - then use !_ ?/ . ! on front panel keyboard or , , , on external
keyboard

Combined

LY

B Click on Skip # = Skip # fore color changes to white - then use =/,

panel keyboard or , , , on external keyboard

2 & &

®

The Skip # setting may be 0.5 — half skip insonification or 1 — full skip insonification
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Scan Length and Scan Time

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period. Time (Scan Time) is the duration of recording period

5 Thickness
40 mm

=y

I By

3b ‘
J oo &

-\

3
r
4
To control Length the following , . 7
manipulations are applicable: P
,.7
7
e Mouse /Touch Screen 4

B Click on corresponding
e Keyboard

Fd
B Press 3 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J '_’J _J 4 on front panel keyboard or , =, k=, U on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J '_’J !J ij on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in
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1 Thickrdess
43 mim

5 Length
209 mm

To control Time
: . . _ -,
the following manipulations are applicable: 7 -

e Mouse /Touch Screen ¢ -’
B Click on corresponding
e Keyboard

-
m Press _4 j on front panel keyboard or on external keyboard = Time fore color changes to

white - then use !J '_’J _J 4 on front panel keyboard or , =, k=, U on external

keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !J '_’J !J ij on front panel
keyboard or , , on external keyboard

®

The value of Time is adjustable between 5 and 60 sec

Time-out

Time-Out is waiting time for intermissions predcessing ABIScan recording, which starts unconditionally
upon Time-Out period is over. Time-Out has fixed duration of 3 sec for t-ABIScan

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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t-ABIScan Record Palette

There are four palettes available through click on appropriate button:

— Coloring

Pseudo

Pzeudo? I

Grayscale I

Thermal I

Start/Stop t-ABIScan recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start t-ABIScan recording

4 |
ﬂ' button becomes invisible since t-ABIScan recording starts. ﬂ' button occupies its position.

-3 e
Click on _3%p | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate t-ABIScan recording prior to automatic completion

= | 2.
stop | putton becomes invisible after completion / termination of t-ABIScan record. __ 3%’ | putton

returns to its position

Save record into afile

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.4.2.6. t-ABIScan — Scanning (Angle Beam Probes)

a Apply probe to test object in the start point of selected scanning line

4
a Clickon ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line synchronously with Probe Icon moving with constant speed above t-
ABIScan record field — typical scanning progress display during is shown and explained below

Current A-Scan

5 Thickness o  Loloring
+ o+ ror 40 mm ‘ 1 » |  Pseudo ﬂ
+ + o+ o+ _ — |
T LT 05 £ Grayscale |
+ o+ + o+ 5 Length ‘ r » — | | -~
+ 4+ + o+ o+ Ermad
. P 80 mm 3 UDS3-5
+ o+ + o+ o+ 1 Time o i E
Y o, " .;rlh,:_m,,,-}',n“r 10s ‘ 4 » Open| Save Cloze
|
| 26-Jan-2006

Current Probe
Position

t-ABIScan record
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6.4.2.7. ABIScan — Prior to Scanning (Angle Beam Probes)
ABIScan control panel for angle beam probe is shown below

1 Thickness i Coloring
40 mm ‘ 1 » | Pseudo

+ o+ +
+ +
¥ * Grayzcale |
ot * 5 Length o Th : | i
o X 160 mm ‘ 3 » == UDS3-5
+ o+ Current A-Scan Encoder: ’ = ]
" _ | J Start [ Open| Save Cloze
ABlScan Z2b-Jan-2006
Full Scan Length
For Total Length of ABIScan Record
L< Not Exceeding 600 mm or 24 in »‘
00 &0 -5 00 150

Empty ABIScan record field

Total Length of ABIScan Record
Not Exceeding 600 mm or 24 in %

5 Length -
640 mm ‘ 3
=100 =200 =200 -0 -EIIIIEI -BIIZII:I

»

Empty ABIScan record

ABIScan scrolling controls field

>

Segment of Scrolled Total Scan Length and ABIScan Record For Total Length of ABIScan
Record Exceeding 600 mm or 24 in

®

O Display Delay for current A-Scan to be used for the recording is equal to Probe Delay setting in submenu
MEASURE of UDS 3-5 Pulser Receiver predcessing entering into ABIScan mode

O Total Length of ABIScan Record is determined automatically according to:
Total Length of ABIScan Record = Total Scan Length + 2 * Skip # * Thickness * Tan (Angle)
where
¢ Thickness, Skip #, and Total Scan Length = Length are the settings of ABIScan control panel
¢ Angle is setting in submenu MEASURE of UDS 3-5 Pulser Receiver predcessing entering into
ABIScan mode

ISONIC 2007 from Sonotron NDT - Operating Manual — Revision 1.14 - Page 164 of 320



Thickness and Skip #

Thickness and Skip # settings define the region of interest starting from the scanning surface and automatic
Range setting for current A-Scan to be used for the recording:

Range =2 x Skip # x Thickness x Cos (Angle)
whereas

¢ Thickness and Skip # are the settings of ABIScan control panel

¢ Angle is setting in submenu MEASURE of UDS 3-5 Pulser Receiver predcessing entering into
ABIScan mode

For objects with parallel surfaces the actual Thickness value to be entered for full skip inspection (Skip # =
1)

1 Thickness

40 mm

5 Length
160 mm

To control Thickness the following /7 7
manipulations are applicable:

e Mouse / Touch Screen 4

B Click on corresponding
e Keyboard

-
B Press 1 J on front panel keyboard or on external keyboard = Thickness fore color changes

to white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Thickness = Thickness fore color changes to white - then use !J '_’J !J !J on
front panel keyboard or , , , on external keyboard

®

The value of Thickness is adjustable between 5 and 300 mm or 0.2 and 12 in (expandable on special
inquire)
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Skip # o~

1 Thickness
40 mm ‘

5 Length
R «

To control Skip # the following
manipulations are applicable:

e Mouse / Touch Screen

B Click on corresponding

e Keyboard
F
B Press _2 J on front panel keyboard or on external keyboard = Skip # fore color changes to

white - then use !_ =, « ! on front panel keyboard or [T} , , on external
keyboard

e Combined
B Click on Skip # = Skip # fore color changes to white - then use !_
panel keyboard or , , , on external keyboard

2 = =

~/ on front

®

The Skip # setting may be 0.5 — half skip insonification or 1 — full skip insonification
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Scan Length

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period

1 Thickness

=y

40 inm

1
~ -~ 5 Length
160 mm
V4
4 s

LR

P

g
To control Length the following
manipulations are applicable: 7
// -
e Mouse /Touch Screen P %
&
B Click on corresponding
e Keyboard

-
B Press 3 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in

Encoder
Select encoder to be used through appropriate box

Encoder:

Drefault j

Clamp probe into encoder — refer to Chapter 7 of this Operating Manual
Connect encoder to its input on the rear panel of ISONIC 2007 instrument

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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ABIScan Record Palette

There are four palettes available through click on appropriate button:

— Coloring

Pseudo

Pzeudo? I

Grayscale I

Thermal I

Start/Stop t-ABIScan recording

4
Click on ﬂl or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to

start ABIScan recording

4 |
ﬂ' button becomes invisible since ABIScan recording starts. ﬂ' button occupies its position.

-3 e
Click on _3%p | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate ABIScan recording prior to automatic completion

- KA
stop | putton becomes invisible after termination of ABIScan record. _ 3tait | putton returns to its

position

Save record into afile

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.4.2.8. ABIScan — Scanning (Angle Beam Probes)

a Apply probe equipped with an encoder to test object in the start point of selected scanning line

..o
O Click on 3t |or press _J on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line — typical scanning progress display during is shown and explained
below

— Coloring

» I Pzeudo
» Pzeudo? | Text
Grayscale |

-~

omn

Bl <
5L h

roomn G

I By

Iz

upsS3-5

oo By

Thermal

Encoder: ] a H
I Drefault j : Open| Save| Close
ABIScan | Scanning... L=25.00 mm | 26-Jan-2006

Current Probe
Position

=50 -100 - 150

ABIScan record
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6.4.2.9. t-ABIScan / ABIScan — Postprocessing
Versatile postprocessing of t-ABIScan / ABIScan records is featured with:

Q Sizing defects at any location along stored images (coordinates, projection size, amplitude-based
evaluation)

Q Play-back and evaluation of A-Scans obtained and captured during t-ABIScan / ABIScan defects
imaging and recording

a Defects outlining and pattern recognition based on A-Scan sequence analysis — Echo Dynamic
Pattern Analysis

O Reconstruction of B-Scan defects images for various Gain, Reject, and off-line Gate level settings

o DAC/DGSt-ABIScan / ABIScan normalization

The screen as below appears upon opening file. All postprocessing procedures are performed through
— touch screen stylus or front panel or external mouse to be used

—_—
*File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

— Length Measurements

t-ABIScan |
POSTPROCESSING | | | |

—Depth Measurements

|' Filtering: I
|
| |
IVA-Scan Recovery
|

Menu Bar Functions

e File>Open - opens new t-ABIScan / ABIScan file
e File>Snapshots>Add Snapshot — stores current postprocessing screen snapshot accompanied with
appropriate settings and measurements into postprocessing session memory stack

e File>Snapshots>Restore Snapshot — recalls earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

e File>Snapshots>Delete Snapshot — deletes earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

e File=>Print — prints out postprocessing screen snapshot(s) accompanied with appropriate settings and
measurements
e File=>Exit — returns to t-ABIScan / ABIScan control panel

e View-—2>Instrument — indicates setup of UDS 3-5 Pulser Receiver used for scanning when file was
created

e View-=2Inspection Data — indicates operator's comments entered prior to scanning
e View—>Coloring — selects palette for t-ABIScan / ABIScan image
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A-Scan Recovery 20N (straight beam inspection record) — generates cursor representing sound path
of straight beam probe's central beam in the object under test that may be guided over t-ABIScan /

ABIScan image using either touch screen stylus or mouse or ?/ « on front panel keyboard or ,
on external keyboard — corresponding A-Scan is recovered synchronously according to sound path
cursor position. Starting position of cursor (L) corresponding to probe's center is indicated in the A-Scan
Recovery field. On the recovered A-Scan there is red Off-line Gate presented. Initially Off-line Gate
covers whole A-Scan range

| File v|| Wiew v|| E dit v|| I easurements v|| A-Scan Recovery v|

— Length Measurements

t-ABIScan |
POSTPROCESSING | ||

— Depth Measurements
" Filtering: I
|
| |

"A—S can Recovery

I I I I
E S e
I I I I

L =262 mm b 00%

-_—

|Automatic Measurements Display| accompanies recovered A-Scan and indicates (refer to
paragraphs 5.1.12, 5.2.13.1 and 5.2.13.2 of this Operating Manual):

o deptht of reflector (measurement mode - Flank)
o amplitude H of the maximal signal in the Off-line Gate expressed in % of full A-Scan height

o AVC (dB to DAC) of the maximal signal in the Off-line Gate provided that DAC was active
whilst recording t-ABIScan / ABIScan data

To fix position of sound path cursor with corresponding recovered A-Scan and Automatic

"
Enter

Measurements Display data left mouse click or release touch screen stylus or press ' *=_ on front
panel keyboard or [Enter| on external keyboard

ESC
To interrupt recovery of A-Scans and empty A-Scan Recovery field right mouse click or press L)
on front panel keyboard or on external keyboard

A-Scan Recovery>OFF (straight beam inspection record) — erases sound path cursor with recovered
A-Scan and Automatic Measurements Display and empties A-Scan Recovery field
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A-Scan Recovery 20N (angle beam inspection record) — generates cursor representing sound path of
angle beam probe's central beam in the object under test that may be guided over t-ABIScan / ABIScan

image using either touch screen stylus or mouse or 2/, « on front panel keyboard or , on
external keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor
position. Starting position of cursor (L) corresponding to probe's incidence point is indicated in the A-

Scan Recovery field. On the recovered A-Scan there is red Off-line Gate presented. Initially Off-line
Gate covers whole A-Scan range

| File v|| Wiew v|| E dit v|| I easurements v|| A-Scan Recovery v|

— Length Measurements

ABIScan l
POSTPROCESSING | ||

— Depth Measurements
" Filtering: I
|
| |

A-5can Recovery
ﬁ L=-244mm

=

T T I
R e

t=0.2mm a=03mm
H=200% AVC=92dB

|Automatic Measurements Display| accompanies recovered A-Scan and indicates (refer to
paragraphs 5.1.12, 5.2.13.1 and 5.2.13.2 of this Operating Manual):

o deptht of reflector (measurement mode - Flank)

o0 distance a between probe incidence point and reflector taken along scanning surface
(measurement mode - Flank)

o amplitude H of the maximal signal in the Off-line Gate expressed in % of full A-Scan height

o AVC (dB to DAC) of the maximal signal in the Off-line Gate provided that DAC was active
whilst recording t-ABIScan / ABIScan data

To fix position of sound path cursor with corresponding recovered A-Scan and Automatic

"
Enter

Measurements Display data left mouse click or release touch screen stylus or press ' *=_/ on front
panel keyboard or [Enter| on external keyboard

ESC
To interrupt recovery of A-Scans and empty A-Scan Recovery field right mouse click or press L‘\
on front panel keyboard or on external keyboard

A-Scan Recovery=>OFF (angle beam inspection record) — erases sound path cursor with recovered A-
Scan and Automatic Measurements Display and empties A-Scan Recovery field
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e Edit>Change Gain>0N — (straight beam and angle beam inspection records) generates cursor
representing sound path of probe's central beam in the object under test that may be guided over t-

ABIScan / ABIScan image using either touch screen stylus or mouse or !/ f on front panel
keyboard or , on external keyboard — corresponding A-Scan is recovered synchronously
according to sound path cursor position. To select reference A-Scan release touch screen stylus or left

[
Enter

mouse click or press +4 _ on front panel keyboard or on external keyboard — this generates
subwindow allowing off-line re-adjusting of Gain for all A-Scans captured during t-ABIScan / ABIScan

recording in £6dB range with £0.1 dB increments through clicking or pressing and holding on ﬁ or

pressing —/, . / on front panel keyboard or , on external keyboard

ISONIC 2005 |

Select Gain Change:

+4.4 dB il

0K Cancel

by
During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain click

DK EﬂTE.! _'
on or press +4 _ on front panel keyboard or on external keyboard - this applies new

Gain value to all captured A-Scans and redraws t-ABIScan / ABIScan image accordingly

Cancel | g
To interrupt re-adjusting of Gain click on or press L) on front panel keyboard or on

external keyboard

Edit>Change Gain>OFF — negates Gain re-adjustment and returns to originally recorded t-ABIScan /
ABIScan image and original Gain setting
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Edit>ROI=>ON (straight beam inspection record) — generates cursor representing sound path of
straight beam probe's central beam in the object under test that may be guided over t-ABIScan /

ABIScan image using either touch screen stylus or mouse or 2/, « on front panel keyboard or ,
on external keyboard — corresponding A-Scan is recovered synchronously according to sound path
cursor position. To select reference A-Scan release touch screen stylus or left mouse click or press

Enter
_/ on front panel keyboard or [Enter|on external keyboard — this generates Off-line Gate controls

n n n n H n allowing to redefine Region Of Interest for t-ABIScan / ABIScan

imaging

| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery -

— Length Measurements

ABIScan |
POSTPROCESSING | |

— Depth Measurements

Filtering: I
| |
IVA-Scan Recovery

|

To interrupt selection of reference of A-Scan right mouse click or press L) on front panel keyboard

or on external keyboard

To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on
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Upon completing redefining of Region Of Interest click on — this applies new Off-line Gate to all
captured A-Scans and updates t-ABIScan / ABIScan image accordingly — only segment of t-ABIScan /
ABIScan image covered by newly adjusted Off-line Gate remains visible

| File v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|

— Length Measurements

ABIScan l
POSTPROCESSING | | /

— Depth Measurements

Filtering: I
’—A—S can Recovery
|

It is possible then to perform A-Scan signals evaluation using newly adjusted Off-Line Gate through A-
Scan Recovery >ON

| File: v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|
a -50 100
== e e e s I |
—— - — e = —
- pr—— e —
—Length Measurements
ABIScan | .
POSTPROCESSING | N
— Depth Measurements +
Filtering: *
’7| I +
| | N
4
A-S5can Recovery N - +N
ﬁ L = E0.8 mm t=16.2mm H=76% i

o Edit>ROI>OFF (straight beam inspection record) — negates Off-line Gate re-adjustment and returns
to originally recorded t-ABIScan / ABIScan image and initial Off-line Gate setting
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Edit2>ROI=>0ON (angle beam inspection record) — generates cursor representing sound path of angle
beam probe's central beam in the object under test that may be guided over t-ABIScan / ABIScan

image using either touch screen stylus or mouse or ?/ « on front panel keyboard or , on
external keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor

"
Enter

position. To select reference A-Scan release touch screen stylus or left mouse click or press ' *=_ on

front panel keyboard or Enter on external keyboard - this generates Off-line Gate controls

n n u u n allowing to redefine Region Of Interest for t-ABIScan / ABIScan

imaging

| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery -

— Length Measurements

t-ABIScan |
POSTPROCESSING | ||

— Depth Measurements

Filtering: I
| |
IVA-Scan Recovery

|

ESC
To interrupt selection of reference of A-Scan right mouse click or press L) on front panel keyboard

or on external keyboard

. . . . . >
To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on .
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Upon completing redefining of Region Of Interest click on — this applies new Off-line Gate to all
A-Scans captured during t-ABIScan / ABIScan recording and updates t-ABIScan / ABIScan image
accordingly — only segment of t-ABIScan / ABIScan image covered by newly adjusted Off-line Gate
remains visible: in the present example there was under surface crack detected using full skip
insonification and Off-line Gate was readjusted by such a way that only full skip segment of t-ABIScan /
ABIScan image remained visible — this allowed to eliminate disturbing presence of initial pulse
reverberations on the t-ABIScan / ABIScan image

| File v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|
g o
=
R T . il =
— Length Measurements
t-ABIScan |
POSTPROCESSING | |
— Depth Measurements
Filtering: I
| |
’—A—Scan Recovery [%
|

It is possible then to perform A-Scan signals evaluation using newly adjusted Off-Line Gate through A-
Scan Recovery >ON

| File: v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|

—Length Measurements

t-ABIScan |
POSTPROCESSING | ||

— Depth Measurements

" Filtering: —‘ I
A-Scan Recovery t=3.8mm a = 36.2mm
ﬁ L =-55.2 mm

H=126% AVC=6.0dB
e Edit=>ROI2>OFF (angle beam inspection record) — negates Off-line Gate re-adjustment and returns to
originally recorded t-ABIScan / ABIScan image and initial Off-line Gate setting

N

I S et S I
!
)

SR R R T
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Edit>Filtering>ON — (straight beam and angle beam inspection records) generates amplitude palette
bar with sliding cursor, which may be controlled using either touch screen stylus or mouse or ' -/, f

on front panel keyboard or , on external keyboard . Position of the sliding cursor on the amplitude
palette bar determines filtering level, which is indicated in the Filtering field. All elements of t-ABIScan /
ABIScan image representing signal amplitude below filtering level are suppressed:

| File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

-50
|

— Length Measurements E

t-ABIScan |
POSTPROCESSING | | | |

—Depth Measurements

Filtering: I
ﬁ 6.6dB
| |
IVA-Scan Recovery
|

Edit>Filtering>OFF (straight beam and angle beam inspection records) — returns to originally
recorded t-ABIScan / ABIScan image and empties Filtering field
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e Edit>Normalize to DAC->ON (straight beam and angle beam inspection records) — applies DAC/DGS
normalized color palette to t-ABIScan / ABIScan image, which was recorded with active DAC/DGS and
redraws t-ABIScan / ABIScan image correspondingly (dB to DAC/DGS normalization)

| File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
Change Gain 4
ROI 4
Filtering 4

Momalize to DAC M
= [F|

t-ABIScan
POSTPROCESSING

— Length Measurements

+

|' Filtering: —‘
A-S5can Recoverp
ﬁ L="57.2mm

—Depth Measurements

t=4.5mm
b6

H=

a=355mm

AVC=856dB

3,
T+ o+ N+t + 4
i \
++I+++4.
i + o+ o+ 4+
+ +f+ + + A+ o+
!

| File v|| Wigw v|| Edit v|| Measurements v|| A-Scan Recavery v|

Lo

— Length Measzurements

t-ABIScan |
POSTPROCESSING | | | |

— Depth Meazurements

Filtering:
[ '
| |
A-S5can Recoverp
|_| L=-57.2mm

e Edit=>Normalize to DAC->OFF (straight beam and angle beam inspection records) — negates dB to
DAC/DGS normalization and returns to originally recorded t-ABIScan / ABIScan image

®

Applying of Edit->Normalize to DAC->ON or Edit->Normalize to DAC->OFF negates Filtering
(Edit>Filtering>OFF)

N,
T+ + W+ o+ o+ o+
15 \
',

',

t=4.5mm a=355mm

H=166% AVC=38.6 dB
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Measurements=>Length->ON — generates first vertical cursor that may be guided over t-ABIScan /

ABIScan image using either touch screen stylus or mouse or ?/ « on front panel keyboard or ,

on external keyboard . Coordinate of the first vertical cursor along t-ABIScan / ABIScan image (Lr)

is indicated in the Length Measurements field. To fix position of the first vertical cursor left mouse click
Ente‘r

or release touch screen stylus or press + J on front panel keyboard or [Enter|on external keyboard .

To interrupt vertical cursor manipulations and empty Length Measurements field right mouse click or

ESC
press L) on front panel keyboard or on external keyboard
Second vertical cursor appears upon fixing first one, it may be manipulated by the same way. Coordinate
of the second vertical cursor along t-ABIScan / ABIScan image (Lg) is indicated in the Length
Measurements field along with parameter W = Lg — Lr. Parameter W represents projection length of
defect provided that vertical cursors are placed appropriately
Measurements=2>Length->OFF — erases vertical cursors and empties Length Measurements field
Measurements>Depth>ON — generates first horizontal cursor that may be guided over t-ABIScan /

Y |

ABIScan image using either touch screen or mouse or =/, _T_ / on front panel keyboard or , on

external keyboard . Coordinate of the first horizontal cursor along t-ABIScan / ABIScan image (Dr) is
indicated in the Depth Measurements field. To fix position of the first horizontal cursor left mouse click

"
Enter

or release touch screen stylus or press *=_/ on front panel keyboard or [Enter| on external keyboard .
To interrupt horizontal cursor manipulations and empty Depth Measurements field right mouse click or

ESC
press L) on front panel keyboard or on external keyboard
Second horizontal cursor appears upon fixing first one, it may be manipulated by the same way.
Coordinate of the second horizontal cursor along t-ABIScan / ABIScan image (Dg) is indicated in the

Depth Measurements field along with parameter H = Dg — Dr. Parameter H represents thickness
loss provided that horizontal cursors are placed appropriately

Measurements>Depth->OFF — erases horizontal cursors and empties Depth Measurements field

| File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

o
n
[=]

— Length Measurements

t-ABIScan [ w-z25mm
POSTPROCESSING | | [Li=-173mm [Lg=206mm

—Depth Measurements

|'Fi|lering: —‘ I H=4mm

I | Dr=0mm | Dg=4mm
A-Scan Recovery t=45mm a=355mm
{I L = 57.2 mm H=166% AVC-=8.6dB
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6.5. TOFD Inspection — RF B-Scan and D-Scan Imaging and
Recording —t-TOFD or TOFD

6.5.1. Setup Pulser Receiver for t-TOFD and TOFD

UDS 3-5 Pulser Receiver window — main operating surface — appears on ISONIC 2007 screen upon

o l [3]t-ToFD ‘ l [3]ToFD ‘ . . .
clicking on or . The following settings to be provided:
# | Parameter or Submenu Required Settings Note
Mode
1 Pulser Mode PULSER Dual
2 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing Level, To synchronize with Gain
Firing Level, and Damping settings to provide setting procedure
Damping optimal signal to noise ratio
3 Filter, Frequency RECEIVER Filter and Frequency settings to match | To synchronize with Gain
with probe's frequency setting procedure
4 Display RECEIVER RF
5 USVelocity BASIC USVelocity setting to be equal to actual
value of ultrasound velocity in the object
under test
6 Probe Delay MEASURE Probe Delay setting to be equal to Accumulated Probe Pair
actual Accumulated Probe Pair Delay may be determined
Delay according to paragraph
6.5.1.1 of this Operating
Manual
7 Display Delay BASICS Display Delay and Range to provide Display Delay and Range
Range clear A-Scan representing: will be determined
o0 Lateral Wave and Longitudinal according to paragraph
Wave Back Echo Signals at the 6.5.1.2 of this Operating
beginning and at the and of A-Scan | Manual
correspondingly
OR
o Lateral Wave, Longitudinal Wave
Back Echo, and Mode Conversion
Back Echo at the beginning, middle,
and at the end of A-Scan
correspondingly
OR
o0 Other combination of signals
required by Inspection procedure
8 Gain BASICS Gain setting to be performed according Refer to paragraph 6.5.1.3
to inspection procedure providing of this Operating Manual
required amplitude of signals from
defects to be detected
9 | Settings for other

parameters and
modes have no
significance

I
Click on _| or press LJ on front panel keyboard or on external keyboard upon completing

ISONIC 2007 from Sonotron NDT - Operating Manual — Revision 1.14 - Page 181 of 320




6.5.1.1. Accumulated Probe Pair Delay

Two probes to be used in order to capture the TOFD Map. The Probe Delay to be precisely measured for
each of them.

Measuring Probe Delay - Miniature Probes (contact face width 12.5 mm / 0.5 in or less) — Pulse Echo
Technique

" Longitudinal Wave Echo Activate submenu PULSER then set:
+ + + + +

Q Pulser Mode to Single

O Pulse Width to Spike (240 pJ) for probe
having resonant frequency of 8 MHz and
higher or to PW ns, were PW =0.5/F (F
is the probe resonant frequency) for
probes having resonant frequency below 8
MHz

Q Firing Level to 18

a Damping to 1000 Q

Q Tuning to NO

Activate submenu RECEIVER then set:

a Display to Full or RF

Q Filterto BB

Q Frequency to completely cover probe's
effective bandwidth

Activate submenu BASICS topic then set:

o US Velocity to 5920 m/s (233.1 in/ms)

O Rangeto50.0 mm (2in)

a Display Delay to 0 ps

O Reject to 0%

Stage 1. Manipulate probe over main working
surface of V-2 reference standard and maximize
echo from 25 mm (1 in) radius concave reflector

Stage 2: Fix probe in found position - the center of
25 mm (1 in) radius concave reflector will indicate
incident point while the distance between probe's
frontal edge and incident point is equal to X-
Value

Incidence
Foint

Stage 3: Tune Display Delay while probe is still
fixed in found position until rising edge of
maximized echo will match with 50%-grid of the A-
Scan width. Upon completing the obtained value
of Display Delay will be equal to actual Probe
Delay

It's necessary to setup Gain bringing height of maximized echo to 75-80% of A-Scan height

e

It is recommended to optimize Tuning in PULSER submenu upon obtaining maximized echo. The goal of
such optimization is increasing of ultrasonic excitation energy through better matching between firing
output and probe. Level of ultrasonic excitation energy is clearly represented by echo amplitude. Upon
completing Tuning optimization Gain to be adjusted to bring echo to 75-80% of A-Scan height

Supposing that Probe Delay values found for probes of the pair are PD1 and PD»
Accumulated Probe Pair Delay = 0.5¢(PD; + PD>)
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Measuring Probe Delay - Large and Medium Size Probes (contact face width more than 12.5 mm /0.5
in) — Pulse Echo Technique

N N N N N Activate submenu PULSER then set:
Longitudinal Wawve Echo Q Pulser Mode

O Pulse Width to Spike (240 pJ) for probe
having resonant frequency of 8 MHz and
higher or to PW ns, were PW =0.5/F (F
is the probe resonant frequency) for
probes having resonant frequency below
8 MHz

O Firing Level to 18

0 Damping to 1000 Q

Q Tuning to NO

Activate submenu RECEIVER then set:

a Display to Full or RF
O Filterto BB
O Frequency to completely cover probe's
effective bandwidth
Activate submenu BASICS topic then set:
O US Velocity to 5920 m/s (233.1 in/ms)
0 Range to 200.0 mm (8in)
O Display Delay to O s
O Rejectto 0%

Stagel
— Incidence

o1t

Stage 1: Manipulate probe over main working
surface of V-1 reference standard and maximize
echo from 100 mm (4 in) radius concave reflector

Stage 2: Fix probe in found position - the center
of 100 mm (4 in) radius concave reflector will
indicate incident point while the distance
between probe's frontal edge and incident point
is equal to X-Value

Stage 3: Tune Display Delay while probe is still
fixed in found position until rising edge of
maximized echo will match with 50%-grid of the
A-Scan width. Upon completing the obtained
value of Display Delay will be equal to actual
Probe Delay

Incidence
Foint

*

It's necessary to setup Gain bringing height of maximized echo to 75-80% of A-Scan height

¢ Itis recommended to optimize Tuning in PULSER submenu upon obtaining maximized echo. The goal of
such optimization is increasing of ultrasonic excitation energy through better matching between firing
output and probe. Level of ultrasonic excitation energy is clearly represented by echo amplitude. Upon
completing Tuning optimization Gain to be adjusted to bring echo to 75-80% of A-Scan height

Supposing that Probe Delay values found for probes of the pair are PD1 and PD>

Accumulated Probe Pair Delay = 0.5¢(PD; + PD>)
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Direct Measurement of Accumulated Probe Pair Delay - All Sizes of Probes — Through Transmission

Technique

Prake 1

Prohe 2

Proke 1

Probe 2

Activate submenu PULSER then set:

O Pulser Mode to Dual
O Pulse Width to Spike (240 pJ) for probe
having resonant frequency of 8 MHz and
higher or to PW ns, were PW =0.5/F (F
is the probe resonant frequency) for
probes having resonant frequency below
8 MHz
O Firing Level to 18
0 Damping to 1000 Q
O Tuning to NO
Activate submenu RECEIVER then set:
o Display to RF
a Filter to BB
O Frequency to completely cover probe's
effective bandwidth
Activate submenu BASICS topic then set:
0 Display Delay to O us

Stage 1: Manipulate probes over each other and
setup of Gain, Range, and USVelocity providing
firm indication of the signal propagating in the
probes wedges from emitting to receiving crystal
then maximize said signal

Stage 2: Fix the probe in the found position
corresponding to highest signal amplitude

¢ It's necessary to setup Gain bringing height
of maximized echo to 75-80% of A-Scan
height

¢ Itis recommended to optimize Tuning in
PULSER submenu upon obtaining
maximized echo. The goal of such
optimization is increasing of ultrasonic
excitation energy through better matching
between firing output and probe. Level of
ultrasonic excitation energy is clearly
represented by echo amplitude. Upon
completing Tuning optimization Gain to be
adjusted to bring echo to 75-80% of A-
Scan height
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I Probe 1

Probe 2

Stage 3: Increase Gain to provide height of first
half wave of received signal reaching 20 % of total
A-Scan height

Stage 4: Decrease Range to provide ~ 50% of
| the A-Scan width occupied by the signal

Probe 2

Stage 5: Start increasing of Display Delay aiming
displacement of signal's start point to beginning of
A-Scan horizontal base

Stage 6: Stop Display Delay manipulation upon
reaching the target — at this moment value of
Display Delay will represent Accumulated Delay
of the Probes Pair

UDS3-5 - ISONMIC Pulzer/Receiver

BASICS PULSER RECEIVER GATE A Menu
GATE B ALARM DAC/TCG MEASURE Selection

] Value: OFF PRIPES | = | -
Cloze EM| Freeze Save | Open DG5S
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6.5.1.2. Display Delay and Range
Display Delay depends on Accumulated Probe Pair Delay, Probe Separation, and USVelocity:

Display Delay = Probe Delay + Probe Separation / USVelocity

whereas:

a

a

USVelocity is the actual value of longitudinal wave velocity in the material, of which the object
under test is made

Probe Separation is the distance between incidence points of the emitting and receiving TOFD probes
measured along the lateral wave trace:

Probe Separation

Emitting Receiving
Probe Frobe

-Lateral Wave

%————- Longitudinal Wave Back Echo

Probe Separation should be optimized according to Inspection procedure and probes positions in the TOFD
fixture to be fixed upon. Display Delay and Range to be adjusted then to provide representing of signals
according to Inspection procedure — the typical examples are given below for 40 mm thickness welded
plates.

UDS53-5 - ISONMIC Pulser/Receiver

0.5 Gain

715 dB
0.2 Range

= Ty

Mo By

pr
13.4 mm ‘
1 U5 Velocit
o0 mn R
0.01 Display Dela
W -
RBeject
Yl «

o By

4 By

ln By

PULSER RECEIVER GATE A Menu "Df ? - 5
ALARM DAC/TCG MEASURE Selection
H | & | & L
Save | Open | Frnt DG5S

y A

/
Lateral Wave Longitudinal Wave
Signal Back Echo
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UD53-5 - ISONMIC Pulser/Beceiver

Gain

715 dB

= Ty

Range

Ino Ry

36.8 mm

1 U5 Velocity ‘

5920 mfs

0.01 Display Delay
2? 84 ps ‘

Beject ‘

0 %

[FHEAN FULSER  RECEIVER  GATE A Menu "D" 2_5
GATE B ALARM DAC/TCE  MEASURE  Selection

I by

[ By

+

In by

Yalue: OFF i i = = =3 e
Close Alaim I \EIEEZE Save \Open| Fnnt DGS
N\ \
\ \ \
Signal Back Echo Wave Back Echo
6.5.1.3. Gain

Depending on Inspection procedure (Inspection specs) Gain may be setup with the reference to:

Representative flaw sample

Artificial diffractors in the form of EDM notches or V-shaped notches
Side drilled holes

Grain noise

Lateral wave signal amplitude

0Oo0O0O0oOo

For both examples above the typical procedure of Gain setting was provided through bringing height of
lateral wave signal to 30% of A-Scan height
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6.5.1.4. Probe Separation

Probe Separation must be properly defined and entered to have the ability of precise defects sizing at
posprocessing stage. Most widely used way of Probe Separation determining is mechanical measuring of
distance between TOFD probes excitation points by using a scaled ruler. However mechanical

measurements are not accurate and their implementation becomes quite complicate for objects with curved
surfaces:

E mittin Receivin R y
Frobe g Frobe g Eﬁﬁtﬁgﬂg Ef.gg;"g

| ateral Wave Trace

Lateral Wave ]"1".;7«::«3=

Probe Separation Probe Saparation

Emitting Reaceaiving
Probe Probe

Lateral Wave Trace

Probe Separation

Probe Separation may be defined more precisely through the way as below:

UDS53-5 - ISOMIC Pulser/Receiver

Gain

= by

-88_5 dB ‘
Bl +
T B
Mrd «

A_qle

Ina By

e By

:

»

= By

Itn By

BASICS PULSER  RECEIVER _ GATE A Menu i "D’l 2_5
GATE B ALARM  DAC/TCG JICTESHIGIEN Selection

| [~ T 2=z =
7 Eluse m»‘ 60. 25 mm Freeze & * Save | Open | Pont DG5S

O Increase Gain to provide height of first half wave of lateral wave signal reaching 10-20 % of total A-
Scan height

Activate Gate A, setup aThreshold to 5%(submenu GATE A)

Select s(A) as Meas Value and set Meas Mode as Flank (submenu MEASURE)

Provide rising edge of first half wave of lateral wave will cross Gate A

Define Probe Separation as Probe Separation = 2 x s(A) whereas s(A) is the digital readout taken

from box

7’
7

ODo0Oo
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6.5.2. t-TOFD and TOFD — Implementation
6.5.2.1. t-TOFD — Prior to Scanning

t-TOFD control panel is shown below

+

Current A-Scan |

+ + o+ + + o+ o+
0o |
e '-1..|_-.—-.|:n.._p..--1p—..4..-q._.-u._+-\1

|l

20.30 ps

+ 0+ o+ o+ o+ o+ o+

I

+ 4+
+

+
+
¥

li
i
+
+
+

S+ F ¥ ¥

+ o+
+ o+
+ o+

5 Length
220 mm
1 Time

10s
Time-'% ait

Scan Length not exceeding 400 mm or 16 in / Scan Time

<

35
5 Baze
120 mm
Averaging

OFF

Empty t-TOFD record field

x ok dk dk dk s

2 5 Jorn By | e Bag e B i Bg | 1= By

hdh dh 4h 4h 4

4 = o
Start Open Save $
L]
g | u] 50 100 150 200
UDS3-5 Text
(2]

+ +
+

+
20.20 ps

+ +

t-TOFD scrolling controls field

++++-;++++
]
+ o+ o+ o+ + o+ 4+
!
|
}
I
4
£

g
+ o+t T

20 Length -~
Eflle » _
T Time - Empty t-TOFD record field
«7®
Time-Wait r
«»
5 Base o
4
‘ ; ' Segment of Scrolled Total Scan Length
‘ 5 * < exceeding 400 mm or 16 in / Scan Tlme’
2 = = 3
Start Open Save g
b u] 5:3 '1DID 15ID 2DID 25ID SCIID 35IEI 400
ups3-5 Text Close [x
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Scan Length and Scan Time

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period. Time (Scan Time) is the duration of recording period

o

|Lu?. SRS

I+~ gy

len By

To control Length the following
manipulations are applicable:

e Mouse /Touch Screen
B Click on corresponding
o Keyboard

-
B Press 1 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J '_’J !J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in
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5 Lerigth
220 mm

Averaging

OFF

To control Time
the following manipulations are applicabIE}://

/4
e Mouse / Touch Screen V/4

B Click on corresponding
e Keyboard

'l
s Press LJ on front panel keyboard or on external keyboard = Time fore color changes to

white - then use !J _J _J ij on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !J '_’J !J !J on front panel
keyboard or , , on external keyboard

®

The value of Time is adjustable between 5 and 60 sec
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Time-Wait

Time-Wait is waiting time for intermissions predcessing t-TOFD recording, which starts unconditionally upon
Time-Wait period is over

5 Length ar
220 mm ‘ 1 »
1 Time o
10s ‘ 2 »
A AR AR AR . Time-W ait o
: Currentvalueof i 3s 3
] Time-Out - ~ 7
] sec : 1 »
tsssssssssEssssEEEEEEEEEEEE - =
Averaging ar
OFF 5 »
/7 7/
To control Time-Wait the following ’, 7
manipulations are applicable: //
/
e Mouse /Touch Screen /,/

— -
B Click on corresponding |button|

e Keyboard

?
B Press 3 on front panel keyboard or on external keyboard = Time-Wait fore color changes

to white - then use !_ ?/ « !' on front panel keyboard or , , , on external
keyboard

e Combined

LY

B Click on Time-Wait = Time-Wait fore color changes to white - then use —

2 & &
front panel keyboard or , , , on external keyboard

®

The value of Time-Wait is adjustable between 0 and 15 sec
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Base

Base represents Probe Separation

5 Length
220 mm

Time-' ait
35

b db 4

Averaging

|r.h},\|-ﬁ-l|. oo By f e By | (= By

A 4

To control Base the following
manipulations are applicable:

e Mouse /Touch Screen
B Click on corresponding
o Keyboard

-
B Press _4 J on front panel keyboard or on external keyboard — Base fore color changes to

white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Base = Base fore color changes to white - then use !J '_’J !J !J on front panel
keyboard or , , , on external keyboard

®

The value of Base is adjustable between 25 and 500 mm or 1 and 20 in
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Averaging
Averaging of sequential A-Scans is required sometimes to improve signal to noise ratio of the t-TOFD

record
5 Length
220 mm ‘
1 Time
10s ‘
B . _ _
:  Current setting of Time-¥ ait ‘
: Averaging i 35
] mm or in ] 5 Base
T rireresserrrrrserees P
‘ <

Averaging

OFF

To control Averaging the following
manipulations are applicable:

e Mouse / Touch Screen

B Click on corresponding

e Keyboard
F
B Press _3 _ on front panel keyboard or on external keyboard = Averaging fore color changes

to white - then use !_ ?/ « !' on front panel keyboard or , , , on external
keyboard

e Combined

LINCIAAIARS

B Click on Averaging = Averaging fore color changes to white - then use =/,
front panel keyboard or , , , on external keyboard

®

Averaging may be either inactive (OFF) or setup for factor 2 or 4 or 8

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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Start/Stop t-TOFD recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start t-TOFD recording

4 | u |
stait | putton becomes invisible since t-TOFD recording starts. __ 2P | putton occupies its position.

-
Click on 3P | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate t-TOFD recording prior to automatic completion

= A
stop | button becomes invisible after completion / termination of t-TOFD record. __ 3%t | putton returns

to its position

Save record into afile

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.5.2.2. t-TOFD — Scanning

a Apply probes pair to test object in the start point of selected scanning line

4 | |
O Click on 3%t |or press LLJ on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe pair over the scanning line synchronously with Position Icon moving with constant speed
above t-TOFD record field — typical scanning progress display during is shown and explained below

|
=]
™
o
™

20 Length
«

-
1
1 Time o
s
Time-W ait o
s KR
5 Baze o
| oonm [l
Averaging o
o R
1 = "
Open Save
u] a0 100 150 2I:IIEI
Text Cloze
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6.5.2.3. TOFD — Prior to Scanning

TOFD control panel is shown below

Current A-Scan
+ + + + + 4+

20.30 ps

+ o+ o+ 4+ o+ .
L wrapesrs e _rpeen| |
y!
+ o+ +
+ o+ +
+ o+ +
+ o+ +

20 Length

= By

220 mm

5 Basze
B e

i e

Scan Length not exceeding 400 mm or 16 in

M gy

A - <
YEraging o
E
Encoder:
I Drefault j ]
Empty TOFD record field
4 = = )
Start Open Save £
& | 1 i
’ 0 &0 100 150 200
UuDs53-5 Text Cloze

o+ o+ o+
20.30 ps

TOFD scrolling controls field

o+t o+ + E o+ o+ o+ o+
i
o+ o+ o+ F
-

S
++++-h-++++
.
PN - S S
1
R

20 Length
1540 mm ‘

5 Base
.

Averaging
.

Empty TOFD record field

oty |1y
adh b4

E der:
ID";:ulf' = Segment of Scrolled Total Scan Length
< exceeding 400 mm or 16in >
| 2 = =] g
Start Open Save 2
’ a a0 100 150 200 2a0 200 260 400
uDs3-h Text Close
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Scan Length

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period

20" Length
1540 mm

Averaging

OFF

To control Length the following
manipulations are applicable:

e Mouse /Touch Screen
B Click on corresponding

o Keyboard

-
B Press' 1 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J _J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J 2J :J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 20000 mm or 2 and 800 in
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Base

Base represents Probe Separation

20 Léngth
1540 mm

= By

=

[ l|“

To control Base the following
manipulations are applicable:

e Mouse /Touch Screen
B Click on corresponding

o Keyboard

-
B Press 2 J on front panel keyboard or on external keyboard = Base fore color changes to

white - then use !J 2J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Base = Base fore color changes to white - then use !J 2J :J !J on front panel
keyboard or , , , on external keyboard

®

The value of Base is adjustable between 25 and 500 mm or 1 and 20 in
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Averaging
Averaging of sequential A-Scans is required sometimes to improve signal to noise ratio of the TOFD record

AR AR A A A A A A A A anans . 20 Length
:  Current setting of & 1540 mm ‘ »
: :

Averaging
mm or in

Averaging

OFF

To control Averaging the following
manipulations are applicable:

e Mouse / Touch Screen

B Click on corresponding
e Keyboard
-

B Press 3 Jon front panel keyboard or on external keyboard = Averaging fore color changes
to white - then use !_ 2/, « ! on front panel keyboard or , , , on external
keyboard

e Combined
B Click on Averaging = Averaging fore color changes to white - then use !_ 2/, « , ! on

front panel keyboard or , , , on external keyboard

®

Averaging may be either inactive (OFF) or setup for factor 2 or 4 or 8

Encoder
Select encoder to be used through appropriate box

Encoder:

Drefault j

Clamp fixture holding TOFD probe pair into encoder — refer to Chapter 7 of this Operating Manual

Connect encoder to its input on the rear panel of ISONIC 2007 instrument

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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Start/Stop TOFD recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start TOFD recording

4 | H |
stait | hutton becomes invisible since TOFD recording starts. __ 3B | putton occupies its position. Click

-
on _ 3P | or press _J on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate TOFD recording

N EA
atep | button becomes invisible after termination of TOFD record. __2tait | button returns to its position

Save record into afile

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.5.2.4. TOFD — Scanning

a Apply probes pair to test object in the start point of selected scanning line

4 |
O Click on 3%t |or press Ll) on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe pair over the scanning line — typical scanning progress display during is shown and
explained below

20 Length o
1540 mm 1
5 Base o
120 mm ‘ 2
Averaging o
OFF ‘ 3
Encoder:
IDefauIt j
[ =
Open Save
UD53-5 Text Close
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6.5.2.5. t-TOFD / TOFD — Postprocessing
Versatile postprocessing of t-TOFD / TOFD records is featured with:

O Improvement of near to surface resolution through removal of lateral wave and back echo records
from t-TOFD / TOFD Map, zooming t-TOFD / TOFD Map accompanied with appropriate A-Scan
expanding

O Linearization and straightening of t-TOFD / TOFD Map

O Increasing contrast of t-TOFD / TOFD images through varying Gain and rectification

O Defects pattern recognition and sizing

The screen as below appears upon opening file. All postprocessing procedures are performed through
Imenu baFl — touch screen stylus or front panel or external mouse to be used

—
*File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-5can Recavery v|

t-TOFD
POSTPROCESSING

Menu Bar Functions

e File>Open — opens new t-TOFD / TOFD file

e File>Snapshots=>Add Snapshot — stores current postprocessing screen snapshot accompanied with
appropriate settings and measurements into postprocessing session memory stack

e File>Snapshots>Restore Snapshot — recalls earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

¢ File>Snapshots>Delete Snapshot — deletes earlier stored postprocessing screen snapshot
accompanied with appropriate settings and measurements from postprocessing session memory stack

¢ File=>Print — prints out postprocessing screen snapshot(s) accompanied with appropriate settings and
measurements

e File>Exit — returns to t-TOFD / TOFD control panel

o View=2>Instrument — indicates setup of UDS 3-5 Pulser Receiver used for scanning when file was
created

e View—2>Inspection Data — indicates operator's comments entered prior to scanning

e View—>Coloring>Grayscale / View>Coloring=>Thermal — selects base color for t-TOFD / TOFD
image

e View>TOFD->Logic>Negative / View>TOFD->Logic2>Positive — selects black / white tones for

representation of positive/negative half waves components of RF A-Scan on the TOFD Map — refer also

to paragraph 9.2.2 of this Operating Manual

e View>TOFD—>Contrast>Natural / View>TOFD->Contrast->Soft / View>TOFD->Contrast->Sharp

— selects contrast of the TOFD Map — refer also to paragraph 9.2.2 of this Operating Manual
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A-Scan Recovery=>ON - generates cursor corresponding to A-Scan base line that may be guided over

t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J !J on front panel keyboard
or , on external keyboard — corresponding A-Scan is recovered synchronously according to A-

Scan base line cursor position. Indication of starting position of cursor (L) corresponding to the position
of TOFD probes pair accompanies recovered A-Scan

File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

L=73.7 mm

t-TOFD
POSTPROCESSING

To fix position of A-Scan base line cursor with corresponding recovered A-Scan left mouse click or
Erlte.r
release touch screen stylus or press .“ij on front panel keyboard or Enter|on external keyboard

ESC
To interrupt recovery of A-Scans right mouse click or press \L) on front panel keyboard or on
external keyboard

A-Scan Recovery=>OFF - erases A-Scan base line cursor, indicator of its position, and recovered A-
Scan
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View—>Coloring2>Rectified — switches between rectified and RF presentation of t-TOFD / TOFD image

File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

Colaring m Grayzcale

Zoam ¥ Themnal

Inspection Data
R

Instrument

oL _——

POSTPROCESSING 50 100 150 200 280

File v|| Wig v|| Farameters v|| Edit v|| Measurements v|| A-Scan Recovery

L=737 mm

22.09 ps

t-TOFD
POSTPROCESSING

ISONIC 2007 from Sonotron NDT - Operating Manual — Revision 1.14 - Page 205 of 320




e View>Zoom->Zoom Factor% — expands t-TOFD / TOFD image along time line (vertically)

File v|| Wigw v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recoverny v|

Calaring » |
Zoom =100%
Inspection Data 200%
Instrumnent

t-TOFD
POSTPROCESSING 0 50 100 150 200 250 300 350
File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -
L=2781 mm

t-TOFD
POSTPROCESSING

Expanded t-TOFD / TOFD image may be scrolled it vertically using appropriate
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Green background highlights segment of recovered A-Scan corresponding to visible part of t-TOFD /
TOFD image. Said segment moves over recovered A-Scan background while scrolling t-TOFD / TOFD

image vertically

File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|
L=2781 mm
Start of visible
part of t-TOFD /
TOFD image

F — — — — —
End of visible part
of t-TOFD / TOFD

I image |

t-TOFD .
POSTPROCESSING | ° s a0 e

P —
200 250 200 250

Segment of recovered A-Scan corresponding to visible part of t-TOFD / TOFD image may be expanded
through double click on it — whole A-Scan background is green for the expanded segment. Vertical
scrolling of t-TOFD / TOFD image causes appropriate varying of Display Delay for recovered A-Scan
File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

L=2781 mm

Start of visible :
part of t-TOFD /

I TOFD image |

e S U —

F — — — — —
End of visible part
of t-TOFD / TOFD

I image |

t-TOFD
POSTPROCESSING | ° s

150

To return to complete recovered A-Scan visibility double click on A-Scan area

®

¢ Zoom function is available for t-TOFD / TOFD image composed of A-Scans longer

than 5 us
¢ Possible zoom factors are defined by ISONIC 2007 software automatically

¢ Maximal possible Zoom factor is 400%
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e Parameters>Change... — allows re-adjusting of basic parameters (USVelocity, Base, Probe Delay)
for computation of defects depth and linearization of t-TOFD / TOFD image

File v|| Wigw v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recoverny v|

L = 23| Change..
Mark Zero

t-TOFD
POSTPROCESSING

File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -
L=2781 mm

US Yelocity, mis

1
5020 Ol

Base, mm

1
131 Ol

Probe Delay, ps 0.01

r—
592 ﬂ
ok |

t-TOFD
POSTPROCESSING

| Erlte.r
On completing click LI or press :J on front panel keyboard or [Enter| on external

keyboard

To negate re-adjustments click on ﬂl or press \L) on front panel keyboard or on

external keyboard
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Parameters>Mark Zero Line — allows re-adjusting of Probe Delay for computation of defects depth
and linearization of t-TOFD / TOFD image through mark of start point of lateral wave signal on the
recorded t-TOFD / TOFD image with reference to recovered A-Scan. Initially this function generates
cursor corresponding to A-Scan base line that may be guided over t-TOFD / TOFD image using either

touch screen stylus or mouse or '_’J , !J on front panel keyboard or , on external keyboard —
corresponding A-Scan is recovered synchronously according to A-Scan base line cursor position

File =|| “iew =[| Parameters «|| Edit = | Measurements v|| A-Scan Recovery v|

Upon selecting reference A-
Scan with clear lateral wave
left mouse click or press
| Erlte.r

= J on front panel
keyboard or on
external keyboard — this
generates horizontal cursor,
which may be be guided over

t-TOFD / TOFD image using
either touch screen stylus or

mouse or !J !Jon front

panel keyboard or , on
external keyboard

t-TOFD
POSTPROCESSING

o

a0 100 180 200 2480 =00 260

File =|| “iew =[| Parameters «|| Edit = | Measurements v|| A-Scan Recovery -

To mark the beginning of

lateral wave signal

corresponding to zero depth

left mouse click or press
Erlte.r

- *==4 J on front panel

keyboard or on

external keyboard

22.04 ps

To interrupt function at any
moment right mouse click or

ESC
press \Q on front panel

keyboard or on
external keyboard

t-TOFD
POSTPROCESSING

2515 ps

=1

S0 100 150 200 250 200 250
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o Edit>Linearization=>0ON - recalculates depth for each point of t-TOFD / TOFD image and redraws it
as Longitudinal Coordinate — Depth map

| File v|| Wiga v|| Farameters v|| E dit v|| I easurements v|| A-Scan Recovery v|

Linearization OW
= 0F|

Femove Lateral Wave »

Straightening 4
Change Gain 4

Flip Honzontal

2447 ps

t-TOFD

| File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recoverny v|

280 300 350

t-TOFD
POSTPROCESSING

o Edit>Linearization>OFF — returns to original t-TOFD / TOFD image - Longitudinal Coordinate —
Time map

ISONIC 2007 from Sonotron NDT - Operating Manual — Revision 1.14 - Page 210 of 320



Edit>Remove Lateral Wave>ON — removes rectangle segment designated by an operator from t-
TOFD / TOFD image. Most frequently this function is applied to lateral wave record, which is recorded
continuously during line scanning and allows to better resolve defects located closely to scanning
surface. Also this function may be applied to other signals continuously recorded during line scanning for
example, backwall echo, mode conversion backwall echo, etc. - this allows to better resolve defects
located closely to bottom surface. In addition to modifying of rectangle segment selected by an operator
this function automatically straightens t-TOFD / TOFD image in order to compensate deviations caused
by various factors during recording, for example, coupling instability, unevenness of scanning or bottom
surface, etc. The described function is based on selecting reference signal and defining a rectangle
segment on the t-TOFD / TOFD image. All signals corresponding to selected rectangle segment of t-
TOFD / TOFD image are equalized by straightening function and then removed; appropriate changes do
occur on t-TOFD / TOFD image above and under selected rectangle segment after its removal. Initially
cursor corresponding to A-Scan base line is generated; it may be guided over t-TOFD / TOFD image

using either touch screen stylus or mouse or '_’J :J on front panel keyboard or , on external
keyboard — corresponding A-Scan is recovered synchronously according to A-Scan base line cursor

E rlte.r

position. To select reference A-Scan left mouse click or release touch screen stylus or press - *=_ on
front panel keyboard or [Enter| on external keyboard

| File: v|| Wiew v|| Parameters v|| E dit v|| Measurements v| A-Scan Recovery v|

Linearization L4

| Remove Lateral Wave | 0N
Straightening F mOFF
Change G ain L4

Flip Horizontal

File =|| “iew =|| Parameters «|| Edit - | Measurements v|| A-Scan Recovery -

2204 ps

t-TOFD
POSTPROCESSII

2515 ps

t-TOFD
posTPn ocessl " G o a0 100 150 200 280 300 350
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First horizontal cursor appears on the t-TOFD / TOFD image upon selecting reference A-Scan. It may

be guided over t-TOFD / TOFD image using either touch screen stylus or mouse or !J !J on front
panel keyboard or , on external keyboard . To fix position of the first horizontal cursor and designate

L
Enter
start of reference signal left mouse click or release touch screen stylus or press _‘ij on front panel
keyboard or [Enter|on external keyboard . Second horizontal cursor appears upon fixing first one; it may
be manipulated by the same way and allows designating end of reference signal
View «|| Parameters - | Measurements 'H &-Scan Recovery v‘

View ~|| Parameters ~ | Measurements ][ A-5can Recovery ~

t-TOFD
POSTPROCESSIN

t-TOFD
POSTPROCESSING

®

Horizontal cursors are accompanied with appropriate time cursors moving over reference A-
Scan
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First vertical cursor appears upon designating end of reference signal. Its length corresponds to duration
of reference signal and it is located between first and second horizontal cursors. First vertical cursor may

be manipulated over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J - on
front panel keyboard or , on external keyboard . To designate first border of rectangle segment

| Erlte.r
left mouse click or release touch screen stylus or press ij on front panel keyboard or [Enter|on
external keyboard . Second vertical cursor completing defining a rectangle appears upon fixing first one;
it may be manipulated by the same way and allows to designate second border of rectangle segment

View «|| Parameters - | Measurements 'H &-Scan Recovery v‘

Wiew =[] Parameters - ‘ Measurements 'H A:5can Recovery -
u

t-TOFD
POSTPROCESSII

t-TOFD
POSTPROCESSING
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As a result:
0 Signs of reference signal and corresponding signals in the selected rectangle segment are
removed from t-TOFD / TOFD image
o t-TOFD /TOFD image is straightened above and under selected and modified rectangle
segment to compensate deviations caused by various factors during recording, for example,
coupling instability, unevenness of scanning or bottom surfaces, etc

| File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

t-TOFD
POSTPROCESSING

—
To interrupt function at any moment right mouse click or press m on front panel keyboard or
on external keyboard

Edit>Remove Lateral Wave->OFF — negates madification of selected rectangle segment of t-TOFD /
TOFD image
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Edit->Straightening=>ON - straightens t-TOFD / TOFD image in order to compensate deviations
caused by various factors during recording, for example, coupling instability, unevenness of scanning or
bottom surfaces, etc. It is based on selecting reference signal (either lateral wave, or backwall echo, or
mode conversion backwall echo, etc) and defining a rectangle segment on the t-TOFD / TOFD image.
All signals corresponding to selected rectangle segment of t-TOFD / TOFD image are equalized by
straightening function and appropriate changes do occur on t-TOFD / TOFD image above and under
modified rectangle segment. Initially cursor corresponding to A-Scan base line is generated; it may be

guided over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J !J on front

panel keyboard or , on external keyboard — corresponding A-Scan is recovered synchronously
according to A-Scan base line cursor position. To select reference A-Scan left mouse click or release

Erlte.r
touch screen stylus or press _‘ij on front panel keyboard or [Enter| on external keyboard

| File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v| A-Scan Recovery v|

Linearization L4

Remove Lateral Wave #

Straightening ]
Change Gain LA R
Flip Horizontal

File =|| “iew -|| Parameters =f| Edit = | M easurements Y|| A-Scan Recovery -

2204 ps

t-TOFD
POSTPROCESSII

t-TOFD
PosTP“o CESSING o a0 100 150 200 280 300 350

2515 ps
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First horizontal cursor appears on the t-TOFD / TOFD image upon selecting reference A-Scan. It may

be guided over t-TOFD / TOFD image using either touch screen stylus or mouse or y !J on front
panel keyboard or , on external keyboard . To fix position of the first horizontal cursor and designate

L
Enter
start of reference signal left mouse click or release touch screen stylus or press :J on front panel

keyboard or [Enter|on external keyboard . Second horizontal cursor appears upon fixing first one; it may
be manipulated by the same way and allows to desighate end of reference signal

| File: v|| Wiew v|| Farameters v|| Edit v|| Meazurements v|| A-Scan Recoverny v|

File =|| Yiew =|| Parameters =[| Edit = | Measurements v|| A-Scan Recovery -

2204 ps

t-TOFD
POSTPROCESSI!

2515 ps

t-TOFD
POSTPROCESSING

a0 100 150 200 280 300 350

o
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First vertical cursor appears upon designating end of reference signal. Its length corresponds to duration
of reference signal and it is located between first and second horizontal cursors. First vertical cursor may
be manipulated over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J - on
front panel keyboard or , on external keyboard . To designate first border of rectangle segment

| Erlte.r
left mouse click or release touch screen stylus or press ij on front panel keyboard or [Enter|on

external keyboard . Second vertical cursor completing defining a rectangle appears upon fixing first one;
it may be manipulated by the same way and allows to designate second border of rectangle segment

| File: v|| Wiew v|| Farameters v|| Edit v|| Meazurements v|| A-Scan Recoverny v|

File =|| “iew =[| Parameters =|| Edit - | Measurements v|| A-Scan Recovery -

22.09 ps

t-TOFD
POSTPROCESSIP

2515 ps

t-TOFD
POSTPROCESSING

50 luls} 150 200 250 00 FE0

=1
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As aresult t-TOFD / TOFD image is straightened in, above, and under selected rectangle segment to
compensate deviations caused by various factors during recording, for example, coupling instability,
unevenness of scanning or bottom surfaces, etc

| File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -

t-TOFD
POSTPROCESSING

Esc
To interrupt function at any moment right mouse click or press m on front panel keyboard or
on external keyboard

Edit->Straightening>OFF — negates modification of selected rectangle segment of t-TOFD / TOFD
image
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Edit>Change Gain=>0ON — generates cursor corresponding to A-Scan base line that may be guided

over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J !J on front panel

keyboard or , on external keyboard — corresponding A-Scan is recovered synchronously
according to A-Scan base line cursor position. To select reference A-Scan release touch screen stylus

| Erlte.r
or left mouse click or press ' *=1_ on front panel keyboard or on external keyboard — this
generates subwindow allowing off-line re-adjusting of Gain for all A-Scans captured during t-TOFD /

ﬂ
TOFD recording in £6dB range with £0.1 dB increments through clicking or pressing and holding on ‘
or pressing !J !J on front panel keyboard or , on external keyboard

Filz v|| Wigw v|| Parameters v|| E dit v|| M easurements v|| A-Scan Recovery v|
L=1272 mm

ISONIC 2005

Select Gain Change:

“ioswe

OK Cancel |
L&

File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -

L=1272 mm

t-TOFD
POSTPROCESSII

s

t-TOFD
POSTPROCESSING o 50 100 150 200 250 300 350

During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain

DK | Erlte.r
click on or press ij on front panel keyboard or on external keyboard — this

applies new Gain value to all captured A-Scans and redraws t-TOFD / TOFD image accordingly
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Cancel ﬂ esc !
To interrupt re-adjusting of Gain click on 4' or press ¥ _J on front panel keyboard or

on external keyboard

Edit>Change Gain>OFF — negates Gain re-adjustment and returns to originally recorded t-TOFD /
TOFD image and original Gain setting

Edit=>Flip Horizontal — reorders A-Scans captured during t-TOFD / TOFD recording in reverse
succession and redraws t-TOFD / TOFD image accordingly. This service function may be useful for
merging scans of neighboring sections of an object, which were scanned in opposite direction due to
access conditions, etc

| File v|| Wiew v|| Parameters v|| E dit v|| Measurements v| A-Scan Recovery v|

Linearization L4
Remove Lateral Wave ¥
Straightening 4
Change Gain »
Flip Horizon

3447 ps

t-TOFD
posrpnocessl "G o S0 100 180 200 2560 200 280

| File: v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery v|

t-TOFD
POSTPROCESSING

®

Applying of Flip Horizontal function empties postprocessing session memory stack
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Measurements>Add Measure>Height — generates cursor corresponding to A-Scan base line that

may be guided over t-TOFD / TOFD image using either touch screen stylus or mouse or '_’J :J on
front panel keyboard or , on external keyboard — corresponding A-Scan is recovered
synchronously according to A-Scan base line cursor position. Indication of starting position of cursor (L)
corresponding to the position of TOFD probes pair accompanies recovered A-Scan. A-Scan base line
cursor to be positioned over defect image to minimize displacement of defect's signal with regard to
starting point of A-Scan. To fix position of A-Scan base line cursor release touch screen stylus or left

| Erlte.r
mouse click or press ' *=_J on front panel keyboard or on external keyboard . Indication of
starting position of cursor (L) corresponding to probe's center accompanies recovered A-Scan

| File v|| Wiga v|| Farameters v|| E dit v|| M easurements v|| A-Scan Recovery v|
Add Measure Length

Clear Lazt Heig
Clear Al

22.09 ps

File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recovery -

L=119.3 mm

t-TOFD
POSTPROCESSII

t-TOFD
POSTPROCESSING

50 400 150 200 250 200 250

=]
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First horizontal cursor appears upon fixing A-Scan base line cursor, it may be guided over t-TOFD /

TOFD image using either touch screen stylus or mouse or y !J on front panel keyboard or , on
external keyboard . First horizontal cursor is accompanied with first time cursor synchronously moving

over reference A-Scan. Coordinate of the first horizontal cursor - depth (H) and corresponding time of
flight (t) are indicated synchronously. To fix position of the first horizontal cursor left mouse click or

Erlte.r
release touch screen stylus or press :J on front panel keyboard or on external keyboard .
Second horizontal cursor appears upon fixing first one, it may be manipulated by the same way. Second
horizontal cursor is accompanied with second time cursor synchronously moving over reference A-
Scan. Coordinate of the second horizontal cursor measured relatively to position of first horizontal cursor

(dH) and corresponding delay of second time cursor relatively to first time cursor (dt) are indicated
synchronously. Provided the horizontal cursors are placed properly:

o H represents defect depth

o t represents time of flight for first diffracted signal

o dH represents defect's height

o dt represents delay of second diffracted signal relatively first diffracted signal

Filz v|| Wigw v|| Parameters v|| E dit v|| M easurements v|| A-Scan Recovery v|
L=119.3 mm
H =199 mm

2204 ps

t- 23.0 |Is

| File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-Scan Recavery -
L=119.3 mm

H=199 mm | dH=4.1 mm

t=23.0 s dt=0.4ps

22.04 ps

t-TOFD
POSTPROCESSIE

t-TOFD
POSTPROCESSING o 50 100 150 200 250 200 250

28.26 ps

ESC
To interrupt width measurement procedure at any moment right mouse click or press @ on front
panel keyboard or on external keyboard
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Vertical |[depth/height measurement mark| appears on the t-TOFD / TOFD image upon fixing position of

second horizontal cursor \
| File v|| Wig v|| Parameters v|| E dit v|| Mea&ements v|| A-Scan Recovery v|

File =|| “iew =|| Parameters «|| Edit = | Measurements v|| A-Scan Recovery -

Point 1:
L=119.3 mm
— =23.04 5, dt=0.44 is
t-TOFD H=19.9 mm, dH=4.1 mm

POSTPROCESSII

t-TOFD
POSTPROCESSING o Y 100 150 200 250 300 350

Depth measurement results may be recalled into accompanied with corresponding A-Scan
through double click on the depth measurement mark

In the subwindow appearing:
o L is coordinate of depth measurement mark along scanning line
o H represents defect depth
o 1 represents time of flight for first diffracted signal
o dH represents defect's height
o dt represents delay of second diffracted signal relatively first diffracted signal

Clicking on = will print current screen snapshot accompanied with depth measurement mark data

Clicking on v will hide subwindow with depth measurement mark data

Clicking on X will hide subwindow with depth measurement mark data and erase corresponding
depth measurement mark
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Measurements>Add Measure>Length — generates left parabolic cursor that may be guided over t-

e using either touch screen stylus or mouse or !J ij '_’J !J on front panel

TOFD / TOFD imag

keyboard or , , , on external keyboard . A-Scan, corresponding to coordinate (L) of tip of left
parabolic cursor along scanning line is recovered synchronously. Left parabolic cursor to be placed over
left defect's end providing shape matching. To fix position of left parabolic cursor left mouse click or

| Erlte.r
release touch screen stylus or press ij on front panel keyboard or [Enter| on external keyboard

| File v|| Wig v|| Parameters v|| E dit v|| M easurements v|| A-Scan Recovery v|

| Add Measure | Length
Height

Clear Last
i| Clear Al

File v|| Wiew v|| Parameters v|| Edit v|| Meazurements v|| A-Scan Recovery v|
L=106.1 mm |

t-TOFD
POSTPROCESSII

t-TOFD
POSTPROCESSING

50 400 150 200 250 200 250

=]
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Right parabolic cursor appears upon fixing left parabolic cursor. It may be manipulated by the same way
and must be placed over right defect's end providing shape matching. Coordinate of right parabolic
cursor along t-TOFD / TOFD image measured relatively to position of left parabolic cursor (dL) is
indicated synchronously, it represents length of defect area provided that both parabolic cursors are

placed properly

| File v|| Wigw v|| Parameters v|| Edit v|| Meazurements v|| A-Scan Fecovery v|

|[L=106.1 mm | dL=43.9 mm

22.04 p=

2826 p=

t-TOFD
POSTPROCESSING | © S

180 200 2a0 200 280

ESC
To interrupt length measurement procedure at any moment right mouse click or press m on front
panel keyboard or on external keyboard
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Horizontal {length measurement mark{ appears on t-TOFD / TOFD image upon fixing position of right
parabolic cursor
| File v|| Wi v|| Farameters v|| Edit v|| Measkments v|| A-Scan Recovery v|

22.04 ps

| File v|| Wiew v|| Parameters v|| Edit v|| Measurements v|| A-5can Recovery -

Point 2:
L=106.1 mm
dL=43.9 mm

t-TOFD
POSTPROCESSI!

S |

t-TOFD
POSTPROCESSING

Length measurement results may be recalled into through double click on the length
measurement mark
In the subwindow appearing:

o L is coordinate of left end of the length measurement mark

o dL is length of defect area covered by length measurement mark

o Hisdistance between scanning line and length measurement mark

Clicking on = will print current screen snapshot accompanied with length measurement mark data

Clicking on ¥ will hide subwindow with length measurement mark data

Clicking on x will hide subwindow with length measurement mark data and erase corresponding

length measurement mark

Measurements—=>Clear Last — erases last length or depth/height measurement mark placed on the t-t-
TOFD / TOFD image

Measurements—=>Clear All — erases all length and depth/height measurement marks placed on the t-
TOFD / TOFD image
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6.6. CB-Scan horizontal plane-view imaging and recording of
defects for shear, surface, and guided wave inspection — t-
FLOORMAP L or FLOORMAP L

6.6.1. Setup Pulser Receiver for t-FLOORMAP L and FLOORMAP L

UDS 3-5 Pulser Receiver window — main operating surface — appears on ISONIC 2007 screen upon

clicking on

l ZIt-Floorm apL

|L-Floormap L
or

‘. The settings as below to be provided

6.6.1.1. Angle Beam Inspection — Shear and Longitudinal Waves

# | Parameter or Submenu Required Settings Note
Mode
1 Gain BASICS Gain setting to be performed
according to inspection procedure
providing required echo heights
from defects to be detected
2 DAC/TCG DAC/TCG DAC/TCG settings to meet
requirements of inspection
procedure
3 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
4 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing To synchronize with Gain
Firing Level, Level, and Damping settings to setting procedure
Damping provide optimal signal to noise ratio
5 Filter, Frequency RECEIVER Filter and Frequency settings to To synchronize with Gain
match with probe's frequency setting procedure
6 Display RECEIVER Display setting may be either Full, | The same Display mode to be
RF, PosHalf, or NegHalf used for both Probe Delay
determining and t-FLOORMAP L
/ FLOORMAP L Recording
7 USVelocity BASICS USVelocity setting to be equal to
actual value of ultrasound velocity
in the object under test
8 Probe Delay MEASURE Probe Delay setting to be equal to | For shear wave / longitudinal
actual probe delay wave angle beam inspection
probe delay may be determined
according to paragraph 5.2.13.5,
5.2.13.6 or 5.2.13.8 of this
Operating Manual or similarly
9 Display Delay BASICS Display Delay setting to be equal Recommend
to actual probe delay Display Delay = Probe Delay
10 | Angle MEASURE Angle setting to be equal to actual
probe angle
11 | Settings for other

parameters and
modes have no
significance

I
Click on _| or press LJ on front panel keyboard or on external keyboard upon completing
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6.6.1.2. Guided, Surface, Creeping, and Head Wave Inspection

# | Parameter or Submenu Required Settings Note
Mode
1 Gain BASICS Gain setting to be performed For guided / surface / creeping /
according to inspection procedure head wave inspection Gain
providing required echo heights setting may be implemented
from defects to be detected according to paragraph 6.6.1.4
of this Operating Manual or
similarly
2 DAC/TCG DAC/TCG DAC/TCG settings to meet For guided / surface / creeping /
requirements of inspection head wave inspection DAC may
procedure be created according to
paragraph 6.6.1.4 of this
Operating Manual or similarly
3 Pulser Mode PULSER Dual for dual element probes
Single for single element probes
4 Tuning, Pulse Width, | PULSER Tuning, Pulse Width, Firing To synchronize with Gain
Firing Level, Level, and Damping settings to setting procedure
Damping provide optimal signal to noise ratio
5 Filter, Frequency RECEIVER Filter and Frequency settings to To synchronize with Gain
match with probe's frequency setting procedure
6 Display RECEIVER Display setting may be either Full, | The same Display mode to be
RF, PosHalf, or NegHalf used for both Probe Delay
determining and t-FLOORMAP L
/ FLOORMAP L Recording
7 USVelocity BASICS USVelocity setting to be equal to For guided / surface / creeping /
actual value of ultrasound velocity head wave inspection
in the object under test ultrasound velocity may be
determined according to
paragraph 6.6.1.3 of this
Operating Manual or similarly
8 Probe Delay MEASURE Probe Delay setting to be equal to | For guided / surface / creeping /
actual probe delay head wave inspection probe
delay may be determined
according to paragraph 6.6.1.3
of this Operating Manual or
similarly
9 Display Delay BASICS Display Delay setting to be equal Recommend
to actual probe delay Display Delay = Probe Delay
10 | Angle MEASURE 90°
11 | Settings for other

parameters and
modes have no
significance

I
Click on _| or press LJ on front panel keyboard or on external keyboard upon completing
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6.6.1.3. Determining Probe Delay and Ultrasound Velocity for Guided / Surface /
Creeping / Head Wave Inspection

The following procedure is recommended for finding Probe Delay and US Velocity settings necessary to
perform guided wave inspection:

(a)
(b)

(©

(d)
(e)

(®
(9)
(h)
(i)

)

==
= L)
I
L]
— Pos 2
300 mm
12in J—
600 mm
24in

In the UDS 3-5 Pulser Receiver window — submenu BASICS setup Range = 750 mm (or 30 in)

In the UDS 3-5 Pulser Receiver window — submenu BASICS setup US Velocity = 3000 m/s (or 120
in/ms)

Place guided wave probe into position Pos 1 on a reference plate providing 300 mm (or 12 in) distance
between probe's frontal surface and plate end

Tune Gain to provide plate end echo reaching 80-90% of A-Scan screen height

Tune Display Delay (submenu BASICS) to provide rising edge of plate end echo matching with 40%
grid on horizontal A-Scan screen scale

Place guided wave probe into position Pos 2 on a reference plate providing 600 mm (or 24 in) distance
between probe's frontal surface and plate end

Tune the US Velocity (submenu BASICS) to provide rising edge of plate end echo matching with 80%
grid on horizontal A-Scan screen scale

Place again guided wave probe into position Pos 1 on a reference plate providing 300 mm (or 12 in)
distance between probe's frontal surface and plate end

Repeat steps (e) through (h) as above until further tuning will not be necessary, i.e. placement of guided
wave probe into positions Pos 1 and Pos 2 causes rising edge of plate end echo appearing at 40% and
80% on horizontal A-Scan screen scale correspondingly. Since that Display Delay and US Velocity
settings are proper

In the submenu MEASURE provide Probe Delay = Display Delay whereas Display Delay value to be
found according to above steps (a) through (i)

®

O Probe Delay and US Velocity for surface / creeping / head wave inspection may be found similarly
O Automatic Calibration (AUTOCAL) procedure according to paragraph 5.2.13.8 of this Operating Manual

is also applicable
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6.6.1.4. Setting Gain and DAC for Guided / Surface / Creeping / Head Wave
Inspection
For setting up Gain and DAC a reference plate containing artificial defects is required; said reference plate

must have acoustical properties (longitudinal and shear wave propagation velocity, attenuation) thickness
and curvature differing from the same properties of the plate to be inspected in not more than +10%.

Gain setting to be performed through providing sure detection of artificial defect from selected distances
according to required inspection range
Optional DAC setting for guided wave inspection to be performed as below:

Place guided wave probe into position on reference plate providing receiving of an echo from a reflector

(a) Place guided wave probe into position on reference plate providing receiving of an echo from a reflector
passing minimal travel distance

(b) Follow instructions of paragraph 5.2.10 of this Operating Manual to record first DAC echo

(c) Move the probe away from the reflector keeping it's echo maximized for each new DAC echo recording
paragraph 5.2.10 of this Operating Manual
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6.6.2. t-FLOORMAP L and FLOORMAP L — Implementation

6.6.2.1. t-FLOORMAP L — Prior to Scanning

t-FLOORMAP L control panel is shown below

+

100
1

150 200
1 1

250
1

200
1

260
1

20 Length o
370 mm ‘ 1
1 Time o ) ) .
10 s 2 Scan Length not exceeding 400 mm or 16 in / Scan Time
Time-W ait o <
3
Coloring:
IF'seudn:n j
Empty t-FLOORMAP record field
4 = =
Start Open Save
E
X E
(]
uUpDs3-5 Text

+ o+ + + H o+ o+
+ o+ 4+ o+ S+
?+ L

3
[
F+ ot ot o+ K+ o+ o+ o+
B

P T I E
E 8 |

e

T
S

=
=
T
-
i
[4
S+ o+ o+ o+ A+ o+ 4

A+ o+ o+ H o+ o+ o+

13

+ R+ o+ o+

e

20 Length g
710 mm ‘ 1 *
1 Time a
10s ‘ 2 .
Time-W ait rF
3s ‘ 3 .
Colonng:
IPseudo j
> = =
Start Open Save
uUDs3-h Text Close

400.0 mm

0 mm

250 300 350 400
1 I 1

450

500
I

550
1

GO0
I

<

Empty t-FLOORMAP record field

Segment of Scrolled Total Scan Length
exceeding 400 mm or 16 in / Scan Time

t-FLOORMAP scrolling controls

>
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Scan Length and Scan Time

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period. Time (Scan Time) is the duration of recording period

20" Length

290 mm

Time-W ait

To control Length the following
manipulations are applicable:

e Mouse /Touch Screen
B Click on corresponding

o Keyboard

-
B Press 1 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J _J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J 2J :J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 1000 mm or 2 and 40 in
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20 Lehgth

290 mm

Time-w ait
B «

To control Time P // Ve
the following manipulations are applicable: , “»
7
v/
e Mouse /Touch Screen e’

B Click on corresponding
e Keyboard

'l
s Press LJ on front panel keyboard or on external keyboard = Time fore color changes to

white - then use !J _J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Time = Time fore color changes to white - then use !J '_’J :J !J on front panel
keyboard or , , on external keyboard

®

The value of Time is adjustable between 5 and 60 sec
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Time-Wait

Time-Wait is waiting time for intermissions predcessing t-TOFD recording, which starts unconditionally upon
Time-Wait period is over

20 Length

200 R

Current value of 290 mm

. o »

Time-Out 1 Time

N 7 CHL
e

P4

\1 e By

. . . / -’
To control Time-Wait the following -
manipulations are applicable: 7 -
77
e Mouse /Touch Screen /,//
B Click on corresponding
e Keyboard
-
B Press 3 on front panel keyboard or on external keyboard = Time-Wait fore color changes
to white - then use !_ 2/, « ! on front panel keyboard or [f, , , on external
keyboard

e Combined

LJ

B Click on Time-Wait = Time-Wait fore color changes to white - then use =/,

front panel keyboard or , , , on external keyboard

» & &,

®

The value of Time-Wait is adjustable between 0 and 15 sec

t-FLOORMAP L Record Palette

There are four palettes available through — select

N
N

Coloring:
Pzeudo - I

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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Start/Stop t-FLOORMAP L recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start t-FLOORMAP L recording

{ LI
Start | button becomes invisible since t-FLOORMAP L recording starts. __3P | putton occupies its

[ |
position. Click on ﬁ' or press LJ on front panel keyboard or or <Alt>+<S> on external

keyboard to terminate t-FLOORMAP L recording prior to automatic completion

N 4 |
ﬂ' button becomes invisible after completion / termination of t-FLOORMAP L record. Start

button returns to its position

Save record into afile

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.6.2.2. t-FLOORMAP L — Scanning

a Apply probes pair to test object in the start point of selected scanning line

4 |
O Click on 3t |or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line synchronously with Position Icon moving with constant speed above
t-FLOORMAP L record field — typical scanning progress display during is shown and explained below

200 280
Current A-Scan A A

+

dnld

+
.+
¥
+

+
+
+ o+
+ o+
+

+

+ o+ o+ A4+ o+

+ o+ + F o+ o+ o+

+
+
+
+
+
+

h+
W al ’HFH
| i Al
'Eﬂ"l"f"hﬂ "M I'-“I‘L-.q P Current Probe

Position

20 Length o -
kK
1 Time o
Ok
Time-'w ait o
3
Colonng:
I Pzeudo j
H [l
Stop Open Save

uD53-5 Text Cloze
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6.6.2.3. FLOORMAP L - Prior to Scanning
FLOORMAP_L control panel is shown below

(]

a0 100 150 200 250 200 260
1 1 1 1 1 1

Current A-Scan

+ + +

QO0.0 mm

+
+
+
+
+
+
+

+

|
’
’
’
:
'
R R,

10 Length o
I o

Scan Length not exceeding 400 mm or 16 in

Colonng:
IF'seuu:h:u j <
Encoder:
IDefault j
2 = ] Empty FLOORMAP L record

Start Open Save

5%

uDs3-5 Text Close

0 mm

41000 1100 1200 1300 1400 1500 1600 4700
I I I I I I I 1

+ o4+ o+ o+ S+

+ o+ o+ o+ o+ o+

4 o+ F o+ o+ o+ o+ o+
400.0 mm

+

T +
i w lt,"u pr\f-.ﬁ‘a'u\;u*u‘

Vgt Empty FLOORMAP L record

+ o+ o+ o+ K+ o+ o+t

+
+
+
+
+
+
+
+
+

Segment of Scrolled Total Scan Length

200 Length ) .
65650 mm ‘ < exceeding 400 mm or 16 in q

Colonng:
IGrayscaIe j
Encoder; FLOORMAP L scrolling controls
IDefauIt j
> = =]
Start Open Save
b g]
UDS35| Test | Close | |5
4 [
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Scan Length

Length represents length of section of test object to be displayed, over which probe will be scanning during
recording period

To control Length the following 7 -~
manipulations are applicable: P /’ -
e Mouse /Touch Screen 4/’ -

B Click on corresponding
o Keyboard

-
B Press 1 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J 2J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J 2J :J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 20000 mm or 2 and 800 in

FLOORMAP L Record Palette

There are four palettes available through — select
S
N

Coloring:
IPseudD vI

Select encoder to be used through appropriate box

Encoder

Encoder:

IDehuh _:J

Clamp probe into encoder — refer to Chapter 7 of this Operating Manual

Connect encoder to appropriate input on the rear panel of ISONIC 2007 instrument

Insert Text Note

Refer to paragraph 6.3.2.1 of this Operating Manual

Preview UDS 3-5 Settings

Refer to paragraph 6.3.2.1 of this Operating Manual
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Start/Stop FLOORMAP L recording

4
Click on ﬂl or press LJ on front panel keyboard or F8 or <Alt>+<S> on external keyboard to

start FLOORMAP L recording

4 | N |
stait | putton becomes invisible since FLOORMAP L recording starts. _ 2P | putton occupies its

[ |
position. Click on ﬁ' or press LJ on front panel keyboard or or <Alt>+<S> on external

keyboard to terminate FLOORMAP L recording

| 4 |
ﬂ' button becomes invisible after termination of FLOORMAP L record. __3tait | putton returns to its

position

Save record into afile

Refer to paragraph 6.3.2.1 of this Operating Manual

Open record from a file and starting postprocessing session

Refer to paragraph 6.3.2.1 of this Operating Manual

Return to UDS 3-5 main operating surface

Refer to paragraph 6.3.2.1 of this Operating Manual
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6.6.2.4. FLOORMAP L — Scanning

a Apply probes pair to test object in the start point of selected scanning line

4 | |
O Click on 3%t |or press llj on front panel keyboard or or <Alt>+<S> on external keyboard

O Guide probe over the scanning line — typical scanning progress display during is shown and explained
below

280 300 340
1 1 1

10 Length
Rl <

Coloring:
IPseudDE
Encoder:
IDehuﬂ
i
Open
ups3-5 Text
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6.6.2.5. t-FLOORMAP L / FLOORMAP L — Postprocessing
Versatile postprocessing of t-FLOORMAP L/FLOORMAP L (CB-Scan) records is featured with:

a Sizing of the defects at any location along stored images (coordinates, projection size,
amplitude-based evaluation)

a Play-back and evaluation of A-Scans obtained and captured during t-FLOORMAP L /
FLOORMAP L (CB-Scan) defects imaging and recording

a Defects outlining and pattern recognition based on A-Scan sequence analysis — Echo
Dynamic Pattern Analysis

O Reconstruction of t-FLOORMAP L / FLOORMAP L (CB-Scan) defects images for various
Gain, Reject, and off-line Gate level settings

o DAC/DGS t-FLOORMAP L / FLOORMAP L (CB-Scan) normalization

The screen as below appears upon opening file. All postprocessing procedures are performed through
— touch screen stylus or front panel or external mouse to be used

—y
*File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

t-FloorMap L
POSTPROCESSING

Menu Bar Functions

e File>Open - opens new t-FLOORMAP L / FLOORMAP L (CB-Scan) file

e File>Snapshots>Add Snapshot — stores current postprocessing screen snapshot accompanied with

appropriate settings and measurements into postprocessing session memory stack
e File>Snapshots>Restore Snapshot — recalls earlier stored postprocessing screen snapshot

accompanied with appropriate settings and measurements from postprocessing session memory stack

e File>Snapshots>Delete Snapshot — deletes earlier stored postprocessing screen snapshot

accompanied with appropriate settings and measurements from postprocessing session memory stack
e File=>Print — prints out postprocessing screen snapshot(s) accompanied with appropriate settings and

measurements
e File>Exit — returns to t-FLOORMAP L / FLOORMAP L (CB-Scan) control panel

e View-—2>Instrument — indicates setup of UDS 3-5 Pulser Receiver used for scanning when file was
created

e View->Inspection Data — indicates operator's comments entered prior to scanning
e View—>Coloring — selects palette for t-FLOORMAP L / FLOORMAP L (CB-Scan) image
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A-Scan Recovery 2ON — generates cursor representing sound path of probe's central beam in the
object under test that may be guided over t-FLOORMAP L / FLOORMAP L (CB-Scan) image using

|

either touch screen stylus or mouse or : ¥ on front panel keyboard or , on external
keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor position.
Indication of starting position of cursor (L) corresponding to probe's center accompanies recovered A-
Scan. On the recovered A-Scan there is red Off-line Gate presented. Initially Off-line Gate covers
whole A-Scan range

File v|| Wiew v|| E dit v|| I easurements v|| A-Scan Recovery v|
L=129.3 mm

IR T
S S S

s =0.0mm H=55%
AVC= 3.14dB

FloorMap L e B
POSTPROCESSING a 50 100 150 200 250 300

/
|Automatic Measurements Display| accompanies recovered A-Scan and indicates (refer to
paragraphs 5.1.12, 5.2.13.1 and 5.2.13.2 of this Operating Manual):

0 sound path S between reflector and probe's center (measurement mode - Flank)

o amplitude H of the maximal signal in the Off-line Gate expressed in % of full A-Scan height

o AVC (dB to DAC) of the maximal signal in the Off-line Gate provided that DAC was active
whilst recording t-FLOORMAP L / FLOORMAP L (CB-Scan) data

To fix position of sound path cursor with corresponding recovered A-Scan and Automatic
Enfe.r |

Measurements Display data left mouse click or release touch screen stylus or press ' *=_ on front
panel keyboard or [Enter| on external keyboard

ESC
To interrupt recovery of A-Scans and empty A-Scan Recovery field right mouse click or press L)
on front panel keyboard or on external keyboard

A-Scan Recovery>OFF — erases sound path cursor with recovered A-Scan, indicator of sound path
cursor position, and Automatic Measurements Display
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Edit>Change Gain>0ON — generates cursor representing sound path of probe's central beam in the
object under test that may be guided over t-FLOORMAP L / FLOORMAP L (CB-Scan) image using

either touch screen stylus or mouse or !/ f on front panel keyboard or , on external
keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor position.
Ente.! |

To select reference A-Scan release touch screen stylus or left mouse click or press ' *=_J on front

panel keyboard or on external keyboard — this generates subwindow allowing off-line re-
adjusting of Gain for all A-Scans captured during t-FLOORMAP L / FLOORMAP L (CB-Scan)

recording in £6dB range with £0.1 dB increments through clicking or pressing and holding on ﬁ or

pressing —/, . / on front panel keyboard or , on external keyboard

ISONIC 2005 |

Select Gain Change:

+4.4 dB il

0K Cancel

by
During Gain re-adjusting reference A-Scan is modified accordingly. Upon completing re-adjusting Gain

DK Ente’r |
click on or press *=_ on front panel keyboard or on external keyboard — this
applies new Gain value to all captured A-Scans and redraws t-FLOORMAP L / FLOORMAP L (CB-

Scan) image accordingly

Cancel | g
To interrupt re-adjusting of Gain click on or press L) on front panel keyboard or

on external keyboard

Edit>Change Gain>OFF — negates Gain re-adjustment and returns to originally recorded t-
FLOORMAP L / FLOORMAP L (CB-Scan) image and original Gain setting
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e Edit>ROI2>0ON - generates cursor representing sound path of probe's central beam in the object under
test that may be guided over t-FLOORMAP L / FLOORMAP L (CB-Scan) image using either touch

screen stylus or mouse or : : on front panel keyboard or , on external keyboard —
corresponding A-Scan is recovered synchronously according to sound path cursor position. To select

L
Enter |

reference A-Scan release touch screen stylus or left mouse click or press ' *=_J on front panel
keyboard or [Enter| on external keyboard — this generates Off-line Gate controls n n n

n, u n allowing to redefine Region Of Interest for t-FLOORMAP L / FLOORMAP L (CB-
Scan) imaging

| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

+
+
+
+
+
+
+
+

FloorMap L
POSTPROCESSING

ESC
To interrupt selection of reference of A-Scan right mouse click or press L) on front panel keyboard
or on external keyboard

To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on .
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Upon completing redefining of Region Of Interest click on — this applies new Off-line Gate to all
captured A-Scans and updates t-FLOORMAP L / FLOORMAP L (CB-Scan) image accordingly — only
segment of t-FLOORMAP L / FLOORMAP L (CB-Scan) image covered by newly adjusted Off-line
Gate remains visible

| File v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|

425.0 mm

E
E

FloorMap L | ¢
POSTPROCESSING 0 &0 100 150 200 260 300

It is possible then to perform A-Scan signal evaluation using newly adjusted Off-Line Gate through A-
Scan Recovery >ON

File: v|| Wiew v|| E dit v|| M easurements v|| A-Scan Recovery v|
L=1286 mm

435.0 mm

+ o+
+ o+
+
+ o+
+ o+
+ o+
+ o+
+ o+
+ o+

s=2268mm H=21% m——
AVC= 79 dB o :

FloorMap L
POSTPROCESSING a 50 100 150 200 250 300

amm

e Edit>ROI2>OFF — negates Off-line Gate re-adjustment and returns to originally recorded t-
FLOORMAP L / FLOORMAP L (CB-Scan) image and initial Off-line Gate setting
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Edit>Filtering>ON — generates amplitude palette bar with sliding cursor, which may be controlled

using either touch screen stylus or mouse or 2» tj on front panel keyboard or , on external
keyboard . Position of the sliding cursor on the amplitude palette bar determines filtering level, which is
indicated as Filtering. All elements of t-FLOORMAP L / FLOORMAP L (CB-Scan) image representing

signal amplitude below filtering level are suppressed:

| File v|| Wigw v|| Edit v|| Measurements v|| A-Scan Recavery v|

435.0 mm

||1

Filtering:
>33.b dB
FloorMap L
POSTPROCESSING

e Edit>Filtering>OFF — returns to originally recorded t-FLOORMAP L / FLOORMAP L (CB-Scan)
image and removes Filtering indication
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Edit>Normalize to DAC>0N - applies DAC/DGS normalized color palette to t-FLOORMAP L /
FLOORMAP L (CB-Scan) image, which was recorded with active DAC/DGS and redraws t-
FLOORMAP L / FLOORMAP L (CB-Scan) image correspondingly (dB to DAC/DGS normalization)

File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

L=8 Filering
ROl

Change Gain

3
4
»

| Momalize to DAC
- Flip Horizontal

s=948mm H=99%

AVC= 17 dB

FloorMap L
POSTPROCESSING

0 mm

0N
= OFF

T
50

T
1460

T
200

File v|| Wigw v|| Edit v|| Measurements v|| A-Scan Recavery -
L =827 mm
E
+ + E
+ + g
+ + g
+ +
+ +
¥ +
+ +
+ +
-
5=94.8mm H=59% gé e
F—a
- = [ -
AVC= 1.7 dB i —— 'l;=___ -
= o5 "-:_‘5.;_
==
= e ]
'3 _,!' -
= . = = E
FloorMap L | £
[=}

POSTPROCESSING 0

T
lule]

T
150 200

T
250

300

Edit>Normalize to DAC>OFF — negates dB to DAC/DGS normalization and returns to originally
recorded t-FLOORMAP L / FLOORMAP L (CB-Scan) image

®

Applying of Edit->Normalize to DAC->ON or Edit->Normalize to DAC->OFF negates Filtering
(Edit>Filtering>OFF)
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_ —reorders A-Scans captured during t-FLOORMAP L / FLOORMAP L (CB-Scan)
recording in reverse succession and redraws t-FLOORMAP L / FLOORMAP L (CB-Scan) image
accordingly. This service function may be useful for merging scans of neighboring sections of an object,
which were scanned in opposite direction due to access conditions, etc

Filterirg »
ROl 4
Change Gain 4
Momnalize to DAC » |

FloorMap L (Am T e e
POSTPROCESSING 200

FloorMap L
POSTPROCESSING
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Measurements>Add Measure=>Length — generates horizontal cursor that may be guided over t-

*

—

FLOORMAP L / FLOORMAP L (CB-Scan) image using either touch screen stylus or mouse or

_'.'_/ on front panel keyboard or , on external keyboard . Horizontal cursor to be positioned over

defect area, which's length along the scanning line to be evaluated. Position of horizontal cursor
characterizes its coordinate (H) relatively scanning line. To fix position of horizontal cursor left mouse

L ]
Enter |

click or release touch screen stylus or press *=_ on front panel keyboard or [Enter| on external
keyboard

File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
H=2159mm
I £
=}
w0
7
‘éi& = e =";:_I_"
= [} S ie= -
-
= Ee
il e
e —
= = = E
FloorMap L | £
= T T T T T
PosTPnocEssl"G a an 100 180 200 280 200
File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
H=217.0 mm
L-68 e e ==
mm I 3 F—JE-_.- = 'S"q!—— .; =
SR el
gl
E%.:’_H— =] w— -—=".-‘."
¥ — e
=== :_:- = :-i-;_
-0
h - e
= e
FloorMap L | £}
[}

POSTPROCESSING o

First vertical cursor appears upon fixing horizontal cursor, it may be guided over t-FLOORMAP L /

|

FLOORMAP L (CB-Scan) image using either touch screen stylus or mouse or ' =/, ¥ on front panel

keyboard or , on external keyboard . Coordinate of the first vertical cursor along t-FLOORMAP L /
FLOORMAP L (CB-Scan) image (L) is indicated synchronously. To fix position of the first vertical cursor

L ]
Enter |

left mouse click or release touch screen stylus or press - *=_/ on front panel keyboard or [Enter|on
external keyboard
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Second vertical cursor appears upon fixing first one, it may be manipulated by the same way. Coordinate

of the second vertical cursor along t-FLOORMAP L / FLOORMAP L (CB-Scan) image measured with
relatively first vertical cursor (dL) is indicated synchronously, it represents projection length of defect

area provided that vertical cursors are placed properly

ESC
To interrupt length measurement procedure at any moment right mouse click or press L) on front

panel keyboard or on external keyboard

File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

H=2159mm

L=68mm [dL=406 mm

435.0 mm

&%g === R .
=:...—§ :: g—% p=
e
— =1
e =3 5 —
":i!- v o
B ——
B = = E
FloorMap L | £
= T T T T T
POSTPROCESSING 0 50 100 180 200 250 300
| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery -

FloorMap L
POSTPROCESSING

435.0 mm

’

T
50

T
100

T T
150 200

200

Horizontal [length measurement markl appears on the t-FLOORMAP L / FLOORMAP L (CB-Scan)

image upon fixing position of second vertical cursor
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Length measurement results may be recalled through double click on the length measurement mark

| File v|| Wig v|| Edit v|| Meazurements v|| A-Scan Recoverny v|

435.0 mm

Point 1:
L=6.8 mm
dL=40.6 mm
H=2159 mm

s |

0mm

Floophlap L
P PROCESSING ] 5|0 10|0 15|0 20|0 25|0 200
&
In the appearing:

o L is coordinate of left end of the length measurement mark
o dL is length of defect area covered by length measurement mark
o Hisdistance between scanning line and length measurement mark

= will print current screen snapshot accompanied with length measurement mark data

Clicking on

Clicking on ¥ will hide subwindow with length measurement mark data

Clicking on x will hide subwindow with length measurement mark data and erase corresponding

length measurement mark
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Measurements>Add Measure>Width — generates cursor representing sound path of probe's central
beam in the object under test that may be guided over t-FLOORMAP L / FLOORMAP L (CB-Scan)
image using either touch screen stylus or mouse or *_ . on front panel keyboard or , on
external keyboard — corresponding A-Scan is recovered synchronously according to sound path cursor
position. Indication of starting position of cursor (L) corresponding to probe's center accompanies
recovered A-Scan. Sound path cursor to be positioned over defect area, which's width along the sound
path line to be evaluated. To fix position of sound path cursor left mouse click or release touch screen

L
Enter
stylus or press *=_ on front panel keyboard or [Enter| on external keyboard
File v|| Wigw v|| Edit v|| Measurements v|| A-Scan Recavery v|

L=278 mm

435.0 mm

+ o+ o+

LY, P N
Pl

I+ o+ o+ o+ o+ o+ o+ o+ +

y
:
.
.
.
:
.

A

!!'.
\'h |

s=807mm  H=40% [}

AWC=25dB

%"h

27
il 'lj |I|II
L

_E 4 _l. - =
FloorMap L | ¢
POSTPROCESSING 0 50 100 180 200 260 300
File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery -
L=278 mm
E
E
N
| o
Hi“l'\\ Mll:f J:i"':':J'rd'lj\:'J = “‘“:-‘I.' Ih'L‘
s=80.7mm  H=40% U=z == e
———ge
AVC= 25 dB = = %
% _ﬂiEsL
= = =
'E = i e
= = E =
FloorMap L | ¢
POSTPROCESSING 0 s0 100 150 200 260 300
First horizontal cursor appears upon fixing sound path cursor, it may be guided over t-FLOORMAP L /
FLOORMAP L (CB-Scan) image using either touch screen stylus or mouse or ? , '.' / on front panel

keyboard or , on external keyboard . Coordinate of the first horizontal cursor along sound path (H) is
indicated synchronously
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To fix position of the first horizontal cursor left mouse click or release touch screen stylus or press

L
Enter |

)

on front panel keyboard or on external keyboard . Second horizontal cursor appears upon fixing
first one, it may be manipulated by the same way. Coordinate of the second horizontal cursor along
sound path measured with relatively first horizontal cursor (dH) is indicated synchronously, it represents
projection with of defect area provided that horizontal cursors are placed properly. To interrupt width

ESC
measurement procedure at any moment right mouse click or press L) on front panel keyboard or

on external keyboard

File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|

L=278 mm

H=189.7 mm | dH=61.1 mm

435.0 mm

+
+
+
+
+
+
+
+

£ o+ ok o+ o+ o+ o+ o+

|Hw co
e

2N : — =
=_F

s=80.7mm  H=40% = = = -
AVC= 25 dB = %ﬁ
=
= Ee
'E":;!; (o
- =
£ —
= = = E
FloorMap L | £
= T T T T T
POSTPROCESSING i 50 100 150 200 250 300
| File: v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
3
E
=3¢
w
¥
FloorMap L | ¢
o

POSTPROCESSING

Vertical jwidth measurement mark{ appears on the t-FLOORMAP L / FLOORMAP L (CB-Scan) image

upon fixing position of second horizontal cursor
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Width measurement results may be recalled through double click on the width measurement mark This

causes appearance of corresponding A-Scan and

subwindov-vl

| File v|| Wiew v|| Edit v|| Measurements v|| A-Scan Recovery v|
+ +
+ + E
+ + =1
+ + §
+ +
+ +
+ +
J— + o+ o+
R v %
s=80.7mm H = 40% Point 2:
AVC= 25 dB o™ L=27.8 mm -
0= V' etzs7mm == -
== dH=61.1 mm ::__: L
| 8] x|
: 'E JE- E 1:_-_ =]
e —
= —]
- = _F
£
FloorMap L | ¢
= T T T T T
POSTPROCESSING 0 50 100 180 200 250 300

In the subwindow appearing:
o L is coordinate of the width measurement mark along scanning line
o His distance between scanning line and width measurement mark
o dH is width of defect area covered by width measurement mark

Clicking on
Clicking on

Clicking on

width measurement mark

= will print current screen snapshot accompanied with width measurement mark data
v will hide subwindow with width measurement mark data
x will hide subwindow with width measurement mark data and erase corresponding

Measurements—=>Clear Last — erases last length or with measurement mark placed on the t-
FLOORMAP L / FLOORMAP L (CB-Scan) image

Measurements—=>Clear All — erases all length and with measurement marks placed on the t-
FLOORMAP L / FLOORMAP L (CB-Scan) image
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7. Recording and Imaging — Dual Channel
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7.1. Main Recording Menu — Dual Channel

Main Recording Menu for Dual Channel Mode is shown below:

[1]BScan (Th)

[2]ToFD

[3]Floormap L

z‘ Postprocessing

E]Back

&7

There are 3 dual channel recording modes available:

¢ Dual Channel Thickness Profile imaging and recording — BScan(Th) — click on [eseanmm) |,

¢

-
1__ on front panel keyboard or on external keyboard

press

Dual Channel TOFD Inspection — RF B-Scan and D-Scan Imaging — TOFD — click Bl or
F

press 2 _J on front panel keyboard or on external keyboard

CB-Scan horizontal plane-view imaging and recording of defects for shear, surface, and guided

. . . TFIoormapL -
wave inspection — FLOORMAP L click on __— or press 3 on front panel keyboard or

on external keyboard

Postprocessing of dual channel scanning and recording files may be activated through click on

-
Eleznasil o pressing on _4_ on front panel keyboard or [F4] on external keyboard

To return to Main Operating Surface of UDS 3-5 pulser receiver channels click on Elegs or press
ESC 4
C ) or' 5 __ on front panel keyboard or or on external keyboard

®

Main Recording Menu - Dual Channel is generated from Main Operating Surface of UDS 3-5 pulser
receiver channels as it is described in the preamble to Chapter 5.2 of present Operating Manual. Dual
channel recording and imaging mode utilizes settings of both UDS 3-5 pulser receiver channels established
prior to entering Main Recording Menu for Dual Channel Mode
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7.2. Dual Channel Thickness Profile Imaging and Recording —
BScan(Th)

7.2.1. Setting Pulser Receiver Channels

Each channel must be calibrated prior to to entering Main Recording Menu for Dual Channel Mode
according to paragraph 6.3.1 of present Operating Manual

7.2.2. Scanning

Dual channel BScan(Th) control panel is shown below

Gate Start CH 1

4.0

Empty BScan(Th) record field CH

AT
[}

Gate End CH 1
100 200 300 400 &00 G0

] 100 200 300 400 500 600
Gate Start CH 2

BOm

10 Length Empty BScan(Th) record field CH
1410 mm
Encoder:
IDefauIt j 3
y Gate Start CH 2
> | = | ® ] y

A

Scrolling Dual Channel BScan(Th) record fields

The scrolling is possible through clicking on [#] and [4] buttons. It is possible to scroll first and second
channel images synchronously or separately from each other, mode of scrolling is defined through clicks on

/ ﬂ button
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Scan Length
Scan Length — Length represents length of scanning line over section of test object to be displayed

~ 10 Length
1410 mm

To control Length the following
manipulations are applicable:

e Mouse / Touch Screen

B Click on corresponding
e Keyboard

-
B Press 1 j on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J _J _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on Length = Length fore color changes to white - then use !J !J :J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 20000 mm or 2 and 800 in

Encoder
Select encoder to be used through appropriate box

Encoder:

Drefauilt j

Connect encoder to its input on the rear panel of ISONIC 2007 instrument
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Start/Stop Dual Channel BScan(Th) recording

Click on > |or press L on front panel keyboard or on external keyboard to start BScan(Th)
recording

> | button becomes invisible since BScan(Th) recording starts. . | button occupies its position.
Click on . | or press L on front panel keyboard or or <Alt>+<S> on external keyboard to

terminate BScan(Th) recording

Ll button becomes invisible after termination of BScan(Th) record. Ll button returns to its position
Typical screen during dual channel BScan(Th) recording is presented below:

+ o+

+ + + o+ o+ o+
+ + + o+ o+ o+
: : : : : : BScan(Th) record
Y o] B Y Back Wall Profile CH 1
+ + + + + +
+ + + + + +
+ + + o+ o+ o+
+ 4
£
E
P N 0 Current Position of
+ 0+ o+ o+ o+ o+ 4+ z . , | | : the Probes
F Y N 300 400 500 GO0 700
+ + o+ _+ _+ +_+
+ o+ +G H 12+ SIIIII:I QIIIII:I
+ o+ + + o+ o+
+ o+ + o+ o+ o+
+ 4+ + + o+

+
+
BOm

BScan(Th) record
Back Wall Profile CH 2

10 Length
1410 mm

Encoder: e
- E

I Drefault J =
| [

)

Save record into afile

Click on il or press ﬂj on front panel keyboard or on external keyboard to save captured

Dual Channel BScan(Th) record accompanied with instrument calibration dump and text notes / comments
into a file. Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving

Return to Main Recording Menu - Dual Channel

@ ESC
Click on AI or press L‘\ on front panel keyboard or on external keyboard to return to Main
Recording Menu - Dual Channel
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7.2.3. Postprocessing

The screen as below appears upon opening file. All postprocessing procedures are performed through
— touch screen stylus or front panel or external mouse to be used

~
\‘ File = | Postprocessing v|| Marker v|

145 mm

&7

2.0 mm

Menu Bar Functions

e File=>Print — prints out duaqgl channel BScan(Th) image

e File>Exit — returns to Main Recording Menu - Dual Channel
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Marker=>ADD — generates cursor representing sound path of probes central beams in the object under
test that may be guided over dual channel BScan(Th) image using either touch screen stylus or mouse

or ‘ ‘ on front panel keyboard or , on external keyboard — corresponding A-Scans are
recovered synchronously according to sound path cursor position

| File: v|| Postprocessing v|| I arker v|

EE T e T
ot F tatdt o+ o+ o+
L T M

145 mm

6.0m

+ o+t ot ottt o+ o+ o+
+ ot o+ twbet o+ o+ o+
+ ok kgt o+ +

2.0 mm

To fix position of sound path cursor with corresponding recovered A-Scan left mouse click or release

"
Enter

touch screen stylus or press *=_ on front panel keyboard or [Enter| on external keyboard

ESC
To interrupt recovery of A-Scans and empty A-Scans Recovery field right mouse click or press L)
on front panel keyboard or on external keyboard

Double click on fixed marker number will cause appearance of both related A-Scans and generating of
popup controls:

| File: v|| Postprocessing v|| b arker v|

I S S
ot o+ et o+ o+
L T T

E
E
w
=
=
o

100 f : : 500 500

ot o+ takdt o+t
o gkt b o+

¥t o+t F ot o+ o+ o+ o+

1] 3

=4
o clicking on _| will print out dual channel BScan(Th) image with marker on it and related
A-Scans then close popup controls and related A-Scans
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v |
o clicking on will close popup controls and related A-Scans

bl
o clicking on _| will erase marker and close popup controls and related A-Scans

ESC
To interrupt recovery of A-Scans and empty A-Scan Recovery field right mouse click or press L)
on front panel keyboard or on external keyboard
Marker>ADD->Clear Last — erases last fixed marker
Marker=>ADD=>Clear All — erases all fixed markers

Postprocessing=>CH 1 — zooms BScan(Th) record of the first channel and initiates comprehensive
postprocessing procedure — refer to paragraph 6.3.2.5 of present Operating Manual to get fully
instructed

Postprocessing>CH 2 — zooms BScan(Th) record of the first channel and initiates comprehensive
postprocessing procedure — refer to paragraph 6.3.2.5 of present Operating Manual to get fully
instructed
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7.3. Dual Channel TOFD Inspection — RF B-Scan and D-Scan
Imaging and Recording

7.3.1. Setting Pulser Receiver Channels

Each channel must be calibrated prior to to entering Main Recording Menu for Dual Channel Mode
according to paragraph 6.5.1 of present Operating Manual

7.3.2. Pre-Scanning Settings

Scan Lenagth
Scan Length — Length represents length of scanning line over section of test object to be displayed

-
1

TOFD Inzspection Setup

200 Length
1190 mm
2 CH1 Baze
114 mm
1 CH2 Base
114 mm

2 Displacement
84 mrh

E

nt:uderil /
/
/
<Back Mext >
I,
To control Length the following Ly
/

manipulations are applicable: /
/4

e Mouse / Touch Screen

B Click on corresponding
e Keyboard

-
B Press 1 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J '_U :J ¥ on front panel keyboard or , =, k= U on external

keyboard
e Combined

B Click on Length = Length fore color changes to white - then use !J '_U :J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 20000 mm or 2 and 800 in
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CH 1 Base
CH 1 Base represents Probe Separation for Channel 1

rs
2

TOFD Inzpection Setup |
4

200 Length

2190 mm

2 CH1 Base
4-

1 CH2 Base
B «

2 Displacement 4/
e
Ml «

Encoder:

=/B {:k Mext =
Y

To control CH 1 Base the following 7,
manipulations are applicable: /4

e Mouse /Touch Screen ’
B Click on corresponding
e Keyboard

F
B Press 2 J on front panel keyboard or on external keyboard = CH 1 Base fore color changes

to white - then use !J '_U :J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on CH 1 Base = CH 1 Base fore color changes to white - then use !J '_U :J !J on
front panel keyboard or , , , on external keyboard

®

The value of CH 1 Base is adjustable between 25 and 500 mm or 1 and 20 in
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CH 2 Base
CH 2 Base represents Probe Separation for Channel 2

TOFD Inzpection Setup |

200 Length
$190 mm
2 CH1 Baze
114 mm

/

2 Displacement
84 mm

To control CH 2 Base the following /,'
manipulations are applicable: 7

e Mouse /Touch Screen Y
B Click on corresponding
e Keyboard
-
B Press 3 Jon front panel keyboard or on external keyboard = CH 2 Base fore color changes

to white - then use !J _j _J !J on front panel keyboard or , , , on external

keyboard

e Combined

B Click on CH 2 Base = CH 2 Base fore color changes to white - then use !J '_U :J !J on
front panel keyboard or , , , on external keyboard

®

The value of CH 2 Base is adjustable between 25 and 500 mm or 1 and 20 in
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Displacement
Displacement represents Distance between two TOFD probes pair along the scanning line; enetering
of displacement is necessary to obtain Aligned Dual channel TOFD Map

TOFD Inzpection Setup |

200 Length
1190, mm ‘
2 CHY Base

114 mm

1 CH2 Base
L14 mm

2 Displacement
84 mm
|

Encoder:

Im

/
< Bé{:k, MNext »
[

To control Displacement the foIIowmg/
manipulations are applicable: //

/
/

N\

e Mouse /Touch Screen y
B Click on corresponding
e Keyboard
-
B Press _4 ) on front panel keyboard or on external keyboard = Displacement fore color

changes to white - then use !J '_U :J !J on front panel keyboard or , , , on

external keyboard
e Combined

B Click on Displacement = Displacement fore color changes to white - then use !J '_U :J

!J on front panel keyboard or , , , on external keyboard

®

The value of Displacement is adjustable between —100 and +100 mm or —4 and +4 in

ISONIC 2007 from Sonotron NDT - Operating Manual — Revision 1.14 - Page 266 of 320



Averaging

Sometimes Averaging of sequential A-Scans is required to improve signal to noise ratio of TOFD records

TOFD Inzpection Setup |
200 Length
1190 mm ‘
2 CH1 Basze
114 mm ‘
1 CH2 Basze
PRLTLIEEEETEELLL LR R 114 mm ‘
:  Current setting of
Averaging 2 Digplacement
3 mm or in S 84 mm ‘
T T TS, * N
Averaging
> P

Encoder:

= Ry

I~ By

oo By

--”---
1= By

To control Averaging the following
manipulations are applicable:

e Mouse / Touch Screen

B Click on corresponding

e Keyboard
F
B Press ' _3 __J on front panel keyboard or on external keyboard = Averaging fore color changes
to white - then use !_ ?/ « ! on front panel keyboard or , , , on external
keyboard

e Combined

B Click on Averaging = Averaging fore color changes to white - then use !

JALIAIAN S
front panel keyboard or , , , on external keyboard

Averaging may be either inactive (1) or active with factor 2, 4, or 8

Encoder
Select encoder to be used through appropriate box

Encoder:

Drefauilt j

Connect encoder to its input on the rear panel of ISONIC 2007 instrument
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Return to Main Recording Menu - Dual Channel

( 1 EsC
. Back .
Click on [i/ or press L) on front panel keyboard or on external keyboard to return to Main
Recording Menu - Dual Channel

Start Scanning

3
Click on { Next > 2 Or press LJ on front panel keyboard or on external keyboard to proceed to Dual
Channel TOFD Scanning

7.3.3. Scanning

Dual channel Dual Channel TOFD Scanning control panel is shown below

Current A-Scan CH 1

14.70 |

|++++++++

1\

E R R
i
|Iu'"*—-W-.-"#r—-*r-*—-vuww-"r".j |
Iy =Ry

Empty TOFD record field CH 1

e+ + + +

+ +
+ + +
+ + +
i
a
&
T T T T T T T
u] G0 100 160 200 2460 200 260 00
u} 5:3 1|:|":| '15I|:I 2|:|":| 25||:I 3|:|":| 35||:I a0
=
4
o
]
o

Empty TOFD record field CH 2

371 ps
2/

Scrolling Dual Channel TOFD record fields

The scrolling is possible through clicking on [¥] and [4] buttons. 1t is possible to scroll first and second
channel images synchronously or separately from each other, mode of scrolling is defined through clicks on

/ @ button
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Start/Stop Dual Channel TOFD recording

Click on > |or press LJ on front panel keyboard or on external keyboard to start TOFD
recording

button becomes invisible since TOFD recording starts. . | button occupies its position. Click on

|
O

or press LJ on front panel keyboard or or <Alt>+<S> on external keyboard to terminate

—

OFD recording

button becomes invisible after termination of TOFD record. Ll button returns to its position
Typical screen during dual channel TOFD recording is presented below:

Displacement

+
+ |+

w1+ 180
+I0 -+, + .
| (P T
|.|"l.'L'I-|I igubenng

' + o+

n|‘|'|.-'\yﬂ-....-'h

+

150

T e '

+
+

+ + + o+

+ o+
+ o+ + o+
+ o+ + o+

371 ps

Save record into afile

| | &
Click on = or press &J on front panel keyboard or on external keyboard to save captured

Dual Channel TOFD record accompanied with instrument calibration dump and text notes / comments into a
file. Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving

Return to Pre-Scanning Settings Menu

@ \ ESC
Click on |or press L) on front panel keyboard or on external keyboard to return to Pre-
Scanning Settings Menu
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7.3.4. Postprocessing

The screen as below appears upon opening file. All postprocessing procedures are performed through
Imenu bal.'l — touch screen stylus or front panel or external mouse to be used

~

\AFiIe v|| Postprocessing v|| Marker v|

Menu Bar Functions

e File=>Print — prints out dual channel TOFD image

e File>EXxit — returns to Main Recording Menu - Dual Channel
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e Marker=>ADD - generates cursor representing sound path of probes central beams in the object under
test that may be guided over dual channel TOFD image using either touch screen stylus or mouse or

i
2) , :J on front panel keyboard or , on external keyboard — corresponding A-Scans are
recovered synchronously according to sound path cursor position

| File: v|| Postprocessing v|| I arker v|

L=174 mm

To fix position of sound path cursor with corresponding recovered A-Scan left mouse click or release

Enre.r |
touch screen stylus or press :J on front panel keyboard or [Enter| on external keyboard
| ESC
To interrupt recovery of A-Scans and empty A-Scans Recovery field right mouse click or press <

on front panel keyboard or on external keyboard

Double click on fixed marker number will cause appearance of both related A-Scans and generating of
popup controls:

| File: v|| Postprocessing v|| b arker v|

L=177 mm

=
o clicking on _| will print out dual channel TOFD image with marker on it and related A-
Scans then close popup controls and related A-Scans
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v |
o clicking on will close popup controls and related A-Scans

bl
o clicking on _| will erase marker and close popup controls and related A-Scans

ESC
To interrupt recovery of A-Scans and empty A-Scan Recovery field right mouse click or press L)
on front panel keyboard or on external keyboard
Marker>ADD->Clear Last — erases last fixed marker
Marker=>ADD=>Clear All — erases all fixed markers

Postprocessing=>CH 1 — zooms TOFD record of the first channel and initiates comprehensive
postprocessing procedure — refer to paragraph 6.5.2.5 of present Operating Manual to get fully
instructed

Postprocessing>CH 2 — zooms TOFD record of the first channel and initiates comprehensive
postprocessing procedure — refer to paragraph 6.5.2.5 of present Operating Manual to get fully
instructed
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7.4. CB-Scan horizontal plane-view imaging and recording of
defects for shear, surface, and guided wave inspection —
FLOORMAP L

7.4.1. Setting Pulser Receiver Channels

Each channel must be calibrated prior to to entering Main Recording Menu for Dual Channel Mode
according to paragraph 6.6.1 of present Operating Manual

7.4.2. Pre-Scanning Settings

Scan Length
Scan Length — Length represents length of scanning line over section of test object to be displayed

FloorMapl’ Inspection Setup

100 Length
1410 mm ’
Coloring: / /
L4
IF'seudu:u // y; j
Encoder: / ) /
IDefauIt / / j
/7 v
/
< Back Mext » I
V4
To control Length the following //
manipulations are applicable: ‘,
e Mouse /Touch Screen 4
B Click on corresponding

e Keyboard

-
B Press 1 J on front panel keyboard or on external keyboard = Length fore color changes to

white - then use !J '_’J _J !J on front panel keyboard or , , , on external

keyboard
e Combined

B Click on Length = Length fore color changes to white - then use !J '_’J :J !J on front
panel keyboard or , , , on external keyboard

®

The value of Length is adjustable between 50 and 20000 mm or 2 and 800 in
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CB-Scan (FLOORMAP L) Record Palette

There are four palettes available through — select EhroughL

N\
N

Colonng:
Pzeudo =~ I

Encoder
Select encoder to be used through appropriate box

Encoder:

I Drefault j

Connect encoder to its input on the rear panel of ISONIC 2007 instrument

Return to Main Recording Menu - Dual Channel

( 1 ESC
. Back :
Click on llz or press L) on front panel keyboard or on external keyboard to return to Main
Recording Menu - Dual Channel

Start Scanning

(T )
Click on m, or press LJ on front panel keyboard or on external keyboard to proceed to Dual
Channel CB-Scan (FLOORMAP L) Recording
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7.4.3. Scanning
Dual channel Dual Channel CB-Scan (FLOORMAP L) Recording control panel is shown below

A-Sc
4 4
.
r Current A-Scan CH 1 . E

[m]
* =
N =
+
+ Empty CB-Scan record field CH 1
.
.
.
v

E
+ E
+ o T T T T T T T
+ ] &0 100 180 200 260 300 340 400
:
+ ] 50 100 150 200 250 300 350 400
o

E
* 5
+ e
+ L

Empty CB-Scan record field CH 2

0Omm

1 %

Scrolling Dual Channel CB-Scan (FLOORMAP L) record fields

The scrolling is possible through clicking on [#] and [4] buttons. It is possible to scroll first and second
channel images synchronously or separately from each other, mode of scrolling is defined through clicks on

/ ﬂ button
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Start/Stop Dual Channel CB-Scan (FLOORMAP L) recording

Click on > |or press LJ on front panel keyboard or on external keyboard to start CB-Scan
(FLOORMAP L) recording

> |button becomes invisible since CB-Scan (FLOORMAP L) recording starts. . | button occupies

its position. Click on . |or press LJ on front panel keyboard or or <Alt>+<S> on external

keyboard to terminate CB-Scan (FLOORMAP L) recording

Ll button becomes invisible after termination of CB-Scan (FLOORMAP L) record. Ll button

returns to its position
Typical screen during dual channel CB-Scan (FLOORMAP L) recording is presented below:

6.0 m

CB-Scan record CH 1

+oF o+ o+ o+ o+ o+ o+ o+
e + + + teeft + + 4
E + + + + A+ + + o+
E o+ o+ o+ o+ o+ + o+ o+
£+ + + o+ o+ o+ o+
A

1000 m

CB-Scan record CH 2

E
oL c.E Current Position of
+ + 4+ o+
a @ @ . e, o the Probes
+_+ + o+
+2 + o+ o+ ] 50 100 [\sg 200 250 300 350 400

+ + o+ L»"-._"-} K

+ + o+

+ + o+

+ + o+

Save record into afile

&=
Click on = |or press ‘22¢J on front panel keyboard or on external keyboard to save captured
Dual Channel CB-Scan (FLOORMAP L) record accompanied with instrument calibration dump and text
notes / comments into a file. Refer to paragraph 5.2.17 of this Operating Manual to proceed with file saving

Return to Pre-Scanning Settings Menu

@ ESC
Click on |or press L) on front panel keyboard or on external keyboard to return to Pre-
Scanning Settings Menu
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7.4.4. Postprocessing

The screen as below appears upon opening file. All postprocessing procedures are performed through
menu bar| — touch screen stylus or front panel or external mouse to be used

~

\AFiIe v|| Postprocessing v|| Marker v|

4

Menu Bar Functions
File=>Print — prints out dual channel CB-Scan (FLOORMAP L) image

[ ]
File>EXit — returns to Main Recording Menu - Dual Channel
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Marker=>ADD — generates cursor representing sound path of probes central beams in the object under
test that may be guided over dual channel CB-Scan (FLOORMAP L) image using either touch screen

stylus or mouse or ‘ ‘ on front panel keyboard or , on external keyboard — corresponding
A-Scans are recovered synchronously according to sound path cursor position

| File: v|| Postprocessing v|| I arker v|

y

e I I

H o+ o+ + o+ 4+ +

T

g

To fix position of sound path cursor with corresponding recovered A-Scan left mouse click or release

"
Enter

touch screen stylus or press *=_/ on front panel keyboard or [Enter| on external keyboard

ESC
To interrupt recovery of A-Scans and empty A-Scans Recovery field right mouse click or press L)
on front panel keyboard or on external keyboard

Double click on fixed marker number will cause appearance of both related A-Scans and generating of
popup controls:

| File: v|| Postprocessing v|| b arker v|

56.0m

F o+ o+ o+ okt o+ + 4
R

o gkt b o+
N I I I

+
+
+
N
L
v
+
+
+

"

=4
o clicking on _| will print out dual channel CB-Scan (FLOORMAP L) image with marker

on it and related A-Scans then close popup controls and related A-Scans
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v |
o clicking on will close popup controls and related A-Scans

bl
o clicking on _| will erase marker and close popup controls and related A-Scans

ESC
To interrupt recovery of A-Scans and empty A-Scan Recovery field right mouse click or press L)
on front panel keyboard or on external keyboard
Marker>ADD->Clear Last — erases last fixed marker
Marker=>ADD=>Clear All — erases all fixed markers

Postprocessing=>CH 1 — zooms CB-Scan (FLOORMAP L) record of the first channel and initiates
comprehensive postprocessing procedure — refer to paragraph 6.6.2.5 of present Operating Manual to
get fully instructed

Postprocessing>CH 2 — zooms CB-Scan (FLOORMAP L) record of the first channel and initiates
comprehensive postprocessing procedure — refer to paragraph 6.6.2.5 of present Operating Manual to
get fully instructed
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8. Incremental Encoders
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8.1. Standard Encoder SK 2001108 ABI — Single Channel
Operation

Encoder SK 2001108 ABI is originally designed for BScan(Th) and ABISCan recording with ISONIC 2001,
ISONIC 2005, ISONIC 2006, ISONIC 2007, ISONIC 2008 instruments — single channel operation

To start use of the encoder refer to simple guidance as below
Step 1

Fit probe into appropriate probe holder and connect
signal cable(s) to probe

Step 2

Fit probe holder with probe into encoder

Step 3

Connect probe signal cable(s) to appropriate coaxial
socket on ISONIC 2007 instrument — refer to
paragraph 4.2 of this Operating Manual

Connect encoder data cable to the appropriate D-
Type connector on rear panel pf ISONIC 2007
instrument — refer to paragraph 4.2 of this Operating
Manual
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8.2. Standard Encoder SK 2001108 FM — Single Channel
Operation
Encoder SK 2001108 FM is originally designed for TOFD and FLOORMAP L recording with ISONIC 2001,

ISONIC 2005, ISONIC 2006, ISONIC 2007, ISONIC 2008 instruments — single channel operation. To start
use of the encoder refer to simple guidance as below

8.2.1. TOFD

Insert ultrasonic probes into their probe holders then:

O Fit probe holders with probes on TOFD bar and fix them at at necessary separation distance

O Fix twister S 904050 on the TOFD bar

O Fit encoder SK 2001108 FM into twister S 904050 and provide necessary orientation of encoder's
wheel — it must be oriented at parallel to the desired probes' trace either along or across the weld —
refer to the sketch and photos below

Base 2

7
070w

Encoder

Encoder YWheel

TOFD Fixture and encoder positioning
for scanning along the weld

TOFD Fixture and encoder positioning
for scanning across the weld
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8.2.2. FLOORMAP L

Encoder SK 2001108 FM allows 2 ways of direct fitting of S 544 series guided wave probes or other probes

fitted into appropriate probe holders:

O Both encoder's wheel and probe contact face are situated on scanning surface:

Fitting probe into encoder

Ready to scan

a Encoder's wheel is situated on surface, which is rectangular to scanning surface:

Fitting probe into encoder

Ready to scan
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8.3. Customized Encoders for Proprietary Inspection Tasks —
Single and Dual Channel Operation

Various custom made encoders for proprietary inspection tasks may be used with ISONIC 2007. For
appropriate encoder data cable and connector pin-out contact

O Nearest Sonotron NDT representative
OR

O Directly to Sonotron NDT — mail to Support@sonotronndt.com with subject ISONIC 2007
encoder connection

®

Improper cable out-coming from custom made encoder for proprietary inspection tasks may lead to
warranty exempted damaging ISONIC 2007 instrument

8.4. Encoder Calibration

Every encoder to be calibrated prior to use with ISONIC 2007

[1]|operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down

Fa

To proceed with the calibration in the ISONIC 2007 start screen or press 2 on front panel

keyboard or -2 on external keyboard

[1]International

|2 | Display Settings

|3 |Instrument

4 | Printer Selection

> ! |
In the appeared ISONIC 2007 Settings Menu Iclick onI or press _3 J on front panel keyboard or on

external keyboard
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[1]Firing Mode

[2]Encoders

[3]Back

.
or press 2

Then

-
To calibrate encoder or press LJ or |c|ick onl

F
To select encoder increment press LJ orfclick o

Encoder Calibration Procedure

In the appeared ISONIC Encoder Settings window

ISONIC Encoder Settings

Fiegiztered Encoders:

[2]Encoding Increment

[=]
m
=
a
o
o
e
2
w
@
=
3

o
w

[3]Back

.....

Eemame
Tiesf

[Ealitarate..

[Fns
T
=
=

Hemave

Ok

| Cancel

The Calibrate Encoder window appears; it contains simple instructions to follow:
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Calibrate Encoder I Calibrate Encoder I

=% Place the Encoder &t Zero Point and click on Step 1 \f Place the Encoder at Zera Point and click on Step 1
Maowe the Encodet to End Point and click on Step 2 = hove the Encoder to End Point and click on Step 2

Zero Point End Point Fero Point End Point
{+300 mm] {+300 mm]

Step1 | Le=2o| ['Step2|| | Step 1>| Rest_|
Cancel | - Cancel |

Encoder’s wheel while calibrating must pass linearly the distance of 300 mm (12 in) between Zero Point
designated through clicking on Step 1 or pressing <Alt>+<1> on external keyboard and End Point along
scale bar attached to flat surface

Upon reaching End Point and clicking on Step 2 or pressing <Alt>+<2> on external keyboard new
Encoder Test window appears

®

If it's necessary to re-designate Zero Point click on Restart or press <Alt>+<R> on external keyboard
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In the Encoder Test window:

Q Click on Reset or press <Alt>+<R> on
external keyboard to designate local zero

point o antining = ercoerten

L
Enter |

O  Click on Yes or press *=_ on front panel Emzereey el il
keyboard or Enter| or <Alt>+<Y> on I =-3.0 mm Beset

external keyboard to name the selected
encoder — Key in the Encoder Name

window appears Click on ez if the shown coordinate iz conrect,
ESC Click on Mo to recalibrate the Encoder.

Q Click on No or press - X" _J on front panel
keyboard or press or <Alt>+<N> on
external keyboard to recalibrate the

encoder — return to Calibrate Encoder
window

K.ey in the Encoder Hame |

IMyNewEncnder

~Nrlle@l s e~ Halz1cl) il [

o/lwlE[R[THyllulltllolrP] ]}

m FlIUX|CHHVYIB|IHNIM
iﬂve Cancel

Upon keying in new Encoder name ISONIC Encoder Settings window returns upon

.
W
~

Del BS

ISONIC Encoder Settings

Fiegiztered Encoders:

Fiename
Test. ..
Calibrate. ..

Bemowve

G,

aE, | Cancel
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L
Enter

To update the reiistry of ISONIC 2007 with new encoder data click on the OK or press = J on front panel

keyboard or ENnter|or <Alt>+<Y> on external keyboard — this will automatically return to ISONIC 2007
Settings Menu

ISONIC Encoder Settings |

Reqistered Encoders:

b yuM ewE ncader

dd

Rename

Test...

[l

Bemove |

E, | Cancel |

While running encoder calibration next time:

a

a

Click on Add... or press <Alt>+<A> on external keyboard to proceed with next new encoder by the
same way as described above

Click on Rename or press <Alt>+<N> on external keyboard to rename the selected encoder

Click on Test or press <Alt>+<T> on external keyboard to check the accuracy of selected encoder
calibration

Click on Calibrate or press <Alt>+<L> on external keyboard to recalibrate selected encoder

Click on Remove or press <Alt>+<R> on external keyboard to remove selected encoder from the
registry of ISONIC 2007

ESC
Click on the Cancel or press L) on front panel keyboard or press or <Alt>+<C> on external
keyboard to negate all changes and return to ISONIC 2007 Settings Menu
Ente.r |
Click on the OK or press ' *=_ on front panel keyboard or or <Alt>+<K> on external keyboard
to update the registry of ISONIC 2007 and return to ISONIC 2007 Settings Menu
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9. Miscellaneous
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9.1. International Settings

[1|operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down

F
In the ISONIC 2007 start screen or press 2 J on front panel keyboard or on external

keyboard

[ 1 ]international

[2]pisplay setings

@Em{rs
IE] Printe r/alec‘lion

5‘ Back

/

-
In the appeared ISONIC 2007 Settings Menu or press LJ on front panel keyboard or on
external keyboard , the International Settings screen appears:

E‘Language [§

[ 2|measurement Unit

[ 3 |Back

rd | ESC
or press 3 o Q on front panel keyboard or

To return to ISONIC 2007 Settings Menu

or on external keyboard
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9.1.1. Language

-,
In the International Settings screen or press ' on front panel keyboard or F1 on external

keyboard

ISONIC Language Selection |

Select language then

®

Standard languages of ISONIC 2007 ate English and German. Other languages are available upon request
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9.1.2. Metric and Imperial Units

E‘Language [3

[ 2|measurement Unit
/ [ 3 |Back
F

. . - |
In the International Settings screen or press 2 on front panel keyboard or on external
keyboard

Measurement Unit:
1 | © Metric

2 | 2 Imperial

Cancel |

/

Select measurement units then |c|ick onl
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9.2. Display Settings

‘ [ 1 ]international

[2]pisplay settings

@ Encoders

‘ IZ‘Prin‘ler Selection

‘ F]Back

F
|
In the ISONIC 2007 Settings Menu or press 2 on front panel keyboard or [F2| on external

keyboard

9.2.1. A-Scan Color Scheme

4]
| 1]A-scan Colors

| 2 |ToFD Display

@Bauk

-

In the Display Settings Menu or press L/r on front panel keyboard or on external keyboard
then mark selected color scheme for both CH 1 and CH 2

Select A-Scan Color Scheme:

CH1
Biack ——————§J
CH2

IBIue j

W

To negate new selection

ISONIC 2007 from Sonotron NDT - Operating Manual — Revision 1.14 - Page 293 of 320



®

There are 4 A-Scan Color Schemes available:

Gain% 5 Gain%

28.5 dB - 28.5 dB
Value: Ao Value: Ao
-10.7 dB -10.7 dB

Gains Gains

28.5dB 28.5dB

Value: AV 4 Value: AV 4

-10.7 dB -10.7 dB
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9.2.2. TOFD Display Settings

[1]A-scan Colors

| 2 |ToFD Display

@Bauk

F
In the Display Settings Menu or press LJ on front panel keyboard or on external keyboard
then check the selected options:

Imaging Settings |

— TOFD Imaging
~ Logic — Contrast
) Negative > Natural
 Soft
= Positive @® Sharp

[ Save Cancel
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®

Natural Contrast TOFD Display

Negative

256 brightness levels of TOFD Map from absolutely white to absolutely black are distributed for RF signals,
which's half waves do vary from minus 100% to plus 100% of A-Scan display height. Positive half wave
signals equal or exceeding plus 100% of A-Scan display height are represented by absolutely black color.
Negative half wave signals equal or exceeding minus 100% of A-Scan display height are represented by
absolutely white color

Positive

256 brightness levels of TOFD Map from absolutely black to absolutely white are distributed for RF signals,
which's half waves do vary from minus 100% to plus 100% of A-Scan display height. Positive half wave
signals equal or exceeding plus 100% of A-Scan display height are represented by absolutely white color.
Negative half wave signals equal or exceeding minus 100% of A-Scan display height are represented by
absolutely black color

Negative Positive
+200% +200%

+ 100% + 100%
# #

& &

i # i #
5 5
P base line 0% »"  base line 0%
4 4
Jiﬁip Jiﬁip

- 100% - 100%
- 200% - 200%
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®

Soft Contrast TOFD Display

Negative

256 brightness levels of TOFD Map from absolutely white to absolutely black are distributed for RF signals,
which's half waves do vary from minus 200% to plus 200% of A-Scan display height. Positive half wave
signals equal or exceeding plus 200% of A-Scan display height are represented by absolutely black color.
Negative half wave signals equal or exceeding minus 200% of A-Scan display height are represented by
absolutely white color

Positive

256 brightness levels of TOFD Map from absolutely black to absolutely white are distributed for RF signals,
which's half waves do vary from minus 200% to plus 200% of A-Scan display height. Positive half wave
signals equal or exceeding plus 200% of A-Scan display height are represented by absolutely white color.
Negative half wave signals equal or exceeding minus 200% of A-Scan display height are represented by
absolutely black color

Negative Positive
+200% +200%
+ 100% + 100%
e a
& &
g g
9r1 @ﬂ
[ éﬁ
. p base line 0% , p’ base line 0%
I I
v
Jiﬁip \;ifii

- 100%

- 100%

- 200%

- 200%
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®

Sharp Contrast TOFD Display

Negative

256 brightness levels of TOFD Map from absolutely white to absolutely black are distributed for RF signals,
which's half waves do vary from minus 50% to plus 50% of A-Scan display height. Positive half wave
signals equal or exceeding plus 50% of A-Scan display height are represented by absolutely black color.
Negative half wave signals equal or exceeding minus 50% of A-Scan display height are represented by
absolutely white color

Positive

256 brightness levels of TOFD Map from absolutely black to absolutely white are distributed for RF signals,
which's half waves do vary from minus 50% to plus 50% of A-Scan display height. Positive half wave
signals equal or exceeding plus 50% of A-Scan display height are represented by absolutely white color.
Negative half wave signals equal or exceeding minus 50% of A-Scan display height are represented by
absolutely black color

Negative Positive
+200% +200%
+ 100% + 100%
A A
é &
g i
@[1 +50% 9[1 +509,
5° 5
. [ base line 0% , p base line 0%
| I
Ji?ip \;iﬁil:r
-50% 50%
-100% - 100%
- 200% - 200%
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9.3. Firing Mode
®

The content the present paragraph is applicable to ISONIC 2007 instruments manufactured on April 10,
2012 or later and to earlier manufactured instruments provided their firmware was modified by Sonotron
NDT on April 10, 2012 or later

F
or press 2 )

In the ISONIC 2007 start screen

[1]|operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down

[1]International

|2 |Display Settings

[3]Instrument

4 |Printer Selection

|5]Back

-
In the appeared ISONIC 2007 Settings Menu |click on] or press = 3 }

[_1J Firing Mode

[2]Encoders

@Eack

-«
Then or press 1 | - this will open simple dialogue for selection of Firing Mode for Multi Channel
inspection:

Firing Mode:

|I| O Parallel
EI ® Sequential

Save | Cancel

ISONIC 2007 from Sonotron NDT - Operating Manual — Revision 1.14 - Page 299 of 320



9.4. Printer Selection

This option is available if there are more than 1 printer drivers installed in ISONIC 2007

[1]|operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down

,

In the ISONIC 2007 start screen or press -2 on front panel keyboard or on external

keyboard

[ 1 ]international

[2]A-scan Colors

@ Encoders

lz‘ Printer Selection

5 Back

3
-

In the appeared ISONIC 2007 Settings Menu or press _,.‘.'_JI on front panel keyboard or on
external keyboard

Select Printer:
HP Laserlet bGP -

Save Cancel | g,

Select printer then
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9.5. Exit to Windows

[1]|operate

[ 2 |settings

[ 3 |Exit To Windows

|4 |shut Down

-
or press > _J on front panel keyboard or on external

In the ISONIC 2007 start screen
keyboard

B
To return to ISONIC 2007 Operation double click on icon 7B | located in the Windows Desktop

®

Exit to Windows is required for:
a Connection to network
0 Printing inspection results to network printer
o Transferring data to / from remote PC

O Installing printer driver(s)
O Installing USB memory stick (disk on key) driver (for ISONIC 2007 instruments running under

Windows 98 SE Operating System)
O Quasi-disk management
In order to prevent overloading of ISONIC 2007 quasi-disk and memory with data and non ISONIC 2007
software that may affect instrument performance it's not allowed to install non ISONIC 2007 software except
drivers noted above. Affecting of instrument performance through installing on non ISONIC 2007 software
except drivers noted above is the warranty exemption damage

9.6. Connection to Network

To connect ISONIC 2007 to local area network using Ethernet connector (refer to paragraph 4.2 of this
Operating Manual) and standard Windows rules

ISONIC 2007 from Sonotron NDT - Operating Manual — Revision 1.14 - Page 301 of 320



9.7. External USB Devices
9.7.1. Mouse

Use one of 2 USB Connectors (refer to paragraph 4.2 of this Operating Manual). ISONIC 2007 founds and
registers external USB mouse automatically through standard Windows routine. Microsoft optical mouse is
recommended

9.7.2. Keyboard

Use one of 2 USB Connectors (refer to paragraph 4.2 of this Operating Manual). ISONIC 2007 founds and
registers USB keyboard automatically through standard Windows routine. Microsoft keyboard is
recommended

9.7.3. Memory Stick (Disk on Key)

Use one of 2 USB Connectors (refer to paragraph 4.2 of this Operating Manual)

ISONIC 2007 running under Windows XP Embedded founds and registers USB memory stick (disk on key)
automatically through standard Windows routine.

For ISONIC 2007 instruments running under Windows 98 SE preliminary driver setup is required. To install
driver use network connection (refer to paragraph 8.5 of this Operating Manual)

9.7.4. Printer

Use one of 2 USB Connectors (refer to paragraph 4.2 of this Operating Manual). Preliminary driver setup is
required. To install driver use network connection (refer to paragraph 8.5 of this Operating Manual) or USB
memory stick (disk on key) if it's already registered in ISONIC 2007
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9.7.5. ISONIC Alarmer
For a variety of manual and automatic inspection applications it may be necessary:

genrating sound alarm on defect detection

controlling some external devices, such as sorters, multi-element go/no go display panels, etc
starting inspection and recording process upon receiving triggering signal from an external device
etc

A variety of above tasks is resolved by simple ISONIC Alarmer (part # SE 554780987), which is interfaced
to ISONIC 2005, 2006, 2007, 2008 instrument through USB port

®

e |SONIC Alarmer may be connected to the instrument at any moment since ISONIC 2007 Start
Screen became active (refer to paragraph 4.3 of this Operating Manual)

e ISONIC Alarmer may be disconnected from the instrument at any moment prior to shut down (refer
to paragraph 4.3 of this Operating Manual)
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ISONIC Alarmer includes:

Internal Speaker, which is switched ON / OF according to alarm logic settings of UDS 3-5 Pulser
Receiver in the ISONIC 2005, 2006, 2007 instruments / UDS 3-6 Pulser Receiver of ISONIC 2008
Instrument

Speaker Volume Control Wheel

Headphone Connector

Input / Output Control chip

25-pin programmable Input / Output interface

Input / Output 25-pin programmable Input
Controller Chip / Output interface

Internal
Speaker

USB Port for Headphone Speaker Volume
connection to ISONIC Connector Control Wheel
2005, 2006, 2007,

2008 Instrument

Initially ISONIC Alarmer is configured to deliver sound through speaker and headphone connector (standard
configuration)

25-pin input / output interface is configured according to the duty book, which is agreed with the customer
(optional configuration)
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Standard configuration pin-out of 25-pin input / output interface D-Type connector is shown below:

3
_ 0
GBI o 27_GND
GB2__15
~GB3 3| _Oo 26 GND
— T .°
—Tme T °
—GB 5 1.°
J
GAD 18 °
GAL__6 0
GAr 101 °
GA3 7 0
—_——0
—GasgT©
—Ga6 o1 1 °
Al o 1.°
— > [ °
o O
PR
11 0
P
P PR
%510
E] O
_o
/ ~
D Comnector 25
Pin Function

Numbe

Ground

Alarm Gate B — Channel 1 (Only Channel for ISONIC 2005, 2006)

Alarm Gate B — Channel 3

Alarm Gate B — Channel 5

Alarm Gate B — Channel 7

Alarm Gate A — Channel 1 (Only Channel for ISONIC 2005, 2006)

Alarm Gate A — Channel 3

Alarm Gate A — Channel 5

Alarm Gate A — Channel 7

NC

NC

NC

NC

Alarm Gate B — Channel 0

Alarm Gate B — Channel 2

Alarm Gate B — Channel 4

Alarm Gate B — Channel 6

Alarm Gate A — Channel 0

Alarm Gate A — Channel 2

Alarm Gate A — Channel 4

Alarm Gate A — Channel 6

NC

NC

NC

NINNNNN (R (R (R(R PR Rk
g~ W|N|P|O|o|m|~N|o|o|r|w|N|k|o|©R (N o0~ IWIN -

NC
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9.8. External VGA screen / VGA projector

Connect to appropriate connector (refer to paragraph 4.2 of this Operating Manual) while at least one of 2
devices either ISONIC 2007 or external screen / projector is switched OFF then switch on one or both
devices

9.9. Software Upgrade

Refer to http://www.sonotronndt.com/support.htm in the Internet
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9.9. ISONIC Office and ISONIC Office 2005 Software packages
for office PC

ISONIC Office and ISONIC Office 2005 software packages allow performing of all-function postprocessing
for all types of inspection files captured using ISONIC 2007 in an office PC. All postprocessing procedures
are identical to the postprocessing procedures and menus inside the unity itself. If Microsoft Word is installed
in an office PC then at any moment postprocessing snapshots including all graphics and accompanying
setup and / or measurement data may be converted into the MS Word® *.doc file

9.10. ISONIC Par2Txt Converter Software package
®

Contents of this chapter is valid for the ISONIC Par2Txt Converter SW Package version 2.0.0.1 or higher

ISONIC Par2Txt Converter converts variously configured *.PAR files created by ISONIC 2001 and ISONIC
2007 instruments into *.txt files. Both pure A-Scans and A-Scans accompanied with frequency domain
(FFT) graphs are presented in ASCII format in *.txt files. This allows further off-line signal analysis using
popular software packages Mathlab®, Labview®, and the like

Click on Start then select Programs => ISONIC => ISONIC Par2Txt Converter or click on
in the desktop to run ISONIC Par2Txt Converter - window as below appears:
E

w AEG

=) ISOMIC 2005 Backup Disk || File Mame | File Type |A
) ISONIC 2005 Results 22 PUOO0034.PAR ISONIC 2005 PAR File
) ABLScan Inspection 2% PLIODON35.PAR ISOMIC 2005 PAR File
) BScan(Thy Inspection a2 PLIONDO3E. PAR ISOMIC 2005 F&R File
) Floormapl Inspection a2 PLIOON0O37. PAR ISOMIC 2005 PAR File
) t-ABI=can Inspection 22 PLIO0D03S PAR ISOMIC 2005 PAR File
) t-B5can(Th) Inspection 20 pJ0002a PAR |SOMIC 2005 PAR File
- :;ES&??'”;‘:;EE“":” 20 PLIODO040.PAR |SONIC 2005 PAR File
j L TORD Inpspecl:icun EE PLO0004T PR < ISONIC 2005 PAR File
o T 05 PUDOODA2PAR ISONIC 2005 PAR: Fie
) ISONIC 2006 65 PUO00DA3 PARy ISONIC 2005 PAR: Fie
) T5ONIC Biackup Disk 63 PLI000DA4 PAR ISONIC 2005 PAR Fie
=) ISONIC Hardware and Firmaware o, | 05 PUO0D045PAR ISOMIC 2005 PAR File
: a9 PUDDO@AE. PAR ISOMIC 2005 F&R File

£ >

20 runghimiz L NN U U Ul B0 O |

— W Convert to Text

| | b -I Yl

Y by | W :

y o oo ) L0V AN Exit
st gl IF =T v E i

Select the [file of interest| then |click on|
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As a result the corresponding |*.txt file} appears

5) I50MIC 2005 Backup Disk,
0) I50MIC 2005 Results
() ABIScan Inspection
\5) BScan(Th) Inspection
\.5) Floormapl Inspection
() t-ABIScan Inspection
() t-BScan{Th) Inspection
) t-FloormapL Inspection
) TOFD Inspection
) E-TOFD Inspection
) UDS 3-5 Pulser Receiver
) I5ONIC 2006
[5) 150MIC Backup Disk:

L& ISONIC Par2Txt Convertor

[[5) I50MIC Hatdware and Firmaware ..

59 PUIOO0034. PAR
32 PUDNON3E PR
59 PLIOON0O3E PAR
&2 PLIO00037. PAR
o PLIO0O03E PAR
32\ U000039 PAR
32 Qhnnn4n PR
00041, FAR
PUIOOO04T. TiT
59 PUIODDD4Z PAR
32 PUIDOON43 PR
32 PUDNON44 PR
52 PUODDD4S PAR

ISOMIC 2005 PAR File
ISOMIC 2005 PAR File
ISONIC 2005 P4R File
ISOMIC 2005 PAR File
ISOMIC 2005 PR File
ISOMIC 2005 PAR File
ISOMIC 2005 PR File

Text File
ISONIC 2005 PAR File
ISOMIC 2005 F4R File
ISONIC 2005 PAR File
ISOMIC 2005 P4R File

File: M arne File Type ~

< > T R P M
+ |‘|
o
g
" ||1|r " LI | i
y ‘1, ¥ [™ ||r_|| II_‘I‘.\f"-'.'l E xit
To preview the contents of *.txt file [double click on its name] or mark it and |click on
& (] bE 0 E L
) [SOMIC 2005 Backup Disk. - File: Type: -

0 ISOMIC 2005 Results
) ABIScan Inspection
5) BScan(Th) Inspection
=) Floormapl Inspection
) t-ABIScan Inspection
5) t-BScan(Th) Inspection
() t-Floormapl Inspection
() TOFD Inspection
) E-TOFD Inspection
) UDS 3-5 Pulser Receiver

() ISOMIC 2008

5 ISOMIC Backup Disk

£

0 ISOMIC Hardware and Firmaware o

3

Fill Hame

Looo0a, . Te=T
22 PUIOOO04Z. PAR
22 PLIODDD43.PAR
29 PUODON44.PAR
29 PLO0ODUS. PAR

20~ mnenae ma e

ISOMIC 2005 PAR File
ISOMIC 2005 PAR File
ISONIC 2005 PAR File
ISOMIC 2005 PAR File
ISONIC 2005 PAR File
ISOMIC 2005 PAR File
ISONIC 2005 PAR File
ISONIC 2005 PAR File

ISONIC 2005 PAR File
ISOMIC 2005 PAR File
ISONIC 2005 PAR File
ISONIC 2005 PAR File

[Tt R nintn n it s ]

To end ISONIC Par2Txt Converter session
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9.11. ISONIC D-Line and ISONIC D-Spreadsheet Creator
Software packages

ISONIC D-Line and ISONIC D-Spreadsheet Creator software packages for office computer equipped with
Microsoft®Office allow converting of t-BScan(Th)/BScan(Th) files (special format *.bsi) into Microsoft® Excel
(.xIs) spreadsheet file

ISONIC D-Line

Click on Start then select Programs => ISONIC =* ISONIC D-Line or click on E icon located in the
desktop to run ISONIC D-Line

e File > Open allows selection and loading of *.bsi format t-BScan(Th)/BScan(Th) data file

L ISONIC D-Linuk

% ISONIC D-Line
File RiOI

File Name:

Scanned Region Leng

Required L-Resolutio

File Name:

B500001 bsi

Scanned Region Length: 100 mm

Required L-Resolution:
| ctual (0.2 mm)

—1L —

Create Excel® File
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On completing download:

e ROI = ON — generates cursor representing sound path of probe's central beam in the object under test
that may be guided over t-BScan(Th) / BScan(Th) image using either mouse or , buttons on
keyboard — corresponding A-Scan is recovered synchronously according to cursor position. To select

reference A-Scan left mouse click or press |[Enter|on external keyboard — this generates off-line Gate

A controls n n n n u n allowing to redefine Region Of Interest for t-BScan(Th)

/ BScan(Th) imaging

“%: ISONIC D-Line
File ROI

File Name:

BS00001 bsi

Scanned Region Length: 100 mm

+ o+ o+ o+ o+ o+ o+

Required L-Resolution:
| ctual 0.2 mm) ~|

+
+
+
+
+
+
+
+

o+ttt ot ot o+t

B

Create Excel® File

Upon completing redefining of Region Of Interest click on — this applies new Gate A to all
captured A-Scans and updates t-BScan(Th) / BScan(Th) image accordingly

To interrupt selection of reference of A-Scan right mouse click or press on keyboard

To interrupt re-adjustment of Region Of Interest after selection of reference of A-Scan click on

e ROI>OFF — negates Gate A re-adjustment and returns to originally recorded t-BScan(Th) / BScan(Th)
image and original Gate A setting
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“%; ISONIC D-Line

File ROI

File Name:

BS00001 bsi

Scanned Region Length: 100 mm

Required L-Resolution:
| sctual (~0.2 mm) |
Actual [~0.2 mm)]
0.5

Create Excel® File

4

. |Required L—Resolutionl — this control allows selecting of necessary longitudinal scanning coordinate

increments for depth spreadsheet to be created. Best possible resolution (actual) corresponding to
minimal possible increment is default — it corresponds to single depth reading per each coordinate. On
selecting coordinate increment larger than actual ISONIC D-Line software will analyze all depth

readings with actual resolution for each interval covered by selected increment and place minimal values
into corresponding cells

#

5

—
1 Lancel

File Name:

BS00001. bsi
Scanned Region Length: 100 mm

Required L-Resolution:
|1 mm ﬂ

Create Excel® File

e Create Excel® File — clicking on this button will initiate automatic creation of spreadsheet followed by
starting Microsoft® Excel software

e File>Exit — quits ISONIC D-Line software
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ISONIC D-Spreadsheet Creator

Click on Start then select Programs = ISONIC = ISONIC D-Spreadsheet Creator or click on E icon
located in the desktop to run ISONIC D-Spreadsheet Creator

File > Open allows selection and loading of *.bsi format t-BScan(Th)/BScan(Th) data file

i ISONIC D-Spreadsheet Creator;
File:

File Name:

ONIC D-Spreadsheet Creator

Scanned Region L

Required L-Resol

Scanned Region W

Required X-Resol

File Name:

Example 01.bsi

Scanned Region Length: 100 mm

Required L-Resolution:
| ictual (0.2 mm) |

Create Excel® File

e File > Open allows selection and loading of *.bsi format t-BScan(Th)/BScan(Th) data file

All further operations are identical to above described for ISONIC D-Line
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9.12. Charging Battery

Battery of ISONIC 2007 may be charged while disconnected from the unit. The special charger is required
(refer to Chapter 3 of this Operating Manual). Connect charger to the battery as it is shown below

— T

i

There is Charge LED on the charger. While charging the battery this LED emits solid light. Charge LED
starts flashing upon charge is completed

®

If a battery is new and almost completely discharged then "boiling" effect in the electrolyte may start earlier
than battery is fully charged. In order to prevent battery charger stops on detecting boiling "boiling" effect:

O |If temperature inside battery does not exceed 60°C deg limit then Charge LED starts flashing — for
such case it is necessary to disconnect charger from mains for few minutes and to connect it to
mains again. The normal charging will continue

Q If temperature inside battery exceeds 60°C deg limit then Temp LED starts flashing — for such case
it is necessary to disconnect charger from mains for at least 2 hours and to connect it to mains
again. The normal charging will continue

After few charge / discharge cycles battery becomes "trained" and probability of "boiling" effect decreases to
almost zero
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9.13. Silicon Rubber Jacket

Establishing Image:

POWER® LOW-BAT®

Sonotron NDT '

&

& @
&) (@(=)=)
O

e e i

. _i
SONIC 2007 [I]

Remove the plastic screw-caps from both sides of the handle using a pair of tweezers:
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Remove the screw (and washer) from each side of the handle:

Remove the handle and put it aside (along with all the metal parts):
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Align the holes with the ports on the machine. Slip the Silicone Rubber Jacket around the machine until it fits
properly and covers all edges:

A view of the front and back side:

Sonotron NDT

) ®
&) @==)
) @

() (%) nsonic 2007 (1) (&) —
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Put the handle back in position (along with all the metal parts):

Sonotron NDT

*
(=)=
3

isoniczoo7) (1) (&) “

Screw-in the screw (and washer) on each side of the handle:
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Push the plastic screw caps on both sides of the handle into place:

DONE!

POWER® LOW-BAT® 3
Sonotron NDT
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10. Dual Channel TOFD preamplifier
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SA 80442 Fixed Gain Dual Channel

Preamplifier Package from Sonotron NDT

improves long cable connection to

ultrasonic probes, which may be required

in NDT practice very often. Typical
applications are TOFD, Corrosion
Detection, and the like implemented
through use of probes fitted into the
scanner / crawler frame

Technical Data:
Independent Channels

Frequency Band

Advanced Low Noise Design

Gain
Output Impedance
Output Driving Capacity — Cable Length

Terminals

Power

Flashing LED Indicators

Housing
Dimensions

Weight

0.2...25 MHz at -3dB

34 nV peak to peak input referred to 20 dB gain / 25
MHz bandwidth

20dB
50 Q
<30m

Input 2 X LEMO 00
Output 2 X LEMO 01

4 X Dry Alkaline Batteries AA Size
Channel 1 Switch ON

Channel 2 Switch ON

Low Battery

Sealed IP 67 Rugged Aluminum Case
62 X 30X 112mm (2.44 X 1.18 X4.4")

320 g (0.7 Ibs)
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